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About This Guide

This user’s guide contains the instructions necessary to operate and maintain 
your BD FACSAria™ II flow cytometer. Because many instrument functions are 
controlled by BD FACSDiva™ software, this guide also contains basic software 
information needed for instrument setup. To familiarize yourself with the 
software, do the tutorials in the Getting Started with BD FACSDiva Software 
guide. For detailed information on software features, see the BD FACSDiva 
Software Reference Manual.

The BD FACSAria II User’s Guide assumes you have a working knowledge of 
basic Microsoft® Windows® operation. If you are not familiar with the 
Windows operating system, see the documentation provided with your computer.

New users of the BD FACSAria II flow cytometer should read:

• Chapter 1 to become familiar with instrument components

• Chapter 2 to understand how the instrument works and to learn about the 
software components used to control different subsystems

• Chapter 3 to see where software components are located 

Instructions for routine acquisition, analysis, and sorting can be found in 
Chapters 4 and 5.

Once you become familiar with routine operation and need only a quick 
reminder of the main steps, use the quick reference guide provided with this 
user’s guide.
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Conventions

The following tables list conventions used throughout this guide. Table 1 lists the 
symbols that are used in this guide or on safety labels to alert you to a potential 
hazard. Text and keyboard conventions are shown in Table 2.

Table 1  Hazard symbolsa

a. Although these symbols appear in color on the instrument, they are in black and white throughout this user’s 
guide; their meaning remains unchanged.

Symbol Meaning

Caution: hazard or unsafe practice that could result in material damage, data 
loss, minor or severe injury, or death

Electrical danger

Laser radiation

Biological risk

Table 2  Text and keyboard conventions

Convention Use

; Tip     Highlights features or hints that can save time and prevent 
difficulties

NOTE Describes important features or instructions 

Italics Italics are used to highlight book titles and new or unfamiliar 
terms on their first appearance in the text. 

> The arrow indicates a menu choice. For example, “select 
File > Print” means to select Print from the File menu.

Ctrl+X When used with key names, a plus sign means to press two 
keys simultaneously. For example, Ctrl+P means to hold down 
the Control key while pressing the letter p. 
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Technical Assistance

For technical questions or assistance in solving a problem:

• Read the section of the user’s guide specific to the operation you are 
performing. 

• See Troubleshooting on page 225.

If additional assistance is required, contact your local BD Biosciences technical 
support representative or supplier. 

When contacting BD Biosciences, have the following information available:

• Product name, part number, and serial number

• Any error messages

• Details of recent system performance

For instrument support from within the US, call (877) 232-8995.

For support from within Canada, call (888) 259-0187.

Customers outside the US and Canada, contact your local BD representative or 
distributor.
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Limitations

This instrument is for Research Use Only. Not for use in diagnostic or 
therapeutic procedures.

BD Biosciences is providing software without warranty of any kind on an as-is 
basis. The software and workstations are intended for running the instruments 
supplied by BD Biosciences. It is the responsibility of the buyer/user to ensure 
that all added electronic files including software and transport media are virus-
free. If the workstation is used for Internet access or purposes other than those 
specified by BD Biosciences, it is the buyer/user’s responsibility to install and 
maintain up-to-date virus protection software. BD Biosciences does not make any 
warranty with respect to the workstation remaining virus-free after installation. 
BD Biosciences is not liable for any claims related to or resulting from the buyer/
user's failure to install and maintain virus protection.
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Cytometer Components

The BD FACSAria II flow cytometer is a high-speed fixed-alignment benchtop 
cell sorter. The cytometer can be operated at varied pressures and can acquire up 
to 70,000 events per second. With its fixed-optics design and digital electronics, 
the BD FACSAria II flow cytometer enables multicolor analysis of up to 13 
fluorescent markers and two scatter parameters at a time.

The BD FACSAria II system consists of three major components: a fluidics cart, a 
benchtop flow cytometer, and a workstation (see Figure 1-1 on page 2). Nearly 
all cytometer functions are operated from within BD FACSDiva software. 

For a description of the system components, see the following sections. For 
technical information about how the cytometer works, see Chapter 2.

• Fluidics Cart on page 2 

• Flow Cytometer on page 6

• Workstation on page 26
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Figure 1-1  BD FACSAria II cytometer components 

Fluidics Cart

A separate fluidics cart supplies sheath and cleaning fluids and collects waste 
from the cytometer. The self-contained fluidics cart supplies the required air 
pressure and vacuum, which eliminates the need for an external source (although 
the cart can be hooked up to an in-house air source, if one is available). The air 
pumps provide pressure from 5 to 75 psi to accommodate a variety of cell sorting 
applications. Air pressure is adjusted within BD FACSDiva software.

Containers and Connectors

The fluidics cart holds a 10-L stainless steel sheath tank, a 5-L stainless steel 
ethanol shutdown tank, a 10-L waste container, and three 5-L auxiliary cleaning 
fluid containers (Figure 1-2). 
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Figure 1-2  Fluidics cart containers

The fluidics cart connects directly to the flow cytometer unit via a power cord, 
fluid hoses, serial communication cable, and air line (Figure 1-3 on page 4). 
Receptacles for the aerosol management and temperature control options are 
also located within the connection panel. The position of the fluidics cart is 
constrained only by the length of the connecting cables and hoses, which extend 
up to 9 feet (2.7 m). Typically, the cart is placed to the left or underneath the 
cytometer. 

To prevent foaming, do not fill the containers with solutions containing a 
high concentration of detergent.

Sheath filter

Sheath tank

Ethanol shutdown tank 3 Fluid filters

3 Auxiliary cleaning
fluid containers

Waste container
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Figure 1-3  Fluidics cart power and fluid line connectors on cytometer

Connecting to an External Air Supply

To connect the fluidics cart to an external air source, switch on the Auxiliary Air 
Supply and attach the external air line to the air input connector. The external air 
supply should provide 80–100 psi. The external air must be dust and oil-free. 

Figure 1-4  Connectors on fluidics cart
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NOTE There is a pull-out drip tray under the connection area. Check the tray 
periodically for moisture. See Checking the Fluidics Cart Drip Tray on page 203 
for details.

Power and Operation

Power to the fluidics cart is supplied by the cytometer. The cart is activated when 
the cytometer main power switch is turned on (see Power Panel on page 24).   

Figure 1-5  Fluidics cart flow gauge

Power to the fluidics cart is supplied and controlled through the flow 
cytometer. The fluidics cart voltage settings have been configured to match 
the supply voltage by your service engineer. To properly operate the fluidics 
cart, plug the fluidics cart power cord only into the power receptacle on the 
cytometer (Figure 1-3 on page 4). Do not plug the power cord directly into 
a wall socket. Do not change the input voltage selection switch on the 
fluidics cart.

When the stream is on, air pressure fluctuates between 80–100 psi 
(Figure 1-5). A pressure reading of less than 80 psi or greater than 100 psi 
indicates that the fluidics cart is not functioning properly. If this occurs, 
contact your BD Biosciences service representative for assistance. Do not 
operate the cytometer outside the normal air pressure range.

Pressure gauge 
at approximately 
88 psi
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See the following sections for more information about the fluidics cart:

• Setting Up the Fluidics Cart on page 108

• Refilling the Plastic Containers on page 112

• Emptying the Waste Container on page 114

• Scheduled Maintenance on page 182

• Fluidics Troubleshooting on page 244

Flow Cytometer

The benchtop flow cytometer contains the major components for all three 
subsystems (fluidics, optics, and electronics). The BD FACSAria II cytometer is 
relatively compact, with a much smaller footprint than most sorters with the 
same capabilities. The cytometer can be set up on a typical laboratory benchtop 
or table, and it requires only a 20-amp electrical outlet. No special facilities are 
required. 

Figure 1-6  BD FACSAria II flow cytometer

Flow cell 
access door

Side door

Sample injection chamber

Sort collection chamber

Optics access door
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To view the fluidics components, open the side door and lift the flow cell access 
door. To view the optics components, open the optics access door. The power 
panel and connectors are found on the left side of the cytometer. Other electronic 
components are embedded within the cytometer and do not need adjustment.

See the following sections for more information about the flow cytometer:

• Fluidics Components on this page

• Optics System on page 18

• Cytometer Electronics on page 24

• Emergency Stop Button on page 25

Fluidics Components

When the fluidics system is activated, the sheath fluid from the pressurized sheath 
tank is forced from the fluidics cart up into the cuvette flow cell where 
hydrodynamic focusing forces particles from the sample injection chamber 
through the cuvette in a single-file stream.

Within the cuvette flow cell, laser light is focused on the sample core stream. 
Fluorescent molecules excited by the different laser wavelengths are detected by 
the optics and analyzed by the electronics. Particles are then either transported to 
waste reservoirs via the waste aspirator, or sorted into a collection device within 
the sort collection chamber. 

The flow cell access door is equipped with a shutter mechanism that shuts 
off the laser light when the door is opened. To ensure there is no interruption 
to data acquisition, do not open the door while sorting or recording. 
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The following fluidics components are described in this section. See Figure 1-7 on 
page 8. For more information about fluidics, see Fluid Movement on page 28.

• Sample Injection Chamber on page 9

• Tube Holders on page 10

• Cuvette Flow Cell on page 11

• Integrated Nozzle on page 12

• Standard Nozzle on page 13

• Sort Block on page 13

• Sort Collection Chamber on page 17

Figure 1-7  Main fluidics components
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Sample Injection Chamber

The sample injection chamber is where sample is introduced into the flow 
cytometer. During acquisition, the chamber is pressurized to force sample toward 
the cuvette flow cell. 

Samples can be agitated and temperature-controlled within the sample injection 
chamber using controls in the software (see Fluidics Controls on page 63). You 
can view the amount of fluid remaining in your sample tube by pressing the 
chamber light button shown in Figure 1-8. 

Figure 1-8  Sample injection chamber

Do not use the chamber light for long periods with samples stained with 
light-sensitive reagents.

Chamber light 
button

Loading port

Tube holder

Splash shield

Emergency stop 
button

Sample
injection
chamber



10 BD FACSAria II User’s Guide   

Tube Holders

A variety of tube holders are provided with the cytometer to accommodate tubes 
from 15-mL centrifuge tubes to 1.0-mL microtubes (Figure 1-9). (For a list of 
compatible tubes, see Labware on page 263.) 

To load a tube, install the appropriate-size tube holder onto the loading port, and 
place a tube in the holder. Make sure to press the tube holder down firmly onto 
the metal rod in the loading port, so the tube holder is seated correctly each time 
a tube is installed.

When the Load button is clicked in the software (see Acquisition Controls on 
page 81), the loading port rises to enclose the tube within the chamber. 

Figure 1-9  Tube holders

After a tube is loaded, the Load button changes to Unload. Click the Unload 
button to lower the loading port after data has been recorded. After each tube is 
unloaded, sheath fluid flushes the sample tubing inside and out to reduce 
potential sample carryover. 

To prevent injury from moving parts, keep your hands and clothing away 
from the loading port when a tube is loading or unloading. Do not place 
objects under the loading port.

15 mL

12 x 75 mm

Tube holders

1 mL-microtube
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Cuvette Flow Cell

The cuvette flow cell is the heart of the BD FACSAria II cytometer (Figure 1-10). 
Within the flow cell, hydrodynamic focusing forces particles through the cuvette 
in a single-file stream, where laser light intercepts the stream at the sample 
interrogation point. 

Figure 1-10  Cuvette flow cell 

The unique flow cell design permits particles to flow through the cuvette at a low 
velocity (approximately 6 m/sec for the 70 micron Sort Setup), allowing longer 
exposure to laser energy. The cuvette is gel-coupled to the fluorescence objective 
lens to transmit the greatest amount of emitted light from the interrogation point 
to the collection optics (see Optics System on page 18). After passing through the 
cuvette, the stream is accelerated (to approximately 30 m/sec with the 70 micron 
Sort Setup) as it enters the nozzle tip, where the drop drive breaks the stream into 
droplets for sorting.

Flow cell

Laser beams

Nozzle

Nozzle locking
lever

Interrogation point
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Integrated Nozzle 

The BD FACSAria II cytometer is provided with integrated nozzles that have the 
seal fixed into the groove. With proper handling and maintenance, the seal is 
designed to stay in the nozzle and not need replacing.

The integrated nozzles are available in four sizes (70, 85, 100, and 130 μm) to 
accommodate a variety of particle sizes, plus a closed-loop nozzle for use in 
cleaning and shutdown procedures. The nozzle is keyed to a fixed position at the 
lower end of the cuvette. Because the nozzle is below the interrogation point, 
optical alignment is not affected when the nozzle is changed.

Figure 1-11  Integrated nozzles

See these sections for more information on the nozzle:

• Changing the Integrated Nozzle on page 205

• Cleaning the Integrated Nozzle on page 206

Bottom 
view

Seal

M indicates 
integrated nozzle
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If the seal in an integrated nozzle eventually comes out or gets damaged, you can 
replace the seal with a standard O-ring. See Temporary Replacement of a Seal on 
page 208.

Standard Nozzle 

Early BD FACSAria II systems were shipped with standard nozzles with a 
replaceable O-ring. If your system is equipped with standard nozzles, see Using 
the Standard Nozzle on page 208 for details on handling and maintaining them.

Sort Block

After leaving the nozzle, particles pass through the sort block where they are 
either transported to waste via the waste aspirator, or sorted into a collection 
device in the sort collection chamber. The sort block houses the high-voltage 
deflection plates, along with the aspirator and aspirator drawer (Figure 1-12).

Table 1-1  Nozzle handling recommendations

Recommended Action Result

Always use the integrated closed-loop nozzle 
for cleaning and shutdown procedures.

Keeps the flow cell clean and reduces 
chances for clogs. A clean flow cell 
provides improved sensitivity and 
higher performance.

Do not expose integrated nozzles to bleach or 
detergents such as CONTRAD® 70. Avoid 
any strong base solutions.

Prevents the seal from coming loose 
and falling out.

Do not wipe the surface of the seal with 
anything.

Prevents damage to the seal that could 
result in leaking.
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Figure 1-12  Sort block with door open

Note that the entire sort block assembly can be rotated on a fixed pivot point to 
adjust the position of the stream in the waste aspirator. If the keyed stream 
position differs between different nozzles, the stream might not hit the center of 
the aspirator after the nozzle is changed. In this case, you can change the angle of 
the sort block by loosening the adjustment screws on both sides of the deflection 
plates and rotating the sort block. An Allen wrench is provided in the accessory 
kit. Tighten the screws when the stream is re-centered in the aspirator.

Adjustment screws

Deflection plates

Aspirator drawer

Aspirator

Sort collection 
device
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Deflection Plates

The high-voltage deflection plates are used to deflect side streams during sorting. 
The plates are turned on and off using the Voltage control in the Side Stream 
window (see Side Stream Formation on page 49). A red warning light is 
illuminated whenever the plate voltage is on (Figure 1-14 on page 16).

Aspirator Drawer 

The aspirator drawer keeps the sort collection tubes covered until sorting begins 
(Figure 1-13). You can open and close the drawer using a control in the Sort 
Layout or Side Stream window (see Using Sorting Controls on page 92). When 
the Sweet Spot is on and a clog is detected during sorting, the drawer 
automatically closes to protect the sort collection tubes.

Figure 1-13  Aspirator drawer closed (left) vs open (right)

A 12,000-volt potential exists between the deflection plates when they are 
on. Contact with the charged plates results in serious electrical shock. Do 
not touch the deflection plates when the voltage warning light is 
illuminated, or when the software indicates that the plate voltage is on. The 
plates remain energized even when the sort block door is open. 

To avoid pinching your hands or fingers in the drawer, keep your hands 
away from the sort block during sorting.
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Aerosol Management 

During sample acquisition and sorting, the sort block door and flow cell access 
door should be kept closed to help contain potential aerosols (Figure 1-14). 

Figure 1-14  Sort block with door closed 

Additional aerosol removal is provided by the BD™ Aerosol Management 
Option (AMO). The AMO is an optional device that evacuates the sort collection 
chamber during sorting. The AMO is equipped with an ultra-low penetrating air 
(ULPA) filter to trap aerosolized particles. 

See Appendix C, BD Aerosol Management Option on page 275 for complete 
information on using this option.

Cell sorters that use droplet generation methods, like the BD FACSAria II, 
can produce aerosols around the sample stream. When acquiring 
biohazardous samples, follow universal precautions at all times. Keep the 
sort block door closed during sorting. If you need to access the sort block 
and you are working with highly infectious samples, consider turning off 
the stream before opening the sort block door.

Deflection plates 
warning light

Sort collection 
chamber

Sort block
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Sort Collection Chamber

Collection devices are installed in the sort collection chamber to collect sorted 
samples. The collection devices are designed in two pieces with a universal top 
that can be used with different tube configurations. Figure 1-15 shows the types 
of collection devices that are available. 

Figure 1-15  Sort collection devices 

An automated cell deposition unit (ACDU) that sorts into multiwell plates and 
onto microscope slides is available as an option. See Figure 1-16 on page 18. 
BD Biosciences also offers a temperature control option to maintain the 
temperature of sorted samples during sorting.

The sort collection chamber door should be kept closed when sorting into a plate. 
The door keeps the chamber free of dust and other airborne particles, and seals 
the chamber during aerosol evacuation for cytometers equipped with the AMO.

Four-way 1.5-mL 
Eppendorf

Universal top Four-way 1-mL
(optional)

Four-way 12 x 75-mm

Two-way 12 x 75-mm

Two-way 15-mL
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Figure 1-16  Plate Loader on ACDU 

Optics System

The BD FACSAria II cytometer uses innovative designs for both the excitation 
and collection optics. The optics can be viewed by opening the optics access door 
and the flow cell access door. 

Excitation Optics

The excitation optics consist of lasers, fiber optic cables, beam-shaping prisms, 
and an achromatic focusing lens, as shown in Figure 1-17 on page 20. For 
information about how signals are generated, see Signal Generation on page 32.

The flow cell access door is equipped with a shutter mechanism that shuts 
off the laser light when the door is opened. To ensure there is no 
interruption to data acquisition, do not open the door while sorting or 
recording.
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The BD FACSAria II cytometer uses low-powered, air-cooled and solid-state 
lasers that do not have special power or cooling requirements. See Table 1-2 for 
the laser choices. See Table 8-5 on page 251 for laser specifications. 

Fiber optics direct the laser light in a precise and constant manner onto beam-
shaping prisms, which in turn transmit the laser light to a focusing lens. The lens 
focuses the laser light onto the sample core stream within the cuvette flow cell 
(Figure 1-17). The lasers are positioned on the sample stream for optimal 
generation of signals. Since the optical pathway and sample core stream are 
fixed, optimization is constant from day to day.

Table 1-2  Laser configurations 

Laser Wavelength Comments

Blue 488 nm Standard

Red 633 nm Standard

Violet 405 nm Optional

Near UVa

a. When both the Near UV and violet lasers are installed, only one of them can be used at the same time. The 
laser power toggle switch determines which laser is active.

375 nm Optional (Uses the same optical path and PMTs 
as violet laser. See Appendix B on page 265.)

Lasers emit intense, coherent electromagnetic radiation that can cause 
irreparable damage to human skin and eyes. To prevent retinal burns and 
possible blindness, do not remove laser shielding, adjust laser controls, or 
attempt to service the cytometer any place where laser warning labels are 
attached. See the BD FACSAria II Safety and Limitations Guide for the 
placement of laser warning labels.
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Figure 1-17  Excitation optics pathway (behind laser shielding) 

Collection Optics

From the cuvette flow cell, laser light is collected by a fluorescence objective lens 
that is gel-coupled to the cuvette to transmit the maximum amount of light. The 
lens collects and focuses fluorescent light emitted at each of the laser focal points 
onto individual collection fibers. These fibers transfer the emitted light to the 
collection optics, as shown in Figure 1-18.
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Figure 1-18  Side view of flow cell, nozzle, and objective lens

The collection optics are set up in octagon- and trigon-shaped arrays that are 
engineered to maximize signal detection from each laser. This is accomplished by 
transmitting the highest wavelengths to the first photomultiplier tube (PMT), and 
reflecting lower wavelengths to the next PMT through a series of longpass 
dichroic mirrors. Bandpass filters in front of each PMT allow fine-tuning of the 
spectral wavelengths that need to be collected. Since reflection is more efficient 
than transmittance, this design greatly increases the multicolor detection 
capabilities of the cytometer. See Figure 1-19 on page 21.

Figure 1-19  Transmission pathways in an octagon
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Detectors 

A standard system is equipped with an octagon containing six PMTs that detect 
light from the 488-nm (blue) laser, and a trigon containing two PMTs that detect 
light from the 633-nm (red) laser. The third-laser option adds an additional 
trigon containing two PMTs to detect light from the 405-nm (violet) laser. If the 
optional 375-nm (near UV) laser is installed, it uses the same PMTs as the violet 
laser. 

Optical upgrades are available to fill the remaining PMT slots for a two- or three-
laser system. A fully-equipped system can detect up to 13 fluorescent markers 
and two scatter parameters at a time.

Figure 1-20  Fully loaded detector arrays

At installation, the octagon and trigon arrays are set up with the filter and mirror 
combinations shown in Table 8-7 on page 252. You can rearrange these 
configurations according to the type of fluorochromes in your experiment.
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Stream-Viewing Optics

The BD FACSAria II cytometer is equipped with optical components that are 
used to view the stream (Figure 1-21).

• The upper camera generates an image used to monitor drop formation. It is 
focused on the stream, just below the nozzle, to provide an image of the 
drop breakoff.

• The lower camera generates an image used for the BD FACS™ Accudrop 
option. It enhances the ability to see side streams and assists in setting an 
accurate drop delay value. 

Figure 1-21  Stream-viewing optics

Special image-processing software allows you to view the stream images from 
each camera within separate windows in BD FACSDiva software. See Sorting on 
page 44 for more information about viewing the streams and to learn how 
Accudrop components are used to determine the drop delay.

Diode laser Micrometer dial Lower camera 
viewing window

Upper 
camera
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Cytometer Electronics

The electronic components consist of power controls and connectors along with 
processing boards in the card cage. This section describes only user-adjustable 
cytometer electronics. For more information about the electronics, see Signal 
Detection on page 34.

Power Panel

Power to the cytometer, lasers, and fluidics cart is supplied by a power cord 
plugged directly into a standard electrical outlet. There are no special facilities 
requirements. The main power button turns on the cytometer and fluidics cart, 
and enables the laser power buttons. To turn on a laser, press the corresponding 
button. The button lights up when the power is on.

Figure 1-22  Flow cytometer power panel on 3-laser system

The cytometer circuit breaker is located next to the fluidics cart power cord 
(Figure 1-22). The switch will need to be reset if there is a power surge in the 
laboratory.
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Emergency Stop Button

The emergency stop button to the right of the loading port (Figure 1-23) is a 
safety feature that can be used to stop the movement of the loading port and 
ACDU stage. The button lights up when a tube is loading to remind you to keep 
your hands away from the loading port.

Figure 1-23  Emergency stop button

The following occur when this button is pushed:

• The tube is unloaded from the sample injection chamber.

• The ACDU stage (if in use) stops moving.

• The stream is turned off.

• The deflection plate voltage is turned off.

• The aspirator drawer (if open) closes to protect the sort collection tubes.

• A warning message appears on the screen.

 !Emergency stop button
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NOTE The emergency stop button does not turn off the lasers or shut down the 
cytometer main power.

Do not reset the button until the message appears. To reset the button, turn the 
button clockwise until the light turns off and the button returns to its original 
position.

Workstation

Data acquisition and analysis, as well as most BD FACSAria II cytometer 
functions, are controlled by BD FACSDiva software on a third-party PC 
workstation. The workstation includes a desktop computer, one or two monitors, 
and a color printer, and is equipped with the following applications:

• Microsoft Windows operating system 

• Microsoft Office application package

• BD FACSDiva software, version 6.1 or later

- Data acquisition and analysis

- Automatic fluidics startup, shutdown, and cleaning modes

- Sort setup, stream monitoring, clog detection, and recovery

- CS&T module for setup and tracking performance

• Supporting documentation for the software

For information about software features specific to the BD FACSAria II, see 
Chapter 2, Theory of Operation, and Chapter 3, Using BD FACSDiva Software. 
For general software information, See the BD FACSDiva Software Reference 
Manual. 

; Tip     For easy access to the online BD FACSDiva Software Reference Manual, 
select Help > Literature > Reference Manual.
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2

Theory of Operation

This chapter describes how the BD FACSAria II cytometer works and how 
BD FACSDiva software components are used to operate different system 
components. For a general overview of the software, see Chapter 3.

See the following sections for a description of these BD FACSAria II functions:

• Fluid Movement on page 28

• Signal Generation on page 32

• Signal Detection on page 34

• Electronic Processing on page 41

• Sorting on page 44
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Fluid Movement

The fluidics system is responsible for moving particles from the sample injection 
chamber through the cuvette flow cell for interrogation, and then to waste or into 
a collection device during sorting (Figure 2-1). The following sections describe 
the controls used to move fluids through the BD FACSAria II fluidics system. 

Figure 2-1  Fluidic movement via the fluidics system 
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Sheath Flow

When you turn on the cytometer, the main air compressor starts up. The fluidics 
system is activated when you select the Fluidics Startup command in 
BD FACSDiva software. During fluidics startup, sheath fluid is forced from the 
pressurized sheath tank through a filter and is delivered to the cuvette flow cell at 
a constant pressure. You can view the current sheath pressure setting using the 
Cytometer > Sheath Pressure command (Figure 2-2). 

Figure 2-2  Sheath pressure level 

After fluidics startup, sheath flow is controlled using the Stream button in the 
Breakoff window (Figure 2-3). When clicked, the button changes from a red “X” 
to a green checkmark, and sheath flows through the cuvette flow cell at the rate 
that is specified in the Sheath Pressure dialog. (See Drop Formation on page 45 
for a complete description of the Breakoff window.)

Figure 2-3  Stream control in Breakoff window

As a general rule, the sheath pressure level is set by selecting a sort setup mode 
from the Sort menu, rather than by adjusting the Sheath Pressure control. Each 
sort setup mode is optimized at a preset sheath pressure. If you change the sheath 
pressure, a multitude of other values will be affected and need updating, 
including the drop drive frequency, drop charge levels, laser delay, area scaling 
factor, and other values. For more information, see Sort Setup on page 85.
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Sample Flow

Sample is introduced into the cuvette when the Load button is clicked in the 
Acquisition Dashboard (Figure 2-4). After Load is clicked, the loading port rises 
to enclose the tube within the sample injection chamber. The chamber is 
automatically pressurized and the chamber pressure forces sample through the 
sample line into the cuvette flow cell. To stop sample flow after a tube is loaded, 
click the Stop Acquiring button. 

The sample flow rate is specified using the Flow Rate field in the Acquisition 
Dashboard. You can adjust the flow rate from 1–11, which corresponds to 
approximately 10–80 μL/min.

Figure 2-4  Load button and Flow Rate field in Acquisition Dashboard

Note that the relatively longer sample tubing on the BD FACSAria II cytometer 
results in a different flow rate between cells and beads. Thus, absolute counting 
using BD Trucount™ beads can yield erroneous results.
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Hydrodynamic Focusing

In the flow cell, pressurized sheath fluid surrounds the sample fluid to 
hydrodynamically focus the core stream of suspended cells into the center of the 
cuvette, where the particles are intercepted by the laser beam. 

The difference in pressure between the sheath fluid and the sample fluid can be 
used to vary the diameter of the sample core. A lower difference results in a relatively 
narrow core stream, while a higher difference results in a wider sample stream. 

Ideally, you want the core stream at its minimum diameter so that cells pass 
through the laser beam in a single-file stream. However, depending on your 
application, a lower resolution might be acceptable in order to acquire the data 
more quickly. For example, a higher flow rate is generally used for qualitative 
measurements such as immunophenotyping—the data is less resolved but is 
acquired more quickly. A lower flow rate is generally used in applications where 
greater resolution is critical.

Sheath flow Sheath flow Sheath flow
Sample flow

Sheath flow
Sample flow

Laser beams Laser beams

Low flow rate High flow rate
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Signal Generation

The following sections describe how signals are generated when cells or particles 
intercept the laser within the cuvette flow cell. 

Light Scatter

When a cell or particle passes through a focused laser beam, laser light is 
scattered in all directions. Light that scatters axial to the laser beam is called 
forward scatter (FSC). Light that scatters perpendicular to the laser beam is 
called side scatter (SSC). FSC and SSC are related to certain physical properties of 
cells:

• FSC indicates relative differences in the size of the cells or particles. 

• SSC indicates relative differences in the internal complexity or granularity 
of the cells or particles. 

Forward scatter

Side scatter

Light source
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Fluorescent Signals

When cells or particles stained with fluorochrome-conjugated antibodies or other 
dyes pass through a laser beam, the dyes can absorb photons (energy) and be 
promoted to an excited electronic state. In returning to their ground state, the 
dyes release energy, most of which is emitted as light. This light emission is 
known as fluorescence.

Fluorescence is always a longer wavelength (lower-energy photon) than the 
excitation wavelength. The difference between the excitation wavelength and the 
emission wavelength is known as the Stokes shift. Some fluorescent compounds 
such as PerCP exhibit a large Stokes shift, absorbing blue light (488 nm) and 
emitting red light (675 nm), while other fluorochromes such as FITC have a 
smaller Stokes shift, absorbing blue light and emitting green light (530 nm).

The emission spectra for some commonly used fluorochromes are shown in 
Figure 2-5. See Table 8-7 on page 252 for the corresponding detectors.

Figure 2-5  Emission spectra of commonly used fluorochromes
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Signal Detection

From the cuvette flow cell, scattered and fluorescent light is collected by the 
fluorescence objective lens. The lens collects and focuses fluorescent light emitted 
at each of the laser focal points onto individual collection fibers. These fibers 
transfer the emitted light to the individual detector arrays.

The following sections describe how laser light is detected and translated into 
signals that can be displayed in a plot.

Detector Arrays 

There are two types of detector arrays in the BD FACSAria II flow cytometer: 
octagon and trigon. The octagon detects SSC and up to seven fluorescence signals 
excited by the 488-nm (blue) laser. The trigons detect fluorescence signals excited 
by the 633-nm (red) and 405-nm (violet) lasers, respectively. Each trigon can 
detect up to three fluorescence channels. (An optical upgrade is required to fill all 
detection channels.) 

Figure 2-6  Octagon and trigon detector arrays

Each detector array houses dichroic and bandpass filters, which steer and filter 
the emitted light, and photomultiplier tubes (PMTs), which detect light signals.

Blue-laser signalRed-laser signalViolet-laser signal
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Filters 

Optical filters modify the spectral distribution of light scatter and fluorescence   
directed to the detectors. Three kinds of filters are used in the detector arrays: 
longpass (LP) filters are used to steer light between the detectors within a detector 
array, while bandpass (BP) and neutral density (ND) filters allow fine-tuning of 
the spectral wavelengths that need to be collected (Figure 2-7).

Figure 2-7  Detectors and filters in an octagon array
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Longpass Filters

Longpass (LP) filters pass wavelengths longer than the filter rating and reflect 
shorter wavelengths. For example, a 500 LP filter permits wavelengths longer than 
500 nm to pass through it and reflects wavelengths shorter than 500 nm 
(Figure 2-8).

Figure 2-8  Light reflection by longpass filter

Dichroic filters that are used to direct different color light signals to different 
detectors are called dichroic mirrors or beam splitters.

Although dichroic mirrors have the properties of LP optical filters, you cannot 
necessarily use any type of LP filter as a beam splitter. A beam splitter must have 
a surface coating that reflects certain wavelengths, but many types of LP filters 
are absorbance filters that do not have any specific reflective characteristics. Also, 
optical filters and beam splitters are rated at a specific angle of incidence. When 
used as a beam splitter, they are placed at an angle relative to the light source. 
Their optical properties are therefore designed for that angle of incidence.

The detector arrays use LP dichroic mirrors to steer progressively shorter 
wavelengths of light to the next PMT in the array. For example, in the octagon 
array, light first passes through a 735 LP filter in the A position, followed by a 
655 LP filter in the B position. Thus, wavelengths longer than 735 nm are 
detected at PMT-A. All wavelengths <735 nm are reflected to PMT-B. 
Wavelengths between 655 nm and 735 nm are detected at PMT-B. All wavelengths 
<655 nm are reflected to PMT-C, and so on. For a list of the longpass filters used 
in the detector arrays, see Table 8-7 on page 252.
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Bandpass Filters

Bandpass (BP) filters transmit a relatively narrow range or band of light. 
Bandpass filters are typically designated by two numbers. The first number 
indicates the center wavelength and the second refers to the width of the band of 
light that is passed. For example, a 500/50 BP filter transmits light that is 
centered at 500 nm and has a total bandwidth of 50 nm. Therefore, this filter 
transmits light between 475 and 525 nm (Figure 2-9).

Figure 2-9  Light transmittance by bandpass filters

Discriminating (DF) filters have the same general function—they transmit a 
relatively narrow band of light. The principal difference between BP and DF 
filters is their construction. DF filters have more cavities or layers of optical 
coatings, resulting in a steeper transmission curve than the curve for a BP filter. 
This steep slope means that a DF filter is better at blocking light outside the rated 
bandwidth of the filter. See Figure 2-10 on page 38.
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Figure 2-10  Bandpass (BP) vs discriminating (DF) filters

In the detector arrays, DF filters block high-intensity laser light and filter the 
remaining light to ensure that only the required wavelengths reach their intended 
detector. For example, in the octagon array, PMT-A has a 780/60 DF filter in 
front of it, which transmits light of 750–810 nm. Thus, the only wavelengths that 
will reach the A detector are those between 750 and 810 nm. 

For optimal detection of fluorescent light, a bandpass filter must always be 
installed in front of each detector. For a list of the bandpass filters used in the 
detector arrays, see Table 8-7 on page 252.
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Neutral Density Filters

Neutral density (ND) filters transmit a fixed percentage of light, reducing the 
transmitted intensity of all wavelengths equally. ND filters are neutral with 
respect to wavelength.

The ND1 filter on the BD FACSAria II allows approximately 10% of the light to 
be transmitted. You can find the ND filter in front of the FSC detector. For 
applications involving small particles (eg, bacteria or platelets), you might need 
to remove the FSC ND filter. For applications involving large particles where 
events appear off scale on the FSC axis with a gain of zero, a higher value ND 
filter is needed to decrease the FSC signal and keep the events on scale. 

The system comes with three ND filters: 1, 1.5, and 2. See Removing or Installing 
the FSC ND Filter on page 223.

ND1

10%
100%



40 BD FACSAria II User’s Guide   

Detectors

Detectors within each detector array convert light signals into electrical signals 
that can be processed by the electronics system.

There are two types of signal detectors in the BD FACSAria II flow cytometer: the 
photodiode and photomultiplier tubes (PMTs). The photodiode is less sensitive to 
light signals than the PMTs, and is used to detect the stronger FSC signal. The 
photodiode detects FSC light from the blue laser, and is stored outside the 
detector arrays. PMTs are used to detect the weaker signals generated by SSC and 
all fluorescence channels. The octagon can hold up to eight PMTs. Each trigon 
can contain up to three PMTs. 

Each PMT detects only one fluorochrome at a time. In BD FACSDiva software, 
the Cytometer Configuration window lets you define which fluorochromes or 
cell parameters will be measured at each PMT detector. If more than one 
fluorochrome is measured using the same PMT, you can add additional 
parameters to your configuration and select the appropriate fluorochrome within 
your software experiment. See Cytometer Configuration on page 68 for more 
information.

Figure 2-11  Example BD FACSAria II cytometer configuration
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Electronic Processing 

As cells or other particles pass through the focused laser beams, they scatter the 
laser light and can emit fluorescence. Because each laser beam is focused on a 
small spot and particles move rapidly through the flow cell, the scatter or 
fluorescence emission has a very brief duration—only a few microseconds. The 
PMTs convert this brief flash of light into an electrical signal called a pulse 
(Figure 2-12).

Figure 2-12  Anatomy of a pulse

A pulse begins when a particle enters the laser beam. At this point, both the 
beam intensity and signal intensity are low.

The pulse reaches a maximum intensity or height when the particle reaches the 
middle of the beam, where the beam and signal intensity are the brightest. The 
peak intensity, or height of the pulse, is measured at this point.

As the particle leaves the beam, the pulse trails off.
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Pulse Parameters

A parameter is a pulse property that is 
generated by a single PMT or photodiode, 
measuring fluorescent or scattered light. You 
can measure three characteristics of a pulse: 
area, height, and width. The pulse height 
measures the maximum digitized value for the 
pulse, the pulse area calculates the sum of all 
height areas for the pulse, and the pulse width 
calculates .

You can select which pulse characteristics you 
want to measure for each parameter using the 
Parameters tab. Pulse area (A) is measured by 
default. The Parameters tab also contains voltage controls that allow you to 
amplify signals by applying a voltage to PMTs or an electronic gain to the FSC 
signal. As the voltage is increased, the detector sensitivity increases, resulting in 
increased signal. As the voltage is decreased, the detector sensitivity decreases, 
resulting in decreased signal.

Digital data is displayed on an 18-bit linear scale, from 2.6–262,144. Select the 
Log checkbox to convert the display to a log scale. The Experiment Inspector 
contains an option to display log data on a four- or five-decade scale. (See the 
BD FACSDiva Software Reference Manual for more information.)
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Laser Delay

Sample interrogation takes place within the cuvette flow cell. Fiber optic cables 
are used to direct laser light through a series of prisms that focus each laser on 
the stream at a separate position. This allows optimal detection of fluorescence 
signals from each laser with minimal cross-contamination from the other beams.

In a three-laser system, the red laser intercepts the stream first, followed by the 
blue and then the violet laser. Because the laser signals are spatially separated, 
there is a slight delay between the detection of each laser’s signal (Figure 2-13). 

Figure 2-13  Signal separation over time

The delay factor in BD FACSDiva software is used to realign the signals so they 
can be measured and displayed on the same time scale. Note that signals are 
aligned with respect to the blue laser, so the red laser signals always have a 
negative delay value.

Time

Cell enters and leaves 
the first laser intercept

Cell enters and leaves the 
second laser intercept

Cell enters and leaves 
the third laser intercept

Red

Blue

Violet



44 BD FACSAria II User’s Guide   

Sorting

During sorting, drop drive energy is applied to the stream to break it into highly 
uniform droplets. Droplets detach from the stream a few millimeters downstream 
from the nozzle. The time between when a particle intercepts the laser and when 
it reaches the droplet breakoff point is determined using BD FACS Accudrop 
technology (see Drop Delay Overview on page 51). 

When a particle is detected and meets the predefined sorting criteria, an electrical 
charge is applied to the stream just as the droplet containing that particle breaks 
off from the stream. Once broken off from the stream, the droplet—now 
surrounded by air—still retains its charge. The charged droplet passes by two 
strongly charged deflection plates. Electrostatic attraction and repulsion cause 
each charged droplet to be deflected to the left or right, depending on the 
droplet’s charge polarity. Uncharged droplets are not affected by the electric field 
and pass down the center to the waste aspirator. See Figure 2-14 on page 45.

The following sections describe how the BD FACSAria II cytometer creates and 
charges drops, how the drops are deflected, and how sorting populations are 
identified.
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Figure 2-14  Sorting

Drop Formation 

The BD FACSAria II cytometer constantly applies drop drive energy to the 
stream. Droplets form as soon as you turn on the stream. Sample interrogation 
takes place upstream of the stream vibration so that analysis is not affected by 
the drop drive.

A drop breakoff image is created using an LED strobe and a video camera. The 
image is displayed in the Breakoff window. (See Breakoff Window on page 46.) 
Patented Sweet Spot technology analyzes the drop breakoff image and provides 
feedback to the appropriate cytometer controls.

Charge is applied via the stream-charging wire in 
the barb.

The sample generates light scatter and 
fluorescence signal. The signal is analyzed.

The charged droplet breaks off.

Deflection plates attract or repel the charged 
droplet.

Uncharged droplets pass to waste.

Charged drops containing particles of interest are 
collected.
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Breakoff Window 

The upper camera transmits an image of the drop breakoff to the Breakoff 
window, where video image processing software converts the visual 
characteristics of the image into numerical properties. The drop breakoff 
is analyzed for two key features: Drop 1 and Gap.

Drop 1 is defined as the number of pixels from the top of the image to the 
center of gravity of the first broken-off drop. A thin gray line on the image 
is used to identify this drop. The number shown to the right of the Drop 1 
field at the bottom of the window is the actual pixel location of the gray 
line. The number entered into the Drop 1 field is the user-defined Drop 1 
target.

The Gap is defined as the number of pixels from the first discontinuity in 
the stream to the next stream object, generally the first broken-off drop. A 
gray line of varying thickness represents the Gap. The number shown to 
the right of the Gap field is the pixel width of the gray line. The number 
entered into the Gap field is a user-defined target. 

When the Sweet Spot is turned on, the drop drive amplitude (Ampl) is 
automatically adjusted to approximately match the target Drop 1 and Gap 
values. The amplitude is initially adjusted in larger increments until Drop 
1 is achieved. The amplitude is then adjusted in smaller increments until 
the cytometer attains the target Gap. The Sweet Spot feature will make 
adjustments as necessary to maintain the required breakoff conditions 
throughout the day.

The Sweet Spot performs two other functions during sorting. When 
sorting, if the Drop 1 or Gap are out of range, sorting is paused until the 
values are back within range. This ensures that sorting occurs only under 
the proper breakoff conditions. If a more severe problem such as a clog is 
detected by the Sweet Spot, the stream is shut off and sorting is stopped, 
the deflection plates shut off, the aspirator drawer closes, and the sample 
tube is unloaded.

Pre-programmed values can be downloaded to the Breakoff window by 
selecting one of the nozzle sizes (70, 85, 100, 130 micron) from the Sort > 
Sort Setup menu.
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Note that changes to values in the Sort Setup windows (Breakoff and Side 
Stream) are automatically saved. At startup, the last settings used on the 
cytometer are restored, except the Stream and Sweet Spot controls which always 
default to off. For more information, see Sort Setup on page 85. 

Table 2-1  Breakoff window controls

Control Description

Stream button Turns the stream on and off.

Sweet Spot 
button

Enables automatic adjustment of the drop drive 
amplitude to maintain the stability of the breakoff 
point.

When the Sweet Spot is on, the Amplitude and 
Frequency fields are disabled. The amplitude is 
automatically adjusted by the software. To enable the 
fields, turn off the Sweet Spot.

Amplitude field Adjusts the amplitude or intensity of the drop drive, 
from 1.0–80.0 volts.

The drop drive amplitude determines the breakoff 
point. A higher amplitude value results in a shorter 
stream breakoff. A lower amplitude results in a longer 
stream breakoff. Typically, the amplitude is set once, at 
the beginning of a sorting experiment, and then 
maintained via the Sweet Spot.

Frequency field Determines the number of drops formed per second and 
the size of the drops. (Drop size is also influenced by 
the nozzle size.)

The drop drive frequency can be adjusted from 1.0–
102.0 kHz. The higher the frequency, the more drops 
are generated per second and the smaller the drops. The 
lower the frequency, the fewer drops generated per 
second and the larger the drops.

On Off

On Off
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Typically, when setting up for sorting, you use the Amplitude to set the required 
drop breakoff, and copy the generated Drop 1 value to the target field. Then, you 
turn on the Sweet Spot to maintain the drop breakoff. When the Sweet Spot 
detects a >1-pixel difference between the target Gap setting and the actual Gap, it 
adjusts the Amplitude to reduce the Gap. When a >2-pixel difference is detected, 
the Sweet Spot stops sorting temporarily (stops charging the stream) until the 
Gap is restored. Note that when the sort is paused, the sample continues to flow. 
Once the Gap is back within range, sorting automatically resumes.

For information on setting the breakoff, see Setting Up the Breakoff on page 105.

Frequency field 
(continued)

In general, the drop drive frequency should not need adjustment. We 
recommend using the default values that are entered with each Sort 
Setup mode.

Drop 1 field The distance between the top of the image and the center of the first 
broken-off drop, from 100–600 pixels.

When you enter a value and turn on the Sweet Spot, the cytometer 
automatically adjusts the amplitude to attain your target value. 

Note that not all Drop 1 targets are attainable. The Drop 1 value 
jumps in whole increments of approximately 57 pixels according to 
your drop spacing. 

The same Drop 1 setting should be used from day to day. A difference 
of up to 10 pixels between the target value and the actual value is 
acceptable.

Gap field The gap between the stream breakoff and the top of the first drop.

The default Gap setting for a 70 micron nozzle is 6 pixels. 

Table 2-1  Breakoff window controls (continued)

Control Description
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Side Stream Formation

Side streams are formed when the voltage is on and you are sorting, or when you 
click Voltage, then Test Sort in the Side Stream window. 

The Side Stream window displays an image of the side streams as transmitted by 
the lower camera. In addition to the stream image, the Side Stream window 
contains the controls used to adjust electrical charges and to determine the drop 
delay using Accudrop, as described in Drop Delay Overview on page 51.

Figure 2-15  Side Stream window

Controls in the Side Stream window are described in Table 2-2 on page 50. You 
can send different values to the Side Stream window by selecting a nozzle size 
from the Sort > Sort Setup menu.

Note that changes to values in the Sort Setup windows (Side Stream and 
Breakoff) are linked to the sort setup and are automatically saved. At startup, the 
last settings used on the cytometer are restored, except the states of the Voltage, 
Test Sort, and Optical Filter buttons, which always default to off. For more 
information, see Sort Setup on page 85.
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Table 2-2  Side Stream window controls

Control Description

Voltage button Turns the plate voltage on and off.

Test Sort button Generates test side streams based on test sort pulses. 

Optical Filter button Controls the position of the optical filter in front of the lower 
(Accudrop) camera.

Attenuation button Decreases the amplitude of the drop drive. At lower pressures, 
you may need to turn on attenuation to dampen the amplitude.

Waste Drawer button Opens or closes the aspirator drawer depending on its current 
state. The default state is closed. For more information, see 
Aspirator Drawer on page 15.

Drop Delay field Sets the amount of time between when an event is measured 
and the breakoff point, from 10–140 drops. The drop delay 
value determines which drop will be deflected. 

The drop delay value is set experimentally using BD FACS 
Accudrop technology.

Auto Delay Opens the Auto Drop Delay dialog. 

Voltage sliders (far 
left, left, right, far 
right)

Set the percentage of charge to be applied to the corresponding 
stream (as a percentage of maximum).

Voltage Center slider Adjusts the relative voltage between the left and right plates 
which moves the streams slightly to the left or right as a whole. 
In general, the slider rarely needs adjusting.

On Off

On Off

In Out

Off On

Closed Open
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Drop Delay Overview

The BD FACSAria II cytometer includes integrated Accudrop technology to assist 
in setting an accurate drop delay value. Accudrop components consist of the 
following:

• A diode laser, mounted to the left of the sort block

• A camera that provides an image of the side streams

• An emission filter for viewing the fluorescence from BD FACS™ Accudrop 
beads

The emission filter is installed in front of the lower camera and can be moved in 
and out by clicking the Optical Filter control. When the button is green ( ), the 
filter is out. This position is used to view the center and side streams. 

Click the button to move the filter in front of the camera when you are 
determining the drop delay. The button changes to red ( ). To determine the 
drop delay, the streams are illuminated by the diode laser just below the point of 
deflection. Specialized fluorescent particles (Accudrop beads) can be viewed in 
the center and left side streams as the delay is adjusted. The best delay yields the 
most particles in the left stream and the fewest in the center stream. 

Plate Voltage field Adjusts the total voltage difference between the plates, which 
determines the angle of stream deflection. The voltage values 
change with different nozzle sizes. 

2nd, 3rd, 4th Drop 
fields

Apply a correction factor for the drop charge as a percentage of 
the previous drop, from –100% to 100%.

Phase field Adjusts the phase between drop generation and charging of the 
droplets from 0–360°.

The selected value is sent to both the drop-charging electrode 
and the drop strobe. In general, the Phase never needs 
adjusting. You can keep the default value of zero.

Table 2-2  Side Stream window controls (continued)

Control Description
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See Determining the Drop Delay – Manual Method on page 154 for more 
information.

Auto Drop Delay

The Auto Drop Delay feature enables the system to optimize the drop delay 
automatically. See Determining the Drop Delay – Automatic Method on 
page 159.

Drop Charging

Drops are charged when an event is detected and meets the defined sorting 
criteria, as specified in the Sort Layout window.

The Sort Layout window contains all sorting instructions and controls 
(Figure 2-16). The sort layout designates which device will be used to collect 
sorted particles and which particles will be sorted into each sort location. Up to 
four sort counters can be displayed in the window to give ongoing status during a 
sort. See Sort Layout on page 87 for more information about the Sort Layout 
window.

Figure 2-16  Sort layout for a four-way sort

Target events are identified by drawing gates around populations of interest in 
plots. The Sort Layout window specifies which gated population should be sorted 
into each sort collection tube or spot in a plate or on a slide. During sorting, 
when an event is identified within one of the sort gates, the drop containing the 
particle of interest is charged via the stream-charging wire attached to the flow 
cell. See Figure 2-17 on page 53.
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Figure 2-17  Flow cell with stream-charging wire

The amount and type of charge determines where the drop will be sorted. For 
example, in a four-way sort, drops with the most charge will be deflected into the 
outer streams, while drops with less charge will be deflected into the inner 
streams.

Conflict Resolution During Sorting

During sorting, the cytometer deflects drops based on the characteristics of the 
particles in each drop and where the user wants to deflect them. Conflicts can 
occur depending on the type of target particle, where the particle is located 
within a drop, or whether the drop is free of contaminating particles. 
BD FACSDiva software accurately measures particle position to within 1/32 of a 
drop.

Mask settings determine how drops are deflected 
when sorting conflicts occur. There are three mask 
settings, each of which addresses a different type of 
conflict. These settings are combined to define sort 
precision modes. Each mode is made up of a set of 
masks. Precision modes are defined in the Sort 
Precision dialog, accessed from the Sort menu.

Stream-charging wire
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Yield Mask

The yield mask setting defines how close to the edge of the drop, in 1/32-drop 
increments, a particle of interest can be located before sorting an additional drop. 
Half of each yield mask setting defines an equal area at each end of the drop.

For example, when the yield mask is set to 16 and an event is within 8/32 from 
the beginning of a drop, the previous (leading) drop will be sorted. If an event is 
within 8/32 from the end of a drop, the following (trailing) drop will be sorted. 
See Figure 2-18.

Figure 2-18  Target particle within a yield mask of 16

If the yield mask were set to 8 for the same target particle, the target particle 
would fall outside of the yield mask. Therefore, no additional drops would be 
sorted. See Figure 2-19.

Figure 2-19  Target particle outside a yield mask of 8

When the yield mask is set to zero, only one drop (the drop containing the target 
particle) will be deflected. When the mask is set to 32, two drops will always be 
deflected. Yield masks between 0–32 will sort either one or two drops. 

Yield masks cannot be used in conjunction with phase masks. Therefore, when 
the yield mask is greater than zero, the phase mask automatically reverts to zero.

Trailing drop: sorted Drop being interrogated Leading drop: not sorted

Target particle

Yield mask Yield mask

Trailing drop: not sorted Drop being interrogated Leading drop: not sorted

Yield mask

Target particle

Yield mask
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Purity Mask

The purity mask setting defines how close, in 1/32-drop increments, a 
contaminating drop can be located before ignoring the drop being interrogated.

For example, when the purity mask is set to 16, the drop being interrogated will 
not be sorted if a non-target particle falls within the first or last 8/32 of the 
leading or trailing drop. In the following example, a non-target particle falls 
within the first 8/32, so the interrogated drop will not be sorted. See Figure 2-20.

Figure 2-20  Non-target particle within a purity mask of 16

If the purity mask were set to 8 for the same target particle, the non-target 
particle would fall outside of the purity mask, so the interrogated drop would be 
sorted. See Figure 2-21.

Figure 2-21  Non-target particle outside a purity mask of 8

With any purity mask greater than zero, the drop being interrogated must be free 
of contaminating particles or the drop will not be sorted. If the purity mask is set 
to zero, a droplet containing the event of interest will be sorted regardless of 
contaminating particles.

Trailing drop Leading drop

Purity mask Purity mask
Non-target particle

(Not sorted)

Drop being interrogated

Purity mask Purity mask
Non-target particle

(Sorted)

Trailing drop Leading dropDrop being interrogated
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Phase Mask

Particles near the drop edge can affect the breakoff and alter the trajectory of the 
deflected drop. The phase mask restricts drop deflection when an event is too 
close to the edge of a drop or when there are events close to the edge of adjacent 
drops. A phase mask is used to improve counting accuracy and side-stream 
quality at the expense of yield.

For example, when the phase mask is set to 16, the drop being interrogated will 
be sorted only if the target particle falls outside the phase mask. See Figure 2-22.

Figure 2-22  Sorted and unsorted drop with phase mask of 16

Decreasing the phase mask to 8 allows more drops to be sorted. However, 
because the target particle is closer to the edge of the drop, there is more 
variability in drop trajectory. See Figure 2-23.

Figure 2-23  Sorted drop with phase mask of 8

; Tip     We recommend using a phase mask of at least 8 when sorting single cells.

Phase masks cannot be used in conjunction with yield masks. Therefore, when 
the phase mask is greater than zero, the yield mask automatically reverts to zero.

Trailing drop (Drop sorted) Leading drop

Phase mask

Trailing drop (Drop not sorted) Leading drop

Phase mask

Trailing drop Leading drop

Phase mask

(Drop sorted)
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Sort Precision Modes

Mask values can be combined in many different ways. By default, six sort 
precision modes are already defined: Purity, 4-Way Purity, Yield, Single Cell, 
Initial, and Fine Tune.

• Purity mode. The yield mask is set to the maximum to obtain the greatest 
number of particles. Because the purity mask is also set to the maximum, 
only drops free of contaminating particles will be sorted. Sorting in Purity 
mode results in a sorted sample that is highly pure, at the expense of 
recovery and yield.

• 4-Way Purity mode. The purity mask is set to the maximum, so only drops 
free of contaminating particles will be sorted. The yield mask is set to zero 
to ensure that residual charges from adjoining drops do not degrade the 
quality of side streams. The 4-Way Purity mode is recommended for four-
way sorting where precise deflection is required.

Precision Mode

Purity
4-Way 
Purity

Yield
Single 
Cell

Initial
Fine 
Tune

Yield Mask 32 0 32 0 32 0

Purity Mask 32 32 0 32 0 0

Phase Mask 0 0 0 16 0 0

Single Cell � � � ⌧ � �
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• Yield mode. Only the yield mask is used at its maximum value. Recovery 
and yield are optimized at the expense of purity. The yield mode could be 
used as a first round sort for enrichment of target particles, followed by a 
sort for purity.

• Single Cell mode. The purity mask is set to the maximum, so only drops 
free of contaminating particles will be sorted. The phase mask is set to half 
the maximum, so only particles centered within the sorted drop are 
deflected. Drop trajectory and count accuracy are optimized at the expense 
of yield. This mode is recommended for plate sorting or situations where 
precise counting is required.

The remaining modes are used mainly during drop delay determination. Initial 
mode is equivalent to Yield mode, but it is named differently as a reminder to use 
this as the initial mode when using Accudrop to set the drop delay.

• Initial mode. Only the yield mask is used at its maximum value. Recovery 
and yield are optimized at the expense of purity. 

• Fine Tune mode. All masks are set to zero to deflect the maximum number 
of drops. This mode is used to fine-tune the drop delay value. See 
Determining the Drop Delay – Manual Method on page 154 for more 
information.
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Defining New Precision Modes

Default Precision modes cannot be edited or deleted. However, you can create 
new modes and then select them from the Precision Mode menu.

1 Select Sort > Sort Precision.

2 Click Add, and the current sort mode is duplicated and the Mask fields are 
enabled.

3 (Optional) Change the name of the mode in the Precision Mode field.

4 Enter values for the Yield, Purity, and Phase Masks.

5 Select the Single Cell checkbox, if needed.

6 Click Close.

The new mode is added to the Precision Mode menu.

To delete a mode, select it from the Precision Mode menu and click Delete.
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3

Using BD FACSDiva Software

Many BD FACSAria II cytometer functions are controlled using BD FACSDiva 
software. This chapter provides a general overview of the workspace components 
and describes software controls that are unique to the BD FACSAria II cytometer. 
For an in-depth description of software components not described in this chapter, 
see the BD FACSDiva Software Reference Manual.

The following topics are covered in this chapter:

• Workspace Components on page 62

• Cytometer Controls on page 63

• Sorting Controls on page 83

• Templates on page 97
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Workspace Components

When you start BD FACSDiva software, the workspace appears (See Figure 3-1). 
For a general overview of the workspace and to get started using the software, 
see Getting Started with BD FACSDiva Software. When running BD FACSDiva 
with the BD FACSAria II, two additional windows can be displayed by clicking 
the Sorting button on the Workspace toolbar. See Sorting Controls on page 83 for 
a description.

Figure 3-1  BD FACSDiva workspace
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Cytometer Controls

Most BD FACSAria II–specific cytometer controls are 
accessed through the Cytometer menu. Controls on the 
Cytometer menu are described in the following sections:

• Fluidics Controls on page 63

• Cytometer Configuration on page 68

• Cytometer Status Report on page 72

The Cytometer Details and the Catalogs menu commands 
are described in the BD FACSDiva Software Reference 
Manual. Additional cytometer controls are located in the 
Acquisition Dashboard. See Acquisition Controls on 
page 81. 

Fluidics Controls

Fluidics control of the BD FACSAria II cytometer is partially automated by 
BD FACSDiva software. The software contains pre-programmed fluidics 
protocols that are activated by selecting the corresponding menu command from 
the Cytometer menu. In addition, fluidics level indicators are available in the 
Cytometer window. See Fluidics Level Indicators on page 67. 

Fluidics Startup

During fluidics startup, waste and sheath levels are verified and the fluidics 
system is primed with sheath solution. The fluidics status is displayed at the 
bottom of the main window. 

See Cytometer Startup on page 100 for more information. 
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Fluidics Shutdown

Fluidics shutdown removes sheath fluid from the lines, replaces it with ethanol, 
and cleans the cuvette with a cleaning solution. See Fluidics Shutdown on 
page 178 for more details.

Change Sample Filter

Sample line filters can be installed to filter a sample before sorting. This selection 
opens the Sample Filter Change wizard, which guides you through the process. 
See Installing or Removing a Sample Line Filter on page 212 for the instructions.

Cleaning Modes

BD FACSDiva software contains pre-programmed cleaning modes that are 
activated by selecting the corresponding menu command from the Cytometer > 
Cleaning Modes menu. See Internal Cleaning on page 183 for more information.

Sheath Pressure

The sheath pressure determines how quickly particles pass through the laser 
beam. Select Cytometer > Sheath Pressure to view the current sheath pressure and 
change the pressure for custom sort setups.
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Sample Agitation

Select Cytometer > Sample Agitation to specify the speed at which samples are 
agitated. You can select from one of the specified values, or select Off to turn off 
agitation.

Each sort setup option is optimized at a preset sheath pressure. If you 
change the sheath pressure, many other values will be affected and need 
updating, including the drop drive frequency, drop charge levels, laser 
delay, and area scaling factor. For proper cytometer operation, change the 
sheath pressure by selecting an option from the Sort > Sort Setup menu. Do 
not adjust the pressure using controls in the Sheath Pressure dialog. Note 
that the Sheath Pressure command is disabled when the Sweet Spot is on.
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Sample Temperature

Use the Sample Temperature command to set the temperature inside the sample 
injection chamber. You can select from one of the specified values, or select Off to 
turn off temperature control (Figure 3-2).

Figure 3-2  Setting the sample temperature

The cooling/heating unit is designed to maintain the temperature of a sample 
tube. It is not designed to cool or heat the sample. It takes approximately 45 
minutes to reach the required temperature inside the chamber, during which time 
the chamber must be kept closed.

To cool or heat the chamber, install a sample tube and click Load. Click Stop 
Acquiring to keep the chamber closed and stop running the sample. To maintain 
the temperature, do not leave the chamber open for extended periods while 
changing sample tubes.

The sample temperature retains the last setting after startup. For example, if it 
was set to 20 C the last time the system was used, then it will return to that 
setting the next time the system is started up.

Cooling/heating 
unit for sample 
injection chamber
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Fluidics Level Indicators

BD FACSDiva software provides fluidics level indicators in the Cytometer 
window (Figure 3-3). The sheath and waste indicators provide an approximate 
indication of the fluid levels in each tank. The DI, bleach, and ethanol tank 
indicators appear full until the fluid level is below 20% of the tank capacity. 
When this occurs, the corresponding level indicator changes to black. 

NOTE The stainless steel ethanol shutdown tank does not have a level sensor. It 
must be checked manually.

Figure 3-3  Fluid level indicators

When the sheath is low or the waste is full while the stream is running, the 
corresponding indicator turns red and the following warning message is 
displayed every 5 minutes until the stream is turned off. If the warning message is 
not dismissed, the system automatically turns off the stream after 15 minutes. 

Do not dismiss the warning message without refilling the sheath or 
emptying the waste. If you continue to run the cytometer after dismissing 
the message, the system could shut down.

EthanolBleachDIWasteSheath
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Cytometer Configuration

The menu selections shown in Figure 3-4 open the Cytometer Setup and Tracking 
(CS&T) module in a separate window. The CS&T module enables you to 
perform multiple functions related to cytometer configuration. 

NOTE When the CS&T module is open, BD FACSDiva software goes into a 
holding mode and does not accept any user input. When CS&T is closed, BD 
FACSDiva becomes active again.

Figure 3-4  Cytometer menu selections that open CS&T

• View Configurations. Opens the Cytometer Configuration window within 
the main CS&T window. See the following section for an overview of this 
function. 

• CST. Opens the CS&T module. See the BD Cytometer Setup and Tracking 
Application Guide for complete information on using CS&T.

• Performance Tracking (LJ). Opens the performance tracking feature within 
the main CS&T window. See the BD Cytometer Setup and Tracking 
Application Guide for complete information on using this feature.

Menu selections that open the 
CS&T module
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Cytometer Configuration Window

The BD FACSAria II cytometer is equipped with a specific set of lasers, filters, 
and dichroic mirrors. The Cytometer Configuration window lets you define 
which fluorochromes or cell parameters will be measured at each photomultiplier 
tube (PMT) detector. Within this window, you can define parameters for an 
unlimited number of fluorochromes, up to four lasers, and all of the detectors.

Select Cytometer > View Configurations to open the window shown in 
Figure 3-5 on page 70. Click the Parameters tabs for a list of parameters. Click 
the Filters and Mirrors tab for the list of optics.

The Cytometer Configuration window also displays these settings:

• Sheath pressure

• Nozzle size

• Window extension

See the BD Cytometer Setup and Tracking Application Guide for more 
information on editing configurations, including adding parameters, mirrors, and 
filters.
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Figure 3-5  Example configuration for a three-laser system

Before you start any experiment, verify that the cytometer configuration contains 
appropriate parameters for the samples you are running and that the cytometer 
optics match the current configuration. If needed, you can add or modify 
parameters in an existing configuration or define a custom configuration, as 
described in Custom Configurations on page 74. 

For accurate data results, the cytometer optics must match the current 
cytometer configuration.
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Selections in the Cytometer Configuration window determine which parameters 
are available for your experiment. When more than one parameter is available 
for a detector, the first parameter is listed by default. To select a different 
parameter, click the name in the Parameters tab of the Cytometer window in BD 
FACSDiva software and select a different parameter from the menu.
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Cytometer Status Report

The Cytometer Status Report provides a list of all cytometer settings at the time 
the report was created. You must be connected to the cytometer to create the 
report. In an open experiment, click to set the current tube pointer and select 
Cytometer > Cytometer Status Report. The report is displayed in a separate 
window with a menu bar above the report header. The header lists the cytometer 
name, type, serial number, and the date and time the report was generated. See 
Figure 3-6 on page 73 for a sample report.

For a full description of the Cytometer Status Report, see the BD FACSDiva 
Software Reference Manual. A BD FACSAria II cytometer report includes the 
following additional information: user access privileges, cytometer information, 
cytometer settings, and sorting settings. The report can be printed or exported.

• The User Access Privileges section lists access settings for the current user.

• The Cytometer Info section lists values for laser delay, area scaling, window 
extension, FSC area scaling, sheath pressure, and sample flow rate. 

• The Parameters section displays settings for the current acquisition tube. 

• The Sort Settings section lists all sort setup values, along with the Plate 
Voltage and Voltage Center values. If the Sweet Spot is off, Breakoff and 
Gap values are shown. If the Sweet Spot is on, Drop 1 and target Gap 
values are shown.
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Figure 3-6  Cytometer Status Report
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Custom Configurations

Before you can record data, you must first ensure that the cytometer 
configuration is appropriate for the experiment. If needed, you can create custom 
configurations to add parameters or filters and mirrors that are not listed in the 
base configuration. You will also need to create custom configurations for each 
sheath pressure you would like to run.

When creating custom configurations, use descriptive names that make it easy to 
identify the configuration. See the BD FACSDiva Software Reference Manual 
and the BD Cytometer Setup and Tracking Application Guide for more 
information. 

Preparing for Custom Configurations 

Custom configurations can only be created by users with administrator access. 
The easiest way to create a custom configuration is to copy and edit a base 
configuration. You can also create a new, blank configuration.

1 Log in to the software as an administrator.

2 Select Sort > Sort Setup and select the setup mode that matches the nozzle 
size you are using.

3 Verify that the correct nozzle is installed, then start the stream.

4 Select Cytometer > CST.

The Cytometer Configuration window appears. (See Figure 3-5 on 
page 70.) For users with administrator access, the window displays the 
Parameters and Filters and Mirrors tabs, which are not visible to users with 
operator access.

NOTE When you create a new configuration in CS&T, you need to run a 
new baseline for that configuration. Once the baseline is established, you 
cannot edit any of the settings in the configuration. 
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Adding Parameters, Filters, and Mirrors

Before creating a custom configuration, verify that the necessary parameters, 
filters, and mirrors required for the custom configuration are defined.

1 To add new parameters, do the following in the Parameters tab:

a Click Add.

b Enter a parameter name in the field provided.

2 To add filters or mirrors, do the following in the Filters and Mirrors tab:

a To add a filter, click Add under the Filter list. To add a mirror, click 
Add under the Mirror list.

b Select a pass type and enter a wavelength in the field provided.

Enter new
parameter
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Copying a Base Configuration 

You cannot edit or delete your base configuration. However, you can use it as a 
starting point to create a custom configuration. 

1 In the Configurations tab, right-click the Base Configurations folder and 
select New Folder.

2 Rename the new folder Custom Configurations.

3 Right-click the base configuration and select Copy.

4 Right-click the Custom Configurations folder and select Paste.

5 A copy of the base configuration is added to the Custom Configurations 
folder.

Filters Mirrors



 Chapter 3: Using BD FACSDiva Software 77

6 Enter a descriptive name and press Enter.

For example, use the name 70-70, meaning 70-micron nozzle at 70 psi. If 
you need to rename the configuration, right-click the new configuration 
and select Rename.

Editing the Copied Configuration 

Once the base configuration is copied, you can customize the parameters, filters, 
and mirrors in the configuration.

1 In the configuration list, right-click the new configuration and select Edit 
Configuration.

The following window appears. 

Use the tabs at the bottom of the window to view each laser’s detectors 
separately.
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2 To edit the nozzle size and sheath pressure for this configuration: 

a Enter the appropriate sheath pressure value at the bottom of the 
configuration window.

b Select the appropriate nozzle size.

3 To edit the optical configuration:

• To change the parameter label for a detector, select and drag a new 
parameter from the Parameters list to the appropriate detector.

• To add more than one parameter label to a detector, Crtl+click the 
parameters in the Parameters list, then drag them to the detector.

Select and drag 
onto the detector
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Verifying that the Configuration Matches the Sort Setup 

To verify that the sheath pressure in the sort setup matches the sheath pressure in 
the configuration:

1 Select File > Exit to exit CS&T.

2 Select Sort > Sort Setup, and select the sort setup that matches the nozzle 
size listed in your configuration.

3 Select Cytometer > Sheath Pressure and verify that the pressure matches the 
pressure in your configuration. Enter a new sheath pressure, if needed.

• To change a filter, select and drag a new 
filter from the Filters list to the filter slot.

• To change a mirror, select and drag a new 
mirror from the Mirrors list to the mirror 
slot.

Filter slot

Mirror slot

Select the sort setup that 
matches the nozzle size 
listed in your configuration.
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The new sheath pressure is automatically saved with the current sort setup 
mode. 

; Tip     The name of the configuration is displayed at the top of the 
BD FACSDiva workspace. If you use a descriptive name for each 
configuration (such as 100-15-Custom, for nozzle size-sheath pressure-sort 
setup mode), it will be easier to verify that the appropriate settings match 
without going back to view the configuration.

Configuration Mismatch Dialog 

If there is a mismatch between the CS&T settings and those in BD FACSDiva 
software, a dialog opens (Figure 3-7 on page 81) to indicate what the differences 
are, and gives these options:

• Use CS&T Settings. Select this option if you have run a performance check 
or created a new configuration, and want to use those values.

• Keep Current Settings. Select this option if you were viewing a 
configuration in CS&T, and don’t want to change the values. For example, 
settings for area scaling for the particle of interest.

Enter the same sheath pressure that was 
entered in the configuration.
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Figure 3-7  CS&T Mismatch Message

Acquisition Controls 

Along with the controls described in the BD FACSDiva Software Reference 
Manual, the following acquisition controls are available for the BD FACSAria II 
cytometer.
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• Load. Lifts a tube into the sample injection chamber, starts sample 
agitation (if agitation is turned on), and starts acquisition of the sample. 

When a tube is already loaded, the button changes to Unload. Clicking 
Unload stops acquisition of the sample, turns off the agitator, and lowers 
the tube from the sample injection chamber. 

NOTE The Load button is enabled only when the workstation is connected 
to the cytometer, an experiment is open, the stream is turned on, and the 
current tube pointer is set to a tube.

• Stop Acquiring. Stops sample acquisition without unloading the sample 
tube.

The Acquire Data button functions only when a tube is loaded.

• Flow Rate. Controls sample flow rate, from 1.0–11.0 (10–80 µL/min). 

Do one of the following to change the flow rate:

- Select the value in the field and enter a new value.

- Click the pointer in the slider bar and drag it to a new value.

- Use the mouse to click the up and down arrows or press the arrow keys 
on your keyboard to increase or decrease the values in small 
increments.
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Sorting Controls

All sorting on the BD FACSAria II cytometer is controlled by BD FACSDiva 
software. Sorting controls are shown in Figure 3-8 on page 83. See Table 3-1 on 
page 83 for explanations of each area.

Figure 3-8  BD FACSDiva sorting controls 

Table 3-1  Description of sorting controls 

The Sort menu provides access to the sort setup and sort precision modes, sort 
layouts, sort reports, and sort devices used with the automated cell deposition 
unit (ACDU). See Sort Menu on page 84.

The Sort Layout window designates which device will be used to collect sorted 
particles and which particles will be sorted into each sort location. Sorting 
controls and counters are also displayed in the window. See Sort Layout on 
page 87.
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Sort Menu 

Select commands in the Sort menu for the following:

• Sort Setup. Downloads the most recently used settings 
for selected nozzle size. See Sort Setup on page 85.

• Sort Precision. Opens a dialog where you can select or 
define a sort precision mode for handling sorting 
conflicts. See Conflict Resolution During Sorting on 
page 53.

• New Sort Layout. Opens the default 2-Tube Sort Layout window where 
other sort layouts can be selected. See Sort Layout on page 87. (Note that 
clicking the Sort Layout button on the Browser toolbar performs the same 
function.)

• Open Sort Layout. Opens an existing sort layout. A sort layout must be 
selected in the Browser for this menu command to be enabled. 
Alternatively, double-click any sort layout to open it.

• Home Device. Opens a dialog containing commands to move the tray 
support arm, either manually or to the home position. See Setting Up the 
Stream on page 170.

• Custom Devices. Opens a dialog where custom devices can be defined. See 
Creating a Custom Device on page 172.

The Breakoff window displays an image of the stream and contains controls to 
adjust drop formation. See Drop Formation on page 45. 

The Side Stream window displays an image of the side streams, and contains 
controls to adjust electrical charges and the drop delay. See Side Stream 
Formation on page 49. 

Table 3-1  Description of sorting controls 

3

4
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• Sort Report. Displays a report showing the sort settings, acquisition 
counters, and sort layout information from the current sort. See Sort 
Report on page 94.

Sort Setup

Sort setup values for four different nozzle sizes can be downloaded using the Sort 
> Sort Setup command. Default settings are provided for each sorting option, 
along with a custom setting for each option. 

As a general rule, for optimal results when sorting large or fragile cells, use a 
larger nozzle size and lower pressure. To increase throughput and yield when 
sorting smaller or less fragile cells, use a smaller nozzle size and higher pressure.

If you make changes to any of the settings, the changes are automatically saved 
when you exit BD FACSDiva software or when you switch to a different sort 
setup mode. When you restart, the most recently used set of values is restored. 
Default settings are shown in Table 3-2 on page 86.

Sort Setup 
name

Nozzle 
(microns)

Default 
pressure (psi) 

70 micron 70 70

85 micron 85 45

100 micron 100 20

130 micron 130 10
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In addition, the Sort Setup menu has following menu items: 70 Custom, 85 
Custom, 100 Custom, and 130 Custom. Initially, all of these new setups are exact 
copies of the corresponding original setups with the same defaults. This allows 
you to create two sets of sort values (pressure, for example) for the same nozzle 
size. 

Do not use a nozzle size that is different from the sort setup setting. The gap 
values and sensitivity algorithms are optimized for particular nozzles and 
are not suitable for other nozzle sizes. The system performance could be 
unstable. 

Table 3-2  Default sort setup values

Setting 70 micron 85 micron 100 micron 130 micron

Sheath Pressure 70 45 20 10

Amplitude 60 32 12 24

Frequency 87 47 30 12

Drop 1 150 150 150 150

Gap (upper limit) 6 (14) 7 (17) 10 (21) 12 (21)

Attenuation Off Off Off Off

Drop Delay 47.00 30.00 27.00 16.00

Far left voltage 100 100 80 60

Left voltage 40 35 30 20

Right voltage 40 35 30 20

Far right voltage 100 100 80 60

Plate voltage 4,500 4,000 2,500 2,000

2nd Drop 20 20 10 0

3rd Drop 10 10 5 0

4th Drop 0 0 0 0
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Sort Layout

The Sort Layout window contains all sorting instructions and controls. The sort 
layout designates which device will be used to collect sorted particles and which 
particles will be sorted into each sort location. Up to four sort counters can be 
displayed in the window to give ongoing status during a sort. 

Only one sort layout can be open at a time, but you can create several layouts for 
a single tube, as long as each sort layout has a different name. Sort layouts can 
also be added to global worksheets.

Sort layouts are available for up to nine default collection devices (shown in the 
following figure). Additional custom devices can be defined. See Creating a 
Custom Device on page 172.

Laser Delay (blue) 0.00 0.00 0.00 0.00

Laser Delay (red) –36.00 –54.00 –40.00 –82.00

Laser Delay (violet) 36.00 54.00 40.00 82.00

Area Scaling (blue) 1.40 1.20 1.40 0.75

Area Scaling (red) 1.00 0.75 1.00 0.50

Area Scaling (violet) 0.80 0.35 0.50 0.25

Window Extension 2.00 2.00 2.00 4.00

Table 3-2  Default sort setup values (continued)

Setting 70 micron 85 micron 100 micron 130 micron

Default 
collection 
devices
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Examples of sort layouts for different devices are shown in the following figures. 
Instructions for setting up a sort layout can be found in Setting Up a Sort Layout 
on page 89.

Figure 3-9  Sort layout for collection tubes (top) and for a 48-well plate (bottom)

Sort location 
field for 
far-right tube

Sort location 
field for 
individual well

Collection 
device

Sort 
counters

Sorting 
controls
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Figure 3-10  Sort layout for a frosted slide

Setting Up a Sort Layout 

Sort layouts can be added to tubes or global worksheets. 

• Create tube-specific layouts if you are sorting different populations or using 
different sort devices for each tube in the experiment.

• Create global worksheet–specific layouts if you are sorting the same 
populations into the same sort device for all tubes in the experiment.

NOTE To create a tube-specific sort layout, make sure a normal worksheet 
(white tab) is shown in the Worksheet window before you create the layout.

1 Select the icon for a tube or global worksheet in an open experiment and 
click the New Sort Layout button on the Browser toolbar. 

2 In the Sort Layout window, select the type of device from the Device menu.

Default sorting devices are listed along with any defined custom devices. 
The Sort Layout window changes depending on the selected device. The 
number of rows and columns in the window matches the number of tubes, 
wells, or spots in the collection device. 

Sort location 
field for a spot 
on a slide
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3 Select the sort precision mode from the Precision menu.

For more information, see Sort Precision Modes on page 57.

4 Enter the number of events to be sorted in the Target Events field. 

Once entered, the number of events can be selected from the Target Events 
menu. For continuous sorting, select Continuous from the Target Events 
menu.

5 Select one of the following options from the Save Sort Reports menu: 

• Save None. Sort reports are not saved.

• Save All. Automatically saves a sort report each time the sort is 
stopped.

• Ask User. Prompts the user each time the sort is stopped to select 
whether or not to save the sort report. This is the default option.

This setting is saved with the sort layout.

6 Select the field(s) corresponding to the tube(s), well(s), or spot(s) where the 
population will be sorted and select a defined population from the Add 
menu. 

When you click in a sort location field, a menu appears allowing you to 
add, delete, or clear all populations in the field (Figure 3-11).

Figure 3-11  Adding populations to be sorted
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After you add a population, the population and the number of target events 
are added to the corresponding sort location field.

; Tip     Select a row or column header to select all fields in that row or column. 
When you add a population, it will be added to all selected fields at once.

7 Specify whether to save sort conflicts by selecting the Save Conflicts 
checkbox.

This checkbox is enabled only when using a two- or four-tube layout. 
When selected, all sort conflicts are sorted into a default location.

• For a two-tube layout, conflicts are sorted to the right.

• For a four-tube layout, conflicts for the far left tube are sorted to the 
left, and conflicts for the far right tube are sorted to the right. 

Editing a Sort Layout

• To change the number of events for any population, click in the Sort 
Location field(s) containing the population, then select a number from the 
Target Events menu or enter a new number.

• To remove a population from a sort location field, select the field, then 
select the corresponding population from the Delete menu. 

• To clear all populations from a field, select the field, then select Clear All.
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Using Sorting Controls

Sorting controls appear at the bottom of the Sort Layout window. Use these 
controls for the following functions.

• Sort. Starts sorting events for the current acquisition tube. All counters 
reset to zero when this button is clicked. Events are sorted until the 
requested number of sorted events has been reached. 

Click the Sort button again to stop sorting before reaching the requested 
number of events. The counters stop at the number of sorted events. If you 
click Sort to restart sorting, the counters reset to zero. 

• Pause/Resume. Stops sorting, but not acquisition. Sort counters and sort 
timers freeze when the Pause button is clicked. Click the Resume button to 
continue sorting and to continue incrementing the sort counters and timers. 
See Pausing and Resuming a Sort on page 167.

• Access Stage. When the ACDU stage is in the back, the stage is moved 
forward to put a plate on or take a plate off the stage. When the stage is in 
the front, the stage is moved to the back and out of the way so you can 
install a collection tube holder. 

• Move Drawer. Moves the aspirator drawer in (closed) or out (open) 
depending on its current state. The default state is in. For more 
information, see Aspirator Drawer on page 15.

Access Stage

Move Drawer
Pause/Resume
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Using Counters

Counters provide ongoing status during sorting. Counter fields cannot be edited. 
To display fewer counters in the Sort Layout window, click the View Counters 
button and select a menu option. The corresponding counter is hidden. (Only 
counters with a checkmark next to the name are displayed.)

Counters display the following information:

• Sort Rate. Number of events per second that met the sort criteria and were 
sorted.

• Conflict Count. Number of events that met the sort criteria but were not 
sorted because of conflicts.

• Conflict Rate. Number of conflicts per second.

• Efficiency. Number of sorted events/(sort conflicts + sorted events) x 100.
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Monitoring a Sort

During sorting, each sort location field displays the number of actual sorted 
events (Figure 3-12). When a target number is specified, the field displays the 
actual number of events along with the number of target events. 

A progress bar appears behind the sort rate counter field showing the progress of 
the sort. 

Figure 3-12  Sort Layout during sorting

Sort Report

Select Sort > Sort Reports to view all of the saved reports for the current sort 
layout (see Figure 3-13). A sort report can be printed or exported. The Sort 
Reports menu option is enabled if either of the following is true: a sort layout is 
selected in the Browser (even if experiment is closed), or a sort layout is open. If 
both conditions are true, the Browser selection takes precedence. 
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Figure 3-13  Select Sort Reports dialog

A sort report (see Figure 3-14 on page 96) contains the following:

• Header information. Experiment name, specimen name, tube name, sort 
layout name, type of collection device, and the date and time of printing.

• Sort Settings. Sort setup values, precision mode, and mask definitions.

• Acquisition Counters. Threshold count, processed events count, electronic 
conflicts count, and elapsed time.

• Sort Counters. Counter values per sort destination, or total sort count if 
sorting sequentially.

• Sort Layout. Population(s), sort count, and target event count for each sort 
location field.
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Figure 3-14  Typical sort report 

The Sort Report window contains a File menu where you can select to print or 
export the report. Exported comma-separated value (CSV) files can be opened 
with a spreadsheet application such as Microsoft Excel®.
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Templates

When you install BD FACSDiva software for the BD FACSAria II cytometer, the 
following additional experiment templates are installed in the BD Export\ 
Templates directory:

• Accudrop Drop Delay template. Contains a single specimen and tube, a 
gated plot on a standard worksheet, and a predefined sort layout. This 
experiment is used for setting the drop delay during sorting as described in 
Determining the Drop Delay – Manual Method on page 154.

• Doublet Discrimination Gating template. Contains custom cytometer 
settings, a single specimen and tube, and three gated plots on a global 
worksheet. This experiment is used to eliminate doublets as described in 
Data Collection on page 131.

• QC Experiment template. Contains cytometer settings, a single specimen, 
one tube, and two global worksheets containing gated plots and statistics 
for data from each laser. This experiment is used for daily cytometer quality 
control, as described in QC Using BD FACSDiva Software on page 307.
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4

Running Samples

The following topics are covered in this chapter:

• Cytometer Startup on page 100

• Checking Cytometer Performance on page 116

• Application Settings on page 123

• Data Collection on page 131

• Data Recording and Analysis on page 138
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Cytometer Startup

Follow these steps to start up your BD FACSAria II cytometer.

1 Start up the workstation.

2 Turn on the cytometer main power. 

Figure 4-1  Power panel 

If the cytometer was just shut down, wait until the system is fully 
depressurized (stops hissing) before you turn on the main power. 

3 Turn on the lasers. Wait 30 minutes for them to warm up.

To turn on a laser, press the corresponding laser power button on the 
power panel (Figure 4-1). 

; Tip     If you are using temperature control, start heating or cooling the 
sample injection chamber or the recirculating water bath while the lasers are 
warming up. See Sample Temperature on page 66. 

Main Power

Blue

Red

Violet

Main power
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4 Start BD FACSDiva software and log in with your user name and 
password.

To start the software, double-click the application shortcut on the desktop. 

5 Check the fluidics levels in the Cytometer window. Replenish fluids or 
empty the waste, if needed.

To display the Cytometer window, click the Cytometer button on the 
Workspace toolbar. Check the fluid levels at the bottom of the window 
(Figure 4-2).

Figure 4-2  Fluid levels in the Cytometer window

To service the fluid containers, see Setting Up the Fluidics Cart on page 108 
and Emptying the Waste Container on page 114.

Performing Fluidics Startup

This section describes the fluidics startup procedure. The status of the fluidics 
system is displayed in the bottom right corner of the main window.

EthanolBleachDIWasteSheath

Note: Roll the mouse pointer over 
fluid indicators to show fluid type.
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1 From the BD FACSDiva Cytometer menu, select Fluidics Startup. The 
following window appears.

2 Verify that the air and fluid lines are disconnected from the ethanol tank 
and connected to the sheath tank, then click Done. See Figure 4-3.

Figure 4-3  Air and fluid lines connected to the sheath tank

3 Verify that a closed-loop nozzle is installed in the flow cell, then click Done.

Caution: Do not run fluidics startup with the air and fluid lines connected 
to the ethanol shutdown tank. This can cause damage to the system. 
Always verify that the lines are connected to the sheath tank.

Air line

Fluid line

Ethanol shutdown 
tank

Sheath tank

Side viewTop view

Sheath
filter

Ethanol
filter
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The fluidics startup process starts and the progress is displayed at the 
bottom of the dialog.

4 Turn the nozzle-locking lever counter-clockwise to the 6:00 position, pull 
the closed-loop nozzle out of the cuvette flow cell, then click Done.

5 Insert the correct nozzle size in the flow cell.

a Verify that the seal in an integrated nozzle, or the O-ring in a standard 
nozzle, is installed in the nozzle groove.

b Make sure the top side of the nozzle is facing up as you insert the 
nozzle.

c Push the nozzle all the way back into the flow cell.

d Turn the nozzle-locking lever clockwise to the 12:00 position.

6 Click OK to complete the process.

7 When fluidics startup is complete, select Sort > Sort Setup and verify that 
the setup mode matches the nozzle size.

For information about Sort Setup modes, see Sort Setup on page 85.

Caution: Do not open the sort block door while the nozzle locking lever is 
in the 6:00 position. The flow cell can be damaged by the top of the door 
during opening. Always turn the lever clockwise back to the 12:00 position 
before opening the sort block door.
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Starting the Stream 

The system can take anywhere from 20 seconds to several minutes to reach the 
correct pressure and turn on the stream, depending on the state of the system and 
the sort setup selected.

1 Start the stream.

a Click the Sorting button on the Workspace toolbar to display the 
Breakoff and Side Stream windows.

b Click the Stream button in the Breakoff window to turn on the stream.

2 Open the sort block door and check the stream.

The stream should flow smoothly from the nozzle into the center of the 
waste aspirator. 

If the stream is flowing but is unsteady, check for bubbles in the flow cell. If 
you see bubbles, turn off the stream, wait for 10 seconds, and turn on the 
stream again.

If you see any dripping or spraying, or the stream image appears abnormal, 
turn off the stream and see Troubleshooting the Stream on page 226.

3 Close the sort block door. 

NOTE If you encounter bubbles in the sheath fluid stream at the 
130-micron sort setting, perform a sample line backflush for approximately 
1 minute. Select Cytometer > Cleaning Modes > Sample Line Backflush.

To prevent this, the sheath tank should be depressurized while not in use to 
prevent air from dissolving into the sheath solution.
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Setting Up the Breakoff 

Establishing a stable drop pattern in the breakoff window is an important step in 
getting optimal results from the system. See Breakoff Window on page 46 for 
more information on the parameters and controls in the breakoff window.

1 Adjust the Ampl slider until the drop breakoff is approximately in the top 
third of the Breakoff window.

Do not exceed 70 volts. If you cannot achieve a drop breakoff at <70 volts, 
do the following:

• Check the flow cell for air bubbles. If you see bubbles, turn the stream 
off and back on.

• Make sure the sheath pressure and drop drive frequency are 
appropriate. See Table 3-2 on page 86 for starting values.

• If the amplitude is <10 volts, turn on attenuation in the Side Stream 
window. See Table 2-2 on page 50.



106 BD FACSAria II User’s Guide   

2 Verify that the small satellite droplets are 
merging with the large droplets.

Satellite-merging is largely dependent on nozzle 
position. If the satellites are not merging, you 
might need to remove and reinstall the nozzle, 
or clean it by sonicating.

The satellite drops should merge into the drops 
in 6 satellites or fewer.

3 Enter the actual Drop 1 value as the target in 
the Drop 1 field.

The actual value appears in the gray 
background next to the Drop 1 field. Once a 
valid target has been established, you do not 
need to reset it unless you change the nozzle or 
your sort setup option.

; Tip     If the target value causes the amplitude to 
exceed 70 volts, perform the recommendations 
under step 1 and re-enter the Drop 1 target 
value.

4 Turn on the Sweet Spot when the drop pattern 
is stable.

The Sweet Spot is designed to automatically 
adjust the drop drive amplitude to maintain the 
stability of the breakoff point. When the Sweet Spot is on, the Amplitude 
and Frequency fields are disabled. The values are automatically adjusted by 
the software. For more information, see Breakoff Window on page 46.

See Table 4-1 on page 107 for examples of breakoff patterns at each nozzle 
size.

Good breakoff Poor breakoff

Target value
Actual value

satellite
drop
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NOTE The breakoff patterns in Table 4-1 are intended as examples. The patterns 
will not always look exactly like these. 

Table 4-1  Examples of breakoff patterns at each nozzle size 

70 micron 85 micron 100 micron 130 micron
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Setting Up the Fluidics Cart

Check the fluid levels in the sheath tank and waste containers every time you use 
the cytometer. This ensures that you will not run out of sheath fluid during an 
experiment or have to service the containers during a sort. Fluidics level 
indicators are shown in the Cytometer window in BD FACSDiva software. See 
Figure 4-2 on page 101.

NOTE When the fluidics cart is in the correct position in the lab, lock the rolling 
casters by turning the orange disk until the feet contact the floor. This helps 
minimize any vibrations that could affect the stability of the stream.

If a fluidics container is running low, refill it with the fluid indicated on the 
container label. For best results, fill the containers only with the fluids shown in 
Table 4-2. For ordering information, see Reagents on page 262. 

For instructions on emptying the waste, see page 114.

Table 4-2  Recommended fluids

Container Compatible Fluids Capacity

Sheatha 

a. Users should select solutions that are compatible with their specific samples and experiments.

• BD FACSFlow™ sheath fluid (non-sterile)

• 1X phosphate-buffered saline (PBS), with or without 
preservatives

One 10-L 
stainless steel 

container

Ethanol 
Shutdown

70% solution diluted in DI or laboratory-grade water One 5-L stainless 
steel container

Bleach • 10% household bleach (0.5% sodium hypochlorite)

• BD™ FACSClean solution

5 L

DI Deionized water (Milli-Q or equivalent). Add 3 mL of 
bleach per liter of DI water.

5 L

Ethanol 70% solution diluted in DI or laboratory-grade water 5 L
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NOTE Make sure the blue sheath fluid line between the sheath tank and the 
cytometer does not come into contact with anything that could introduce 
vibration that might affect the stability of the stream.

Refilling the Sheath Tank 

The fluid level in the pressurized stainless steel sheath tank should be checked 
often and refilled when low. The startup times for the breakoff stream will 
increase when the tank is low. If the cytometer is run until the sheath supply is 
too low, the system will turn off the stream.

Figure 4-4  Sheath tank connectors 

To refill the sheath tank:

1 Turn off the stream.

2 Disconnect the air line.

3 Pull up on the ring of the pressure relief valve to release pressure from the 
tank. 

Make sure the tank is fully vented.

Air line

Fluid line

Sheath tank

Side viewTop view

Sheath
filter

Sheath
sensor

Pressure relief 
valve

Containment 
device

Air 
connector

Cover 
knob

Fluid 
connector
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4 Unscrew the sheath tank cover knob and remove the cover.

5 Fill the tank with sheath fluid up to the upper weld line on the inside of the 
tank. See Figure 4-5.

NOTE Do not overfill the sheath tank because this can cause incorrect 
sample flow rates.

Figure 4-5  Sheath tank fill level

6 Replace the cover and tighten the knob. 

Make sure the large O-ring on the inside lip of the cover is seated correctly 
and has not slipped out of position. The tank can leak if the cover is not 
secured properly.

7 If you removed the sheath tank from the fluidics cart to refill it, always 
place the tank back in its original position on the cart. See Figure 4-6 on 
page 111.

The flow rate is calibrated with the sheath tank on the fluidics cart. If the 
location or elevation of the sheath tank is changed, it could affect the flow 
rate calibration.

Upper weld line to 
indicate fill level
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Figure 4-6  Sheath tank location label 

8 Connect the air line. The system is ready to run again.

Refilling the Ethanol Shutdown Tank 

The fluid level in the stainless steel ethanol shutdown tank should be checked 
before starting the fluidics shutdown procedure and refilled when low. This tank 
does not have a sensor, so it must be checked manually.

Figure 4-7  Ethanol shutdown tank connectors

1 Turn off the stream.

2 If it is connected, disconnect the air line on the ethanol shutdown tank.

3 Pull up on the ring of the pressure relief valve to release pressure from the 
tank. 

Make sure the tank is fully vented.

ATTENTION
SHEATH TANK (W)

to  be

LOCATED HERE
during  instrument  operation

to  maintain  calibration

Ethanol
filter

Pressure relief 
valve

Air 
connector

Cover knob

Fluid 
connector
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4 Unscrew the tank cover knob and remove the cover.

5 Fill the tank with ethanol to the level shown in Figure 4-8.

6 Replace the cover and tighten the knob. 

Make sure the large O-ring on the inside of the cover is seated correctly and 
has not slipped out of position. The tank can leak if the cover is not secured 
properly.

7 If you are going to perform fluidics shutdown, connect the air line.

Figure 4-8  Ethanol shutdown tank fill level

Refilling the Plastic Containers

You can refill the plastic containers directly on the fluidics cart without detaching 
any lines, or you can remove the container for refilling. Note that during 
operation, you can add fluid to a container through the large cap without any 
interruption to your experiment, but if you detach any lines, you will need to 
prime the system.

1 (Optional) Disconnect the container’s sensor and quick-release connector if 
you need to move the container. (See Figure 4-9.)

If you do not need to move the container, skip to step 2.

Fill level
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Figure 4-9  Plastic fluidics container

2 Remove the large-sized cap from the container (See Figure 4-9.)

3 Fill the container with the fluid indicated on the container label.

4 Replace the container cap and hand-tighten it until it is fully closed.

5 If you disconnected the sensor and quick-release connectors in step 1:

a Reconnect the sensor and quick-release connectors to their respective 
ports.

b Prime the fluidics system.

From the BD FACSDiva menu bar, select Cytometer > Cleaning 
Modes > Prime after Tank Refill. In the dialog that appears, select the 
fluid to prime, then click OK.

To ensure that the appropriate solutions are dispensed, do not switch the 
tank positions. Make sure the label on each container matches the labeled 
port on the fluidics cart. 

Quick-release 
connector

Large-sized 
cap

Sensor
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Emptying the Waste Container 

Empty the waste container daily and when the fluid indicator shows the waste is 
getting full. To prolong the life of the container, we recommend that you switch 
to the alternate container each time the waste is emptied.  

Figure 4-10  Waste container details 

1 Disconnect the waste container’s sensor and fluid line connectors from their 
respective ports on the fluidics cart. 

All biological specimens and materials coming into contact with them can 
transmit potentially fatal disease. To prevent exposure to biohazardous 
agents, expose waste container contents to bleach (10% of total volume) 
before disposal. Dispose of waste in accordance with local regulations. Use 
proper precautions and wear suitable protective clothing, eyewear, and 
gloves.

Change the waste container cap every month to prevent container 
pressurization. To order new replacement caps (BD Part No. 33885407, 
pack of 12), contact your local BD Biosciences representative.

Waste container

Waste ports
(behind handle)

Trap

Disposable cap
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2 Remove the disposable waste cap (large-sized cap) and attached trap from 
the container. Place the assembly on the bench label-side up. 

Figure 4-11  Draining liquid from the trap 

3 Empty the waste container according to your standard laboratory 
procedures for biohazardous waste.

4 Add approximately 1 L of bleach to the waste container (10-L container).

Add a sufficient amount so that 10% of the total waste volume is bleach.

The waste container can become pressurized when the cytometer is 
running. Always disconnect the container from the fluidics cart before you 
empty it. Wait at least 1 minute for pressure to dissipate before you open 
the container.

Do not wet the cap on top of the trap. If you see liquid inside the trap, 
remove the drain plug and fully drain the liquid before you replace the plug 
(Figure 4-11 on page 115).

Sensor

Waste fluid lines

Drain plug

Trap
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5 Replace the waste trap and attached filter cap. Hand-tighten the trap and 
cap until they are fully closed. 

6 If one month has passed since you last changed the cap, replace the filter 
cap with a new one. Write the date on the new cap as a reminder.

7 Reconnect the sensor and fluid line connectors to their respective ports.

Checking Cytometer Performance 

Before setting up an experiment, you should first run a performance check. A 
performance check ensures that the cytometer is performing consistently over 
time. It also generates default cytometer settings that places each PMT within an 
optimal range.

NOTE You can also use the quality control process originally established in 
previous versions of BD FACSDiva software. See QC Using BD FACSDiva 
Software on page 307.

To run a performance check, start the Cytometer Setup and Tracking (CS&T) 
application within BD FACSDiva software and select the appropriate cytometer 
configuration. Each configuration must have a valid baseline. See the BD 
Cytometer Setup and Tracking Application Guide for more information on 
running a baseline.

To prevent over-pressurization during fluidics startup, do not overtighten 
the trap or attached filter cap. Tighten each component only until it is 
hand-tight. Do not use sealants such as Teflon® tape or other adhesives.

338677 Rev A

Waste (A)

Space for date
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Preparing the CS&T Workspace

To ensure that your cytometer is performing consistently over time, it’s important 
to keep as many variables constant as possible, such as bead type, sheath 
pressure, and cytometer settings. For this reason, you should run the daily 
performance check using the same cytometer configuration each day. 

1 Turn off the Sweet Spot (if it is on), then select Cytometer > CST.

The cytometer disconnects from the BD FACSDiva interface and connects 
to the Cytometer Setup and Tracking interface. A window similar to 
Figure 4-12 on page 117 opens.

Figure 4-12  Main CS&T window 
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2 Verify that the bead lot information under Setup Beads matches the 
Cytometer Setup and Tracking bead lot. 

Select the correct lot ID from the menu. The bead lot ID number is located 
on the CS&T beads vial.

3 Verify that the cytometer configuration is correct for your experiment. 

If the cytometer is not set to the correct configuration:

a Click Select Configuration in the Setup Control window. 

b Select the correct configuration from the list.
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c Click Set Configuration. Click OK.

4 Verify that the current configuration has a valid baseline defined.

If not, see the BD Cytometer Setup and Tracking Application Guide for 
more information on running a baseline.

Expired performance check

Valid baseline
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Preparing the CS&T Beads 

The BD™ Cytometer Setup and Tracking beads consist of bright, mid, and dim 
beads dyed with a mixture of fluorochromes. Use the beads to define a baseline 
and to check cytometer performance using the CS&T application. 

See the BD Cytometer Setup and Tracking beads package insert for more 
instructions about preparing the bead suspension.

1 Mix the beads by gently inverting the vial.

2 In a 12 x 75-mm tube, add 0.35 mL of sheath fluid and 1 drop of beads.

NOTE Beads are stable at 2°C to 25°C for no more than 20 minutes if 
stored in direct light, and up to 8 hours if protected from light.

Running a Performance Check 

The performance check feature of Cytometer Setup and Tracking will check the 
cytometer’s daily performance.

1 Install the bead tube onto the cytometer loading port.

2 In the Setup Control window, select Check Performance from the 
Characterize menu.

3 Click Run.

Plots appear under the Setup tab and the performance check is run. The 
performance check takes approximately 5 minutes to complete.
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Reviewing the Results

1 Once the performance check is complete, click View Report.

2 Print the report. 

3 Verify that the performance check passed.

In the Setup tab, the Cytometer Performance Results should have a green 
checkmark and the word Passed next to it.

If any parameters did not pass, see the BD Cytometer Setup and Tracking 
Application Guide for troubleshooting information.

4 Select File > Exit to close the Cytometer Setup and Tracking window and 
connect back to the BD FACSDiva interface.
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5 Click Use CST Settings in the dialog that appears.

By selecting Use CST Settings, the laser delay, area scaling, and other 
cytometer settings will be updated to the latest optimized settings from the 
performance check.

Click the Details button to verify which cytometer settings will be updated.

At this point you can do one of the following:

• Continue to the next section to create application settings for an 
experiment you will use frequently.

• Collect data using existing application settings. See Data Collection on 
page 131.
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Application Settings

Application settings are associated with a cytometer configuration and include 
the parameters needed for the application, area scaling values, PMT voltages, and 
threshold values, but not compensation. Each time a performance check is run 
for a configuration, the application settings associated with that configuration 
are updated to the latest run.

Using application settings provides an easy, consistent, and reproducible way to 
reuse cytometer settings for your commonly used applications. See the BD 
Cytometer Setup and Tracking Application Guide for information on running a 
baseline and for other details on using the CS&T application.

Before creating application settings you must:

• Perform the cytometer startup procedure described in Cytometer Startup 
on page 100.

• Run a performance check for the cytometer configuration that will be used 
for the application.

Creating Application Settings

This section describes how to create and save application settings for a multi-
color immunophenotyping sample. 

Setting Up the Workspace

1 Create a new folder.

2 Create a new experiment.

3 Select the Cytometer Settings in the Browser.

4 In the Inspector window, click the Parameters tab and delete any unneeded 
parameters.
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5 Select the H checkbox to select height for each parameter. See Figure 4-13 
on page 124.

Figure 4-13  Inspector window - Parameters tab

Adjusting Area Scaling

The required area scaling factor changes based on sheath pressure and particle 
size. The area scaling factors should be verified for each experiment performed 
on the cytometer. 

1 In the Browser, right-click Global Sheet1 and select Apply Analysis 
Template.

2 In the Template dialog, select the Area Scaling worksheet and click OK.

3 Create a new specimen by clicking the New Specimen button on the 
Browser toolbar.

4 Expand the new specimen, then click to set the current tube pointer to 
Tube_001.

5 Install the FITC-positive control tube onto the loading port and click Load 
in the Acquisition Dashboard.
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6 Adjust the FSC and SSC voltages to place the particles on scale. See 
Figure 4-14 on page 125. 

Figure 4-14  Adjusting FSC and SSC voltages

7 Adjust the P1 gate around the population of interest in the FSC vs SSC plot. 
See Figure 4-15.

Figure 4-15  FSC and SSC plot

8 Adjust the FSC area scaling.

a Click the Laser tab in the Cytometer window. See Figure 4-16.



126 BD FACSAria II User’s Guide   

Figure 4-16  Adjusting FSC area scaling

b Adjust the FSC area scaling factor until the FSC-A signal matches the 
FSC-H signal. See Figure 4-17. 

• Increase the area scaling factor if the FSC-A signal is lower than 
FSC-H. 

• Decrease the area scaling factor if the FSC-A signal is higher than 
FSC-H.

c View the result of your change in the histograms and statistics views.
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Figure 4-17  FSC area scaling comparison

9 Adjust the blue laser area scaling until the FITC-A signal matches the FITC-
H signal, if needed. 

10 Unload the FITC-positive control tube, then load the APC-positive control 
tube.

11 Adjust the red laser area scaling until the APC-A signal matches the APC-H 
signal, if needed.

12 In the Inspector window, clear the checkbox for height for all parameters. 
See Figure 4-18 on page 128.

Incorrect FSC area scaling Correct FSC area scaling
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Figure 4-18  Deselecting the height parameter

Optimizing PMT Voltages 

1 Right-click Cytometer Settings in the Browser, then select Application 
Settings > Create Worksheet.

A second global sheet is added with the plots created according to your 
selections in the parameters tab. (See Figure 4-19.) Use the gray boxes and 
crosshairs to guide your optimization. 

Figure 4-19  Optimizing PMT voltages

2 Load the unstained control tube onto the cytometer.
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3 In the Cytometer window, optimize the settings for your application.

a Optimize the FSC and SSC voltages to place the population of interest 
on scale.

b Optimize the FSC threshold value to eliminate debris without 
interfering with the population of interest.

c If needed, increase the fluorescence PMT voltages to place the negative 
population within the gray boxes. Try to align the center of the 
negative population with the crosshair shown in the gray box.

NOTE Do not decrease the fluorescence PMT voltages at this point. Doing 
so may decrease your ability to resolve dim populations from the negative 
population.

4 Unload the unstained control tube from the cytometer.

5 Load the multicolor sample onto the cytometer.

6 Verify that the positive populations are on scale.

If a positive population is off scale, lower the PMT voltage for that 
parameter until the positive population can be seen entirely on scale.

7 Unload the multicolor sample from the cytometer.
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Saving Application Settings

1 Right-click Cytometer Settings in the Browser, then select Application 
Settings > Save, to save the values for reuse. See Figure 4-20.

Figure 4-20  Saving application settings

a In the Applications Settings dialog, rename the application settings 
with a descriptive name.

b Click OK.

The application settings are saved to the catalog.



 Chapter 4: Running Samples 131

Data Collection

Before you record data for a sample, cytometer settings should be optimized to 
position the cells of interest on scale for scatter and fluorescence parameters. In 
the previous section, application settings were created by taking into 
consideration the following:

• FSC and fluorescence area scaling

• FSC and SSC voltages

• FSC threshold

• Fluorescence PMT voltages

In this section, the application settings will be applied and compensation will be 
calculated before collecting test data.

The following sections describe how to use previously optimized application 
settings for a 4-color experiment. See Application Settings on page 123 for more 
information. 

Compensation will be automatically calculated using the compensation setup 
feature. For more information about this feature, see the BD FACSDiva Software 
Reference Manual. If you are performing compensation manually, not all steps 
will apply.

Setting Up the Workspace

Before you begin optimizing settings, it is important to verify the cytometer 
configuration and create an experiment containing appropriate parameters for 
the assay.

1 Select Cytometer > View Configurations, and verify that the current 
configuration is appropriate for the type of sample you are running.

2 Verify that there is a valid performance check for the configuration.
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3 Make sure the octagon and trigon(s) contain appropriate filters.

For assistance, see Cytometer Configuration on page 68.

4 Click the corresponding buttons on the Workspace toolbar to display the 
Browser ( ), Cytometer ( ), Inspector ( ), Worksheet ( ), and 
Acquisition Dashboard ( ) windows, as needed. 

5 (Optional) Create a folder for your experiment.

Select the icon for your database and press Ctrl+N. Rename the folder 
appropriately. See the BD FACSDiva Software Reference Manual for ideas 
on how to organize experiments.

; Tip     To place an experiment inside a folder, select the folder before you 
create the experiment.

6 Create an experiment from the Doublet Discrimination Gating template. 

For best results, we recommend that you perform doublet discrimination in 
order to record only singlet events. This template contains cytometer 
settings and gated plots for this purpose. A procedure is given in Recording 
Data on page 142.

For experiments where you do not need to distinguish singlets from 
doublets, you can start with a default experiment or a template of your 
choice.

To use the template, select Experiment > New Experiment and select the 
Doublet Discrimination Gating template. Click OK to add a copy of the 
template to the Browser.

For accurate data results, the cytometer optics must match the current 
cytometer configuration.
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7 Rename the experiment appropriately (for example, 4-Color experiment).

8 Right-click the experiment level Cytometer Settings in the Browser and 
select Apply Application Settings. See Figure 4-21. 

Figure 4-21  Application Settings window

See Application Settings on page 123 for instructions on creating 
application settings.

9 Select the application setting for your sample and click Apply.

See Figure 4-22 on page 134 for a typical error message if there are any 
mismatches between the application and cytometer settings.
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Figure 4-22  Example mismatch error message 

10 Select Experiment > Compensation Setup > Create Compensation Controls.

The Create Compensation Controls dialog appears, listing only those 
parameters associated with the application settings.

11 Click OK to add the specified controls.

Alternatively, add and define label-specific controls, then click OK. 

Add label-specific controls when your experiment contains samples stained 
with the same fluorophore conjugated to different antibodies (labels) that 
require different compensation values. This is especially useful with tandem 
conjugates due to lot-to-lot variation. See the BD FACSDiva Software 
Reference Manual for more information about this feature.
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A compensation specimen is added to the experiment, along with a stained 
control tube for each compensation control. (Expand the specimen to view 
all tubes.) Worksheets containing appropriate plots are added for each 
compensation tube.

Calculating Compensation

The unstained control will be used to verify the settings for FSC, SSC, and FSC 
threshold, and to gate the population of interest.

1 Install the unstained control tube onto the cytometer. 

2 Expand the compensation specimen in the Browser.

3 Set the current tube pointer to the unstained control tube and click Load.

4 Verify that the population of interest is displayed appropriately on the FSC 
vs SSC plot. Adjust if needed. (See Figure 4-23).

Since the application settings have already been optimized for your sample, 
the cytometer settings should require little or no adjustment.

Figure 4-23  Voltages adjusted
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5 Click the Threshold tab and adjust the FSC threshold, if needed.

Set the threshold to remove most of the debris without cutting off the 
singlet population (Figure 4-23).

6 Adjust the P1 gate to surround only the singlets (Figure 4-23).

7 Right-click the P1 gate and select Apply to All Compensation Controls.

The P1 gate on each stained control worksheet is updated with your 
changes.

8 Click Record Data. 

9 When recording is finished, click Unload and remove the unstained control 
tube from the cytometer.

10 Install the next tube onto the cytometer and repeat steps 8 and 9 until data 
for all stained control tubes has been recorded.

11 Double-click the first stained control tube to display the corresponding 
worksheet.

Do not change the PMT voltages after the first compensation control has 
been recorded. In order to calculate compensation, all controls must be 
recorded with the same PMT voltage settings. If you need to adjust the 
PMT voltage for a subsequent compensation control, you will need to 
record all compensation controls again.
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12 Verify that the Snap-to Interval gate encompasses the positive population 
(Figure 4-24). Adjust the gate, if needed.

Figure 4-24  Gating the positive population

13 Repeat steps 11 and 12 for the remaining compensation tubes.

14 Select Experiment > Compensation Setup > Calculate Compensation.

15 Enter the name of your experiment as the setup name, then click Link & 
Save. 

; Tip     To keep track of compensation setups, include the experiment name, 
date, or both in the setup name.

NOTE We recommend that you always visually and statistically inspect 
automatically calculated overlap values. The means of the positive controls 
should be aligned with the means of the negative.
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Data Recording and Analysis

Once you have optimized the cytometer electronics for your sample type, you are 
ready to record and analyze data. 

Before you record data, we recommend that you gate out doublets in order to 
record only singlet events. The Doublet Discrimination Gating template provides 
gated plots for this purpose.

During analysis, recorded data is displayed in plots, and gates are used to define 
populations of interest. BD FACSDiva software analyzes the gated data and 
calculates statistics that you can print or export. With global worksheets, data 
can be shown for a series of tubes on the same worksheet, manually or in an 
automated batch analysis.

The following sections describe how to use BD FACSDiva software features to 
record and analyze sample data. 
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Setting Up the Experiment

Before you record data, set up an experiment with appropriate tubes, plots, and 
labels for your assay. This section describes how to add Browser and worksheet 
elements to the experiment that was started in the previous section, Data 
Collection.

1 Rename Specimen_001 to a descriptive name.

2 Rename Tube_001 to 4-color_001.

3 Set the current tube pointer to the 4-color_001 tube.

4 Click Next Tube in the Acquisition Dashboard to duplicate the first tube 
with the name 4-color_002.

5 Use the Experiment Layout to specify the number of events to record for 
each tube.

The Experiment Layout can be used to define the events to record as well as 
parameter labels for all tubes in an experiment. Labels appear on the plot 
axes and in all statistics views.

a Select Experiment > Experiment Layout.

b In the Acquisition tab, select the events to record field for all specimen 
tubes, and select or enter 5,000 events.

c Click OK. 
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Setting Up the Global Worksheet

A global worksheet is used to perform doublet discrimination and to set up plots 
to preview and record data.

1 Click the Worksheets View button on the Worksheet toolbar.

The global worksheet is shown. If you are using the Doublet 
Discrimination Gating template, the worksheet shows the predefined plots 
and gates used to distinguish singlets from doublets. 

The second and third plots are set up to display gated data from the first 
and second plots, respectively, as shown in the population hierarchy.

2 Create two dot plots for previewing and recording data.

For this example, create a FITC vs PE plot and an APC vs PerCP-Cy5.5 
plot.

; Tip     Double-click the Plot button to keep it selected until you create all plots. 
Click any other button to undo the selection.
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3 Turn on biexponential display. 

a Select the two plots.

b In the Inspector, select the checkboxes for X Axis and Y Axis under 
Biexponential Display. See Figure 4-25.

Figure 4-25  Turning on biexponential display

4 Set up the fluorescence plots to display data from the FSC gate.

The FSC gate defines singlet events. By gating the fluorescence plots 
through this population, only singlet events will be recorded.

a Select the two plots. 

b In the Inspector, select the FSC Gate checkbox.

5 Arrange the fluorescence plots so they fill the page vertically.

For an example, see Figure 4-27 on page 145. 
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Recording Data

This section describes how to adjust the gates to eliminate doublets and record 
singlet events.

1 Move the current tube pointer to the 4-color_001 tube.

2 Install the first mixed sample tube onto the loading port and click Load.

3 Change the Events to Display to 5,000 events.

4 Adjust the Scatter Gate to encompass the singlet events.

5 Adjust the SSC Gate to encompass the low SSC-W population.

6 Adjust the FSC Gate to encompass the low FSC-W population.

Figure 4-26  Discriminating singlet events

7 Click Record in the Acquisition Dashboard to record data.

8 When all events have been recorded, click Unload and remove the tube 
from the cytometer.

9 Install the next tube, then click Next Tube in the Acquisition Dashboard to 
move the current tube pointer to the next tube.
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10 Repeat steps 7 through 9 for the remaining tubes.

Analyzing Data

This section describes how to set up plots, gates, and a statistics view to analyze 
the recorded data. By the end of this section, your analysis should look similar to 
that shown in Figure 4-27 on page 145.

1 Select Edit > User Preferences. 

2 In the Gates tab, set the preferences as follows:

3 Create the following gates:

• Quadrant gate on the FITC vs PE plot. 

• Interval gate on the APC vs PerCP-Cy5.5 plot to capture the APC 
beads.

• Rectangle gate on the APC vs PerCP-Cy5.5 plot to capture the PerCP-
Cy5.5 beads. 

4 Rename each population in the population hierarchy. 

; Tip     Press the Enter key twice to move to the next population without using 
the mouse.
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5 Right-click either fluorescence plot and select Create Statistics View. 

A statistics view is added to the worksheet.

6 Right-click the statistics view and select Edit Statistics View.

7 Edit the statistics view as follows:

• In the Header tab, select the Use 2 columns for display checkbox.

• In the Populations tab, clear the checkboxes for all populations except 
FITC, PE, PerCP-Cy5.5, and APC. 

• In the Statistics tab, select the Mean checkboxes for the fluorescence-A 
parameters.

8 Resize the statistics view so it fits on the page.

9 (Optional) Print the analysis.
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Figure 4-27  Sample analysis for mixed-bead tube
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Performing a Batch Analysis 

Batch analysis allows you to automatically advance through a selected set of tube 
data when using a global worksheet. 

To perform a batch analysis:

1 Verify that the global worksheet you will be using for analysis is displayed 
in the worksheet window.

2 Right-click the specimen to analyze in the Browser and select Batch 
Analysis.

The Batch Analysis dialog appears.

Only tubes under the selected specimen will be processed. Tubes without 
data are skipped during a batch analysis.

3 Do the following in the Batch Analysis dialog:

• Select Auto to analyze all the files without user intervention. 

• Select 5 from the View Time menu to pause the analysis for 5 seconds 
after each tube is loaded.

• Select the Output to Printer checkbox to print a copy of the analysis 
after the data for each tube is loaded. 
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• Select the Statistics checkbox to export the statistics to a separate file, 
then enter a name for the statistics file. By default, the file is saved in 
D:\BDExport\Statistics.

• Select the Freeze Biexponential Scales checkbox to process all files with 
the same biexponential scales.

• Clear the Use Preferred Global Worksheet checkbox to display analyses 
of tubes within the same global worksheets. This option is useful for 
analyzing panels that require a separate global worksheet for each 
tube.

4 Click Start to begin the analysis.

When the analysis is finished, a completion message similar to Figure 4-28 
displays.

Figure 4-28  Batch analysis complete
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5

Sorting

You can program BD FACSDiva software to sort a specified number of particles 
from multiple populations into a variety of sorting devices including tubes, 
plates, and slides. Hardware for sorting into plates and slides is available as an 
option. Up to four defined populations can be sorted into each tube, allowing up 
to 16 populations to be sorted at one time.

Any subsetted population can be used for sorting, including populations defined 
by quadrant gates, interval gates, or derived gates. A single sort population can 
be defined by up to eight gates. 

The following topics are covered in this chapter:

• Setting Up for Sorting on page 150

• Determining the Drop Delay – Manual Method on page 154

• Determining the Drop Delay – Automatic Method on page 159

• Sorting on page 161

• Setting Up for Sorting Into a Plate or Slide on page 168

Before you begin, you should be familiar with BD FACSAria II operation using 
BD FACSDiva software. Review chapters 2 and 3, if needed.
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Setting Up for Sorting

In general, do the following to set up for a sorting experiment. Each step is 
explained in more detail in previous or subsequent sections. 

1 Start up the cytometer and the computer.

See Cytometer Startup on page 100. 

2 Install the appropriate size nozzle.

3 Select a new sort setup mode, if needed, and select an appropriate 
cytometer configuration.

To change your current sort setup mode, select a nozzle size from the Sort > 
Sort Setup menu. 

For more information, see Sort Setup on page 85.

4 Install a sample line filter, if needed.

See Installing or Removing a Sample Line Filter on page 212.

5 Check the laser delay for your sheath pressure and particle size. 

• To set the laser delay automatically using the Cytometer Setup and 
Tracking module, see Checking Cytometer Performance on page 116.

• To set the laser delay manually, see QC Using BD FACSDiva Software 
on page 307.

6 Optimize cytometer settings for the sample to be sorted.

See Data Collection on page 131.

7 Install the required collection device and set up the side streams.

See Setting Up for Bulk Sorting on page 152 or Setting Up for Sorting Into a 
Plate or Slide on page 168.
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8 Calculate the drop delay.

See Determining the Drop Delay – Manual Method on page 154.

9 Use gating tools and subsetting methods to define the population(s) of 
interest.

Examples of gating analyses can be found in Analyzing Data on page 143 
and in Getting Started with BD FACSDiva Software.

10 Define a sort layout for the tube containing the defined sort populations 
and proceed with sorting. 

See Sorting on page 161. 
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Setting Up for Bulk Sorting 

This section describes how to set up the streams for two- or four-way sorting. For 
sorting using the ACDU option, see Setting Up for Sorting Into a Plate or Slide on 
page 168.

To set up for bulk sorting:

1 Install collection tubes in the required collection device.

Collection tube holders are available for 1-mL microtubes, 1.5 mL Eppendorf 
tubes, 12 x 75-mm tubes, and 15-mL centrifuge tubes. For compatible tubes, 
see Labware on page 263. 

2 Install the collection tube holder onto the cytometer.

a Close the sort block door and open the sort collection chamber door, if 
needed. The sort block door must be closed to install the tube holder.

b Slide the holder into the slotted fittings below the sort aspirator drawer, 
then close the sort collection chamber door.

3 Turn on the deflection plates.

Click the Voltage button in the Side Stream window (Figure 5-1 on 
page 153). The voltage warning light illuminates, indicating that the plates 
are charged. 

Any cytometer surface that comes in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when handling 
sorting hardware. Wear suitable protective clothing and gloves.

Before installing the collection tube holder, ensure that an O-ring is 
installed in the groove between the two sections of the tube holder. The 
O-ring minimizes the chance of aerosols escaping. It can be found in the 
accessory kit (Catalog No. 337897).
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Figure 5-1  Turning on the deflection plates 

Make sure the center stream image does not move after the plates are 
turned on. Major movement of the center stream could indicate that the 
plates or area around the plates needs cleaning. 

4 Click the Test Sort button and optimize the side streams. See Figure 5-2.

Adjust the voltage sliders to view the required number of streams. 

Figure 5-2  Turning on Test Sort 

A 12,000-volt potential exists between the deflection plates when they are 
on. Contact with the charged plates results in serious electrical shock. Do 
not touch the deflection plates when the plate voltage is on. The plates 
remain energized even when the sort block door is open.

Voltage 
button

Test Sort 
button

Voltage 
sliders
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If you cannot see a stream image or the image is dim, adjust the micrometer 
dial on the diode laser to better view the streams (Figure 1-21 on page 23). 

5 Adjust the 2nd, 3rd, and 4th Drop settings to tighten the center stream and 
fine-tune the side streams, if needed.

Generally, the sort setup mode provides good starting values for these 
settings. Adjust the values only if needed to optimize the streams.

6 Open the aspirator drawer and aim the side stream(s) into each collection 
tube.

a In the Side Stream window, click the Waste Drawer button to open the 
drawer.

b Open the sort block door and aim each side stream into the tube as you 
adjust the corresponding slider in the Side Stream window.

c When you are satisfied with the side stream deflection, close the sort 
block door.

7 Click the Voltage button to turn off the deflection plates.

Determining the Drop Delay – Manual Method

BD FACS Accudrop technology is used to determine the optimal drop delay 
setting for your sorting application. For more information, see Drop Delay 
Overview on page 51. 

There are two methods for determining the drop delay.

• Manual drop delay. Using the standard method as described in the 
following sections.

• Auto drop delay. Using an automated algorithm method. See Determining 
the Drop Delay – Automatic Method on page 159.



 Chapter 5: Sorting 155

NOTE Before beginning these procedures, make sure the stream is stable and the 
Sweet Spot is on. 

Setting Up the Experiment

The steps in this section show you how to set the drop delay using the Accudrop 
experiment template. Because no data is recorded, the experiment can be reused 
as often as you like. 

1 Create an experiment from the Accudrop Drop Delay template.

Select Experiment > New Experiment. Select the Accudrop Drop Delay 
experiment and click OK.

2 Expand Specimen_001 and Tube_001.

3 Set the current tube pointer to Tube_001.
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4 Open the sort layout by double-clicking it.

Using Manual Drop Delay 

This section describes the manual method of optimizing the drop delay. 

1 Load a tube filled with a suspension of BD Accudrop beads (approximately 
1–2 drops of beads in 0.5 mL PBS).

2 In the Laser tab of the Cytometer window, set the window extension to 
zero.

3 Adjust the flow rate to achieve an event rate of 1,000–3,000 events per 
second.

; Tip     If this cannot be achieved using a flow rate setting between 1 and 5, 
adjust the bead concentration.

4 Turn on the voltage in the Side Stream window. Click Sort in the Sort 
Layout window.
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5 Click Cancel at the Confirm dialog.

There is no need to collect the beads. When the drawer is closed, the beads 
are sorted to waste.

6 Adjust the micrometer dial (see Figure 1-21 on page 23) to obtain the 
brightest bead spot on the center stream. 

7 Click the Optical Filter button in the Side Stream window.

This control moves the emission filter that allows you to view the Accudrop 
beads in front of the lower camera. When the control is clicked, the image 
switches from a raw image to a processed (digitized) image. The two boxes 
indicate the region of the image where the left and center stream intensities 
are calculated during image processing. The numbers shown are 
percentages of the total intensity. 

If the left side stream is not completely contained in the left region, adjust 
the voltage slider to place the stream in the center of the region.

8 Verify that the sort precision mode is set to Initial. See Sort Precision Modes 
on page 57 for more information.

9 Optimize the drop delay.

Adjust the drop delay value in 1-drop increments (Ctrl-click arrow control) 
to achieve close to 100% intensity in the left side stream. Wait a few 
seconds after each click for a complete response to the delay change. 
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Figure 5-3  Sorting Accudrop beads in Initial mode 

10 In the Sort Layout window, change the precision mode to Fine Tune.

11 Optimize the drop delay.

Adjust the drop delay value in 0.03-drop increments (click arrow control) 
until the left side stream intensity is greater than or equal to 90%. Wait a 
few seconds after each click for a complete response to the delay change. 

Figure 5-4  Sorting Accudrop beads in Fine-Tune mode

12 Click the Optical Filter button to move the emission filter away from the 
camera.

13 Reset the window extension to its original setting (typically 2).

14 Turn off the deflection plates.
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Determining the Drop Delay – Automatic Method

The auto drop delay feature automates setting the drop delay to get optimized 
results from sorting. You should use this method after you have a good 
understanding of how drop delay works in general. See Using Manual Drop 
Delay on page 156 for more information.

Overview of Auto Drop Delay 

Auto drop delay works best when the sort system is stable and assumes that BD 
Accudrop beads are used. When the process is started, the auto drop algorithm 
uses several passes to find best drop delay possible under current conditions of 
the system. Coarse passes are used to find initial drop delay within 2 drops of the 
ideal. The coarse passes are faster than fine tune passes. Fine tune passes are used 
to locate the ideal drop delay value considering current conditions.

Using Auto Drop Delay 

1 Set up an experiment for drop delay as described in Setting Up the 
Experiment on page 155.

2 Load a tube filled with a suspension of BD Accudrop beads (approximately 
2 drops of beads in 0.5 mL PBS).

3 Adjust the flow rate to achieve these values of events per second:

70 micron = 1,000 to 3,000
85 micron = 800 to 2,000
100 micron = 600 to 1,500
130 micron = 400 to 1,200

; Tip     If this cannot be achieved using a flow rate setting between 1 and 5, 
adjust the bead concentration.

4 Turn on the voltage in the Side Stream window. Click Sort in the Sort 
Layout window.
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5 Click Cancel in the Confirm dialog.

There is no need to collect the beads. When the drawer is closed, the beads 
are sorted to waste.

6 Adjust the micrometer dial (see Figure 1-21 on page 23) to obtain the 
brightest bead spot on the center stream. 

7 Click the Auto Delay button in the Side Stream window.

A dialog similar to Figure 5-5 on page 161 opens. The graph in the left 
pane of the dialog represents brightness of the stream (Y axis) versus drop 
delay (X axis). Typically the graph should have a flat portion, with several 
small peaks in either direction (up or down) or one prominent peak. 

NOTE If the original drop delay value was close to the appropriate value 
prior to starting auto delay, then you may not get a graph displayed 
because few data points were required to determine the optimal drop delay.

8 Select Start Run in the Auto Drop Delay dialog.

9 Monitor the Auto Drop Delay dialog for progress. A message appears 
when the process is completed.

NOTE If the sort is stopped during algorithm execution (either by user 
action or because the system detected a failure), the run will be stopped 
with an appropriate message. Start the sort again, verify that the stream is 
stable and the sort is not pausing, and re-run the auto drop delay.



 Chapter 5: Sorting 161

Figure 5-5  Auto drop delay dialog

Sorting

Before beginning the sort, do the following:

1 Perform the steps outlined in Setting Up for Sorting on page 150.

2 Use gating tools and subsetting methods to define the population(s) of 
interest.

Examples of gating analysis can be found in Analyzing Data on page 143 
and in Getting Started with BD FACSDiva Software.

NOTE Gates drawn on a biexponential scale can be used for sorting. 
However, the cytometer will sort on a log scale. Therefore, a gate that 
crosses the zero boundaries will sort all events below zero into that gated 
population. This can cause a variance between the sort results and the 
statistical results in the software. If the gate is completely below zero on a 
biexponential plot, no events will be sorted.

NOTE Snap-To gates cannot be used for sort gates.
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Setting Up the Experiment

; Tip     When more than one drop is deflected in the same direction, residual charge 
from the first drop degrades the quality of the side streams. Thus, when four-way 
sorting or sorting into small wells where precise deflection is required, use the 4-
Way Purity mode or select a mode with a yield mask of zero. For more 
information, see Yield Mask on page 54.

1 Create a new sort layout by clicking the New Sort Layout button on the 
Browser toolbar. 

By default, the 2-Tube Sort Layout appears.

2 Make appropriate entries in the Sort Layout window.

• Select the collection device from the Device menu.

• Change the sort precision mode to Purity (two tubes), 4-Way Purity 
(four tubes), or Single Cell (plate or slide).

• Enter the number of target events by selecting a value from the menu or 
entering a number in the field. 

• Select a Save Sort Reports option: Save None, Save All, or Ask User. 
See Setting Up a Sort Layout on page 89.

• Select the Save Conflicts checkbox if you are using a 2- or 4-Tube Sort 
Layout and want to save conflicts.
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• Select the sort location field(s) to be sorted into. Select multiple fields 
by dragging the mouse. Select a row or column by clicking the row or 
column header. 

• Add the required population(s) to each sort location field. 

• To display fewer counters in the Sort Layout window, click the View 
Counters button and deselect a menu option. The corresponding 
counter is hidden. (Only counters with a checkmark next to the name 
are displayed.)
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Starting and Monitoring the Sort

1 Open the sort collection chamber door and install the collection tubes, 
plate, or slide.

2 Install the sample tube onto the loading port and click Load.

3 Adjust the flow rate.

Sorting results are typically optimized at lower flow rates.

4 (Optional) Turn on the deflection plates and open the aspirator drawer.

The deflection plates turn off automatically each time a tube is unloaded. If 
you do not turn them back on before beginning a sort, a dialog appears 
where you can turn on the plates and open the aspirator drawer by clicking 
OK.

5 Verify that the current tube pointer is indicating the appropriate tube in the 
Browser, then click Sort.

6 Click OK if you are prompted to open the aspirator drawer or turn on the 
deflection plates.

If you click Cancel, sorting will begin with the deflection plates off and the 
drawer closed. As a result, sort populations will be identified and counted, 
but no deflection (or sorting) will occur. If you sort with the drawer closed, 
events will be sorted to waste.
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; Tip     Click Record Data to save data for the tube. Acquisition and sorting 
continue after the required number of events has been recorded.

Sorting continues until the required number of cells has been sorted. 
Acquisition stops and the drawer closes when sorting is complete. If the 
number of Target Events is set to Continuous, sorting continues until you 
manually stop sorting by clicking the Stop Acquiring button in the 
Dashboard, or the Sort button in the Sort Layout window. 

Monitor the sort progress from the Sort Layout window. The number of 
events sorted into each sort location appears in the corresponding field. 
The sort rate and sort conflict rate are displayed in the corresponding 
counter fields.

NOTE When the Sweet Spot is on, sorting pauses automatically if the 
Drop 1 or Gap values are out of range. This ensures that sorting occurs 
only under the proper breakoff conditions. If a more severe problem such 
as a clog is detected, the stream shuts off and sorting stops. The deflection 
plates shut off, the aspirator drawer closes, and the sample tube is 
unloaded. To clear a clogged nozzle, see Cleaning the Integrated Nozzle on 
page 206.

7 (Optional) You can print the sort report at this time, or open the report 
later and print it then. You can also export the report.
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Stopping and Resuming a Sort

The Stop/Resume feature allows you to temporarily stop the sort, and still retain 
the counter values. This is particularly useful when the sample volume is low and 
you need to refill the tube, or to replace collection tubes. 

Replacing Sample Tube 

1 To stop a sort while it is running, click the Sort button in the Sort Layout 
window. 

2 If prompted, click OK to save the sort report. You can set the sort report to 
save automatically after each sort. See Setting Up a Sort Layout on page 89.

3 Unload the sample tube by clicking Unload in the Acquisition Dashboard.

4 Refill the sample tube, then click Load in the Acquisition Dashboard.

5 Click the Resume button in the Sort Layout window to continue sorting.

6 Click OK when you are prompted to open the aspirator drawer or turn on 
the deflection plates.

The sort counters resume from the value where they stopped. The threshold 
counter restarts, however the value is accumulated and the total count is 
saved in the final sort report.

Replacing Collection Tubes 

1 To stop a sort while it is running, click the Sort button in the Sort Layout 
window. 

2 If prompted, click OK to save the sort report. You can set the sort report to 
save automatically after each sort. See Setting Up a Sort Layout on page 89.

3 Click Stop Acquiring in the Acquisition Dashboard to stop the sample flow.
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4 Turn off the deflection plates by clicking the Voltage button in the Side 
Stream window.

5 Remove the lower section of collection tube holder by lifting up on the 
handle and pulling the lower section of the holder down and forward.

6 Replace collection tubes as needed.

7 Reinstall the tube holder and pull down on the handle to secure it in place.

8 Click Acquire Data in the Acquisition Dashboard to restart the sample 
flow.

9 Click the Resume button in the Sort Layout window to continue sorting.

10 Click OK when you are prompted to open the aspirator drawer or turn on 
the deflection plates.

The sort counters resume from the value where they stopped. The threshold 
counter restarts, however the value is accumulated and the total count is 
saved in the final sort report.

Pausing and Resuming a Sort 

The Pause/Resume feature allows you to temporarily pause the sort, and still 
retain the sort counter values. This is useful when you need to make adjustments 
to an experiment during a sort. Be aware that the sample continues to flow 
during a pause.

NOTE If you need to replace the sample tube to refill it, or to replace collection 
tubes, you should stop the sort. See Stopping and Resuming a Sort on page 166.

1 To pause a sort while it is running, click the Pause button in the Sort 
Layout window.

2 Make adjustments to the experiment as needed.

3 Click the Resume button in the Sort Layout window to continue sorting.
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Setting Up for Sorting Into a Plate or Slide

The following sections describe how to set up for sorting into a plate or slide. For 
general guidelines, see Setting Up for Sorting on page 150.

Installing the Sorting Hardware

1 Install the splash shield below the aspirator drawer.

a Close the sort block door and open the sort collection chamber door, if 
needed. 

The sort block door must be closed in order to open the collection 
chamber door. 

b Remove the tube holder, if one is installed.

c Slide the splash shield into the slotted fittings below the sort aspirator 
drawer and push it all the way in.

Any cytometer surface that comes in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when handling 
sorting hardware. Wear suitable protective clothing and gloves.
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2 Click the Access Stage button to bring the ACDU stage to the front.

a Open an experiment, if one is not already open, and create a sort 
layout for any of the tubes.

b In the Sort Layout window, click the Access Stage button to move the 
stage to the front of the sort collection chamber.

3 Install the required collection device on the stage (Figure 5-6).

• If you are sorting into a plate, install the plate with well A1 toward the 
front of the stage. 

• If you are sorting onto a slide, install the slide-adapter tray with the 
printed side up. If your slide has a frosted end, place the frosted end to 
the right.

Figure 5-6  ACDU stage set up with plate (left) and slide (right)

Sorting starts on the front left corner of the device (A1 location), and 
proceeds from front to back, and then from left to right, sorting in a 
serpentine motion. Thus, for a plate, sorting proceeds from well A1–A12, 
B12–B1, C1–C12, and so on. 

When sorting onto a slide, sorting proceeds in rows across the short end of 
the slide, and in columns along the long end of the slide. Make sure that 
you set up your sort layout accordingly. See Figure 5-7 on page 170.

Well A1

Well A1
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Figure 5-7  Sort order on a slide

Setting Up the Stream 

This section describes how to optimize side stream deflection and how to adjust 
the home location.

When sorting into a plate or onto a slide, the stage is pre-programmed to move a 
set distance between wells on a plate or spots on a slide. The home location is 
used as the starting point. The far left stream should hit the center of the well in 
the top left corner of a plate or the top left corner of a slide at the home location.

Default Home location coordinates exist for each standard sort collection device: 
BD Falcon™ multiwell plates with 6, 24, 48, 96, and 384 wells, and standard or 
frosted-end slides. For other plate types, you will need to create a custom device. See 
Creating a Custom Device on page 172.

Use the following procedure to verify the home location and adjust it.

1 Optimize the drop delay.

See Determining the Drop Delay – Manual Method on page 154.

(A1)

(A2)

(A3)
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2 Turn on the deflection plates.

Click the Voltage button in the Side Stream window. The voltage warning 
light illuminates, indicating that the plates are charged.

NOTE Make sure the center stream image does not move after the plates 
are turned on. Major movement of the center stream could indicate that the 
plates or area around the plates needs cleaning. See External Cleaning on 
page 181.

3 Click the Test Sort button and optimize the far left side stream, then click 
the Test Sort button again to turn it off. 

Adjust the far left slider for minimal deflection of the stream. The stream 
should be deflected just enough to clear the hole in the splash shield. Do 
not adjust the other sliders.

If you cannot see a stream image or the image is dim, adjust the micrometer 
dial on the diode laser (Figure 1-21 on page 23) to better view the streams. 

4 Select Sort > Home Device. 

5 In the Device Setup dialog, select the collection device you are using and 
click Go to Home.

Test sort button



172 BD FACSAria II User’s Guide   

The stage moves to the pre-programmed home position.

6 Double-click the Test Sort button to deposit a drop at the home location.

7 Inspect the collection device to see where the drop was deposited.

If you need to move the stage to the front, close the Device Setup dialog 
and click the Access Stage button in the Sort Layout window. 

8 Wipe the collection device dry and place it back on the tray support.

If needed, click the Access Stage button to send the stage back and select 
Sort > Home Position to access the Device Setup dialog again.

9 Adjust the home location, if necessary.

Click the appropriate arrow buttons to move the tray support as needed. 
Large arrows move the tray by five steps. Small arrows move the tray by 
one step.

10 Repeat steps 6 through 9 until the drop is centered appropriately.

11 Click Set Home, then Close.

12 Click the Voltage button to turn off the deflection plates.

13 Proceed with Sorting on page 161.

Creating a Custom Device 

You can program the ACDU stage to sort into any grid configuration. Create a 
custom device by entering the number of rows and columns and setting the home 
and farthest locations. BD FACSDiva software calculates the increment between 
rows and columns to determine the sort locations. The home and farthest 
locations for a 96-well plate are A1 and H12, respectively.
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Figure 5-8  Home and farthest location on 9-drop slide (example)

1 Select Sort > Custom Devices.

2 Click the Add button in the Custom Devices dialog.

A new device is added to the list of custom devices. By default, devices are 
named Custom Device_00x, where x is the next consecutively numbered 
device.

3 Select the text in the Name field and enter a new name.

4 Enter the number of sort location rows and columns.

A device can have up to 60 rows and 25 columns.

5 Use the arrow buttons and the Test Sort button to set the home location, 
then click Set Home.

Home

Farthest



174 BD FACSAria II User’s Guide   

See Setting Up the Stream on page 170 for details. There are no default 
values for custom devices, so greater initial adjustment with the arrow 
buttons is required.

6 Use the same procedure to set the farthest location, then click Set Farthest.

The farthest sort location is the well or spot on the lower-right corner of the 
collection device.

7 Click Apply, then Close.

After you set the home and farthest locations, custom devices are listed in 
the Device menu in the Sort Layout window. 

NOTE Once custom devices are defined, you cannot change the number of 
rows and columns.

8 Click the Voltage button to turn off the deflection plates.

9 Proceed with Determining the Drop Delay – Manual Method on page 154 
and Sorting on page 161.

Deleting a Custom Device 

1 Select Sort > Custom Devices.

2 Select the name of the custom device to be deleted in the Custom Devices 
dialog.

3 Click Delete. 

The device is deleted from the Custom Device list, but is retained within 
any sort layouts where it was used.
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6

Shutdown and Maintenance

The BD FACSAria II cytometer is designed to require minimum maintenance. 
However, to preserve the reliability of the cytometer, you must regularly perform 
basic preventive maintenance procedures. This chapter explains routine 
maintenance procedures you should follow to keep your cytometer in good 
condition.

Maintenance procedures are presented as follows:

• Daily Shutdown on page 176

• Scheduled Maintenance on page 182

• Unscheduled Maintenance on page 204
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Daily Shutdown 

In the BD FACSAria II system, the recommended daily shutdown procedure is to 
run the Clean Flow Cell command with the closed-loop nozzle installed (see the 
next section). This procedure fills the flow cell with cleaning solution. This is 
normally sufficient to keep the flow cell clean and operating properly.

If the system is used to process many different sample types, or the system has 
problems with contamination, you can perform a more extensive cleaning by 
running the Fluidics Shutdown command. See Fluidics Shutdown on page 178.

In addition to one of the choices listed above, you should also perform an 
external cleaning. See External Cleaning on page 181.

Cleaning the Flow Cell

Use the Clean Flow Cell command to run a tube of DI water through the sample 
line and flow cell. This procedure can be used in two ways:

• As the daily shutdown procedure. 

• Any time poor optical performance indicates that additional cleaning is 
needed.

NOTE After the procedure is complete, the DI water remains in the flow cell 
until the stream is restarted.

To clean the flow cell:

1 Turn off the stream.

2 Remove the nozzle and install the integrated closed-loop nozzle. See 
Figure 6-1 on page 179.

If you are using a standard closed-loop nozzle, verify that there is an O-ring 
in the nozzle before installing it.

3 Select Cytometer > Cleaning Modes > Clean Flow Cell.
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4 When prompted, install a tube containing approximately 3 mL of sterile, 
filtered DI water, then click OK.

The cytometer loads the tube and fills the flow cell with the DI water.

5 Click OK when the completion dialog appears. 

6 If this is part of a daily shutdown, perform these steps:

a Turn off the cytometer main power. 

b Exit BD FACSDiva software and shut down the computer.

c Vent the air pressure from the sheath tank by pulling up on the vent 
ring.
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Fluidics Shutdown

The Fluidics Shutdown command can be used to perform an extensive cleaning if 
the system is used to process many different sample types, or the system has 
problems with contamination. This procedure removes sheath fluid from the 
lines and fills them with 70% ethanol, and cleans the flow cell.

Preparing for Shutdown

1 Unload the sample tube, if one is loaded.

2 Turn off the stream.

3 Check the waste container and empty it if needed. 

See Refilling the Sheath Tank on page 109. 

4 Check the ethanol shutdown tank and refill if it needed. 

See Refilling the Ethanol Shutdown Tank on page 111.

Running Fluidics Shutdown

1 Select Cytometer > Fluidics Shutdown. The following window opens.

2 Remove the nozzle from the flow cell assembly and click Done.

3 Insert the integrated closed-loop nozzle into the flow cell assembly and 
click Done. See Figure 6-1. 
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If you are using a standard closed-loop nozzle, verify that there is an O-ring 
in the nozzle before installing it.

Figure 6-1  Closed-loop nozzle installed in flow cell 

4 Connect the air and fluid lines to the stainless steel ethanol (ETOH) 
shutdown tank. See Figure 6-2 on page 180.

a Disconnect the air line from the sheath tank and connect it to the air 
port on the ETOH shutdown tank.

b Disconnect the fluid line from the bottom side of the sheath filter and 
connect it to the ethanol filter on the ETOH shutdown tank. See 
Figure 6-2 on page 180.

Keep the sheath filter attached to the sheath tank. Do not run ethanol 
through the sheath filter.

c Click Done.

The system starts the cleaning process, and then displays a message at the 
bottom of the window.
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Figure 6-2  Connecting air and fluid lines for shutdown procedure 

5 When prompted, install a tube containing 3 mL of sterile, filtered DI water on 
the loading port, then click Done.

The cytometer loads the tube and continues the cleaning process. A 
progress message appears, and then displays Done when the process is 
complete.

Disconnect 
here

Fluid and air lines moved for shutdown

Air line
Fluid line

Ethanol shutdown 
tank

Sheath tank

Ethanol
filter

Sheath
filter

Side viewTop view
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6 Click OK when you see a message informing you the system can be turned 
off. 

7 Vent the air pressure from the sheath tank by pulling up on the ring on the 
pressure relief valve.

8 Turn off the cytometer main power. 

9 Exit BD FACSDiva software and shut down the computer.

External Cleaning

To keep the system free from salt buildup, wipe down all cytometer surfaces that 
have been exposed to sheath fluid. Clean surfaces with a cloth dampened with a 
10% bleach solution, followed by DI water.

The following surfaces should be inspected and cleaned when necessary:

• Inside the sort chamber

• Deflection plates

• Sample loading port

• Collection devices

All cytometer surfaces that come in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when cleaning 
cytometer surfaces. Wear suitable protective clothing and gloves.

To prevent shock, turn off the plate voltage before cleaning on or around 
the deflection plates. To prevent arcing (sparking), make sure the plates are 
completely dry before you turn the plate voltage back on.
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Scheduled Maintenance

For optimal cytometer functioning, perform the following procedures according 
to the recommended maintenance schedule.

Table 6-1  Scheduled Maintenance

Procedure Recommended Frequency

Internal Cleaning on this page See Table 6-2 on page 183

Purging the Fluid Filters on page 190 Weekly

Purging the Sheath Filter on page 191 Weekly

Changing the disposable waste cap (see 
Emptying the Waste Container on 
page 114)

Monthly

Changing the Fluid Filters on page 191 Every 6 months

Changing the Sheath Filter on page 192 Every 3 months

Changing the Ethanol Shutdown Filter on 
page 193

Every 6 months

Changing the Sample Lines on page 194 Every 4–6 months, or as needed

Changing the Air Filters on page 202 Every 6–12 months, depending on 
cytometer use and the quality of the air

Changing the Sheath Tank Air Filter on 
page 203

Every 6 months

Checking the Fluidics Cart Drip Tray on 
page 203

Weekly
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Internal Cleaning

BD FACSDiva software includes four pre-programmed cleaning modes that can 
be used alone, or in combination to provide the required level of cleaning. The 
following sections describe the different cleaning modes. See Table 6-2 on 
page 183 for an overview of each mode. 

Table 6-2  Cytometer cleaning modes

Cleaning Mode Summary Frequency

Sample Line Backflush on 
page 184

Flushes the sample line with 
sheath fluid.

After running samples with 
adherent cells or dye.

Cleaning the Flow Cell on 
page 176

Cleans the sample path and 
the flow cell with DI water.

When indicated by 
distorted scatter or high 
CVs, or as a daily 
shutdown procedure.

Prime After Tank Refill on 
page 184

Primes the fluid lines for the 
designated fluid(s).

When a fluidics line is 
unplugged to refill a tank.

Prepare for Aseptic Sort 
on page 187

Decontaminates the complete 
sheath path and sample path 
with bleach, DI water, and 
ethanol.

When needed before 
aseptic sorting.
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Sample Line Backflush

After a sample tube is unloaded, the sample line tubing within the sample 
injection chamber is automatically flushed inside and out with sheath fluid to 
eliminate potential sample carryover. Use the Sample Line Backflush command to 
perform additional backflushing of the inside of the sample line after a tube is 
unloaded. Perform the sample line backflush when you observe sample carryover 
or after running samples with adherent cells or dye.

NOTE Keep the stream running while performing the backflush.

1 Select Cytometer > Cleaning Modes > Sample Line Backflush.

2 Click Start to start the backflush.

3 Click Stop to stop the backflush, or click Cancel to stop the backflush and 
close the dialog.

The backflush does not stop automatically.

Prime After Tank Refill

Use the Prime After Tank Refill command to prime the fluid lines if a 5-liter 
plastic fluidics container was disconnected for refilling.

1 Turn off the stream.

2 Select Cytometer > Cleaning Modes > Prime After Tank Refill.
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3 Select the checkboxes for the tanks that were refilled, then click OK.

The cytometer proceeds with priming the specified tanks. A progress 
message appears while the tanks are being primed.

4 Click OK when the tank prime is complete. 

Removing the Sheath Probe 

The sheath probe must be removed from the sheath tank before autoclaving the 
tank in preparation for performing the aseptic sort procedure. 

NOTE Do not autoclave the sheath probe. It is not designed to withstand the 
conditions of autoclaving.
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Make sure to follow the steps below in sequence, so the containment device 
works properly. 

1 Disconnect the air line from the sheath tank.

2 Vent the air pressure from the sheath tank by pulling up on the pressure 
relief valve. Verify that all of the pressure is released by pulling up a second 
time.

3 Loosen the nut at the top of the probe with an 11/16-inch wrench 
(provided in accessory kit). See Figure 6-3.

Figure 6-3  Sheath probe containment device 

4 Loosen the thumbscrew on the containment device.

5 Pull the top section of the containment device straight up and out of the 
bottom section. See Figure 6-4.

Figure 6-4  Removing sheath probe

Sheath probe

Containment 
device

Thumbscrew

Pressure relief valve

11/16-inch nut

Top section of 
containment 
device
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6 Finish loosening the 11/16-inch nut at the top of the probe and pull the 
probe straight up and out of the sheath tank.

7 Decontaminate the sheath probe using 70% ethanol. See Figure 6-5.

Figure 6-5  Sheath probe

Prepare for Aseptic Sort

Use the Prepare for Aseptic Sort command when you want to decontaminate the 
entire sheath path. This procedure cleans the system with bleach, DI water, and 
ethanol. 

Do these steps before starting the Prepare for Aseptic Sort command:

1 Verify that the pressure has been vented from the sheath tank and the 
sheath probe has been removed. See the preceding section.

2 Disconnect the fluid and air lines from the sheath tank.

3 Empty the sheath tank and rinse with DI water.

4 Autoclave the sheath tank at 125°C and 15 psig for 30 minutes with a 7.5-
minute warmup and shutdown cycle.

5 Fill the sterilized sheath tank with sterile sheath fluid.

6 Obtain a new sheath filter to replace the old filter when instructed to do so 
in the wizard. See Changing the Sheath Filter on page 192. 

7 Install the decontaminated sheath probe into the sheath tank and tighten 
the nut securely with an 11/16-inch wrench.

8 Install the top section of the containment device into the bottom section, 
and then tighten the thumbscrew.
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9 Sterilize the DI water sensor by soaking in a 10% bleach solution for 10 
minutes.

10 Fill the DI water container with sterile DI water and 3 mL of bleach per 
liter of DI water, and then reinstall the sterilized DI water sensor.

To run the Prepare for Aseptic Sort command:

1 Select Cytometer > Cleaning Modes > Prepare for Aseptic Sort.

Follow the instructions on screen as you perform the procedure.

2 Install the integrated closed-loop nozzle in the flow cell and click Done.

If you are using a standard closed-loop nozzle, verify that there is an O-ring 
in the nozzle before installing it.

3 Remove the fluid line from the DI water port, connect the fluid line from 
the bleach container to the DI water port, then click Done. See Figure 6-6.

Do not disconnect the sensors from either container.
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Figure 6-6  Moving the bleach fluid line 

4 Disconnect the bleach fluid line from the DI water port, and connect it 
back to the bleach container port, then reconnect the fluid line to the DI 
water port, and click Done.

5 Disconnect the fluid line from the sheath tank (at the output side of the 
sheath filter) and connect it to the fluid out port on the side of the fluidics 
cart (see Figure 6-7). Click Done.

The system cleaning takes approximately 20 minutes.

Figure 6-7  Moving the sheath fluid line 
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6 Disconnect the fluid line from the fluid out port on the side of the fluidics 
cart and connect it to a new 0.2-µm sheath filter. See Changing the Sheath 
Filter on page 192.

7 Remove the old sheath filter and connect the new 0.2-µm sheath filter to 
the liquid port of the sterilized sheath tank.

8 To complete the process, select one of the two options.

Figure 6-8  Finishing the aseptic sort prep process

• To continue running samples, perform fluidics startup.

• To turn off the system, perform the flow cell cleaning procedure.

Purging the Fluid Filters

Once a week, purge air from the fluid filters for the 5-L plastic containers by 
opening the bleeder valve on the top of each filter. This ensures that the filters 
will not dry out.

1 Open the bleeder valve a small amount and leave it open until fluid seeps 
out through the valve (see Figure 6-9 on page 191).

2 Close the valve.

3 Wipe up any excess fluid that might have dripped onto the fluidics cart.
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Purging the Sheath Filter 

Once a week, purge air from the sheath filter by opening the bleeder valve on the 
top of the filter. The sheath tank is pressurized, so do this task carefully to avoid 
spraying sheath fluid on any equipment. 

1 Place a small container under the bleeder valve to catch any fluid.

2 Slowly open the bleeder valve a small amount and leave it open until fluid 
seeps out through the valve (see Figure 6-10 on page 192).

3 Close the valve.

4 Wipe up any excess fluid that might have dripped onto the fluidics cart.

Changing the Fluid Filters 

We recommend changing the fluid filters every 6 months. Spare filters are 
included with the accessory kit. 

Figure 6-9  Fluid filters

1 Remove the filter by pressing the tabs on each quick-disconnect coupling. 
(See Figure 6-9.)

2 Install the new filter and connect the quick-disconnect couplings.

Write the current date on the filter so you will know when to replace it.

Quick-disconnect 
couplings

Bleeder valve
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3 Open the bleeder valve on top of the filter a small amount and leave it open 
until fluid seeps out through the valve.

4 Close the valve.

5 Wipe up any excess fluid that might have dripped onto the fluidics cart.

Changing the Sheath Filter 

We recommend changing the sheath filter every 3 months, or when increased 
debris in an FSC vs SSC plot indicates that the sheath filter needs to be replaced. 
Spare filters are included with the accessory kit. 

NOTE The sheath filter is the same as the one used for the ethanol shutdown 
filter. The filters can be used for either purpose.

1 Turn off the stream.

2 Remove the filter by pressing the tabs on each quick-disconnect coupling. 
(See Figure 6-10.)

Figure 6-10  Sheath filter

3 Unscrew the nuts at each end of the filter to remove the connecting tubing.

4 Locate a new filter and wrap the threads at each end with Teflon tape.

Direction of flow
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5 Observe the direction of flow on the filter and replace it in the same 
orientation.

a Screw the nuts with connecting tubing onto each end of the filter and 
tighten finger-tight.

b Tighten nuts 1 to 2 additional turns with a wrench.

c Check for leaks once pressure is turned on.

d Write the current date on the filter so you will know when to replace it.

6 Open the bleeder valve on top of the filter a small amount and leave it open 
until fluid seeps out through the valve.

7 Close the valve.

Changing the Ethanol Shutdown Filter 

We recommend changing the ethanol shutdown filter every 6 months. Spare 
filters are included with the accessory kit. 

NOTE The ethanol shutdown filter is the same as the one used for the sheath 
filter. The filters can be used for either purpose.

1 Remove the filter by pressing the tabs on each quick-disconnect coupling. 
(See Figure 6-11.)

Figure 6-11  Ethanol filter

2 Unscrew the nuts at each end of the filter to remove the connecting tubing.

3 Locate a new filter and wrap the threads at each end with Teflon tape.

Direction of flow
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4 Observe the direction of flow on the filter and replace it in the same 
orientation.

a Screw the nuts with connecting tubing onto each end of the filter and 
tighten finger-tight.

b Tighten nuts 1 to 2 additional turns with a wrench.

c Check for leaks once pressure is turned on.

d Write the current date on the filter so you will know when to replace it.

5 Open the bleeder valve on top of the filter a small amount and leave it open 
until fluid seeps out through the valve.

6 Close the valve.

Changing the Sample Lines

The primary sample line between the sample injection chamber and the pinch 
valve should be changed every 4–6 months or when decreased event rates 
indicate that the sample line might be clogged. The secondary sample line 
between the pinch valve and the cuvette flow cell needs changing only when it is 
kinked or clogged.

Figure 6-12  Primary and secondary sample lines
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To withstand the high pressures generated by the BD FACSAria II flow cytometer, 
the sample lines are attached using a two-piece compression fitting, where a 
cone-shaped ferrule is compressed onto the tubing as the connecting nut is 
tightened. 

To replace the tubing, you will need a 12-inch length of replacement tubing for 
the primary sample line, or a 7-inch length for the secondary line. Replacement 
tubing is supplied in the accessory kit. The ferrules and connecting nuts can be 
reused when the tubing is replaced.

Changing the Primary Sample Line

To replace the primary sample line, you will need a 12-inch length of replacement 
tubing from the accessory kit. There is a different fitting at each end of the 
tubing, so the procedure is divided into two sections. 

Assembling the Collet Fitting at the Pinch Valve

At the pinch valve end of the primary sample line, a collet fitting joins the sample 
line to the pinch tubing. 

To replace the tubing:

1 Turn the stream off (if needed). Make sure the loading port is in the unload 
position.

2 Unscrew the nut from the collet fitting and pull the nut and collet apart.

3 Pull the pinch tubing out of the nut, and then pull the sample line out of the 
pinch tubing. See Figure 6-13.

All biological specimens and materials coming into contact with them can 
transmit potentially fatal disease. Handle used tubing and fittings as if 
capable of transmitting infection. Wear suitable protective clothing and 
gloves. 
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4 Locate a new 12-inch piece of sample line tubing.

a Slide the nut over the new sample line tubing.

Figure 6-13  Collet nut fitting on pinch valve tubing

b Slide the pinch valve tubing over one end of the sample line tubing until 
approximately 6 mm of the sample line is inside the pinch valve tubing.

c Slide the pinch valve tubing on the inside of the teeth of the nut until it 
stops.

d Couple both pieces of the fitting together and then tighten until finger-
tight.

Collet Nut

Sample line 
tubing

6 mm

Pinch valve 
tubing
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Primary Sample Line - Sample Injection End

At the sample injection end of the primary sample line, a compression fitting 
secures the sample line at the top of the sample injection chamber. 

Figure 6-14  Primary sample line insertion

1 Turn the stream off (if needed). Make sure the loading port is in the unload 
position.

2 If there is a sample line filter installed, remove it by pulling it off of the 
sample line. 

To gain access to the filter, see Installing or Removing a Sample Line Filter 
on page 212.

3 Unscrew the connecting nut at the top of the sample injection chamber and 
slowly pull out the sample line. (See Figure 6-12 on page 194.) 

Ferrule

Sample injection 
chamber

Nut

Primary sample 
line
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4 Ensure that a cone-shaped ferrule is attached to the sample line.

Figure 6-14 on page 197 shows an example of a ferrule. If the ferrule was 
left behind in the injection chamber fitting, gently push the tip of the 
ferrule-removal tool (included in the accessory kit) into the top of the 
ferrule and pull the ferrule straight out. See Figure 6-15.

After using the tool, you might need to replace the ferrule. If the ferrule is 
damaged, replace it with a spare (included in the accessory kit).

Figure 6-15  Ferrule tool

5 Slide the ferrule and nut off the end of the sample line.

6 Slide the nut and then the ferrule onto the end of the new sample tubing.

Leave approximately 5 inches (12.7 cm) of tubing extending out of the 
sample injection chamber end. (This length can be adjusted depending on 
the depth of your sample tube.) This length is referred to as the pilot, as 
shown in Figure 6-16 on page 198.

Figure 6-16  Components of a compression fitting 

7 Insert the pilot tubing into its fitting, ensuring that the tubing reaches the 
intended pilot depth.

Do not to bend the primary sample line during insertion.

External view Internal view

Ferrule

Tubing Pilot 
length

Pilot depth

Ferrule Pilot length

Tubing
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Insert the sample line into the sample injection chamber fitting. Push the 
tubing from the top until it is slightly above the bottom of the chamber 
viewing window. Finger-tighten the nut on top of the chamber so the 
sample line is secure. 

8 Check the fitting connections at both ends to make sure they are not 
leaking.

Turn on the stream, load a tube of DI water, and make sure none of the 
fittings are leaking. If needed, unload the tube, turn off the stream, and 
tighten the fittings. After tightening, if leaking still occurs, replace the 
ferrule. 

9 Verify the length of the sample line.

The sample line should not bow or bend when a tube is loaded. If you need 
to adjust the length, unscrew the nut on top of the sample injection 
chamber, adjust the length, and tighten the nut again.

Changing the Secondary Sample Line

This section describes changing the secondary sample line (see Figure 6-12 on 
page 194). There is a different fitting at each end of the tubing, so the procedure 
is divided into two sections. 

Pinch Valve End

The procedure to replace the secondary sample line at the pinch valve end is the 
same as for the primary sample line, except the replacement line is a 7-inch 
length. See Assembling the Collet Fitting at the Pinch Valve on page 195.

Do not overtighten the nut and do not use tools. Over-tightening the nut 
can kink or damage the tubing.

Make sure all fittings are securely tightened. If any fitting is loose, the 
tubing could detach during high-pressure operation, exposing the 
operator to potentially biohazardous sample spray.
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Flow Cell End

1 Turn the stream off (if needed). 

2 Unscrew the connecting nut at the top of the flow cell and slowly pull out 
the sample line. (See Figure 6-17.) 

Figure 6-17  Secondary sample line insertion

3 Ensure that a cone-shaped ferrule is attached to the sample line.

If the ferrule was left behind in the flow cell fitting, gently push the tip of 
the ferrule-removal tool (included in the accessory kit) into the top of the 
ferrule and pull the ferrule straight out. 

After using the tool, you might need to replace the ferrule. If the ferrule is 
damaged, replace it with a spare (included in the accessory kit).

4 Slide the ferrule and nut off the end of the sample line.

5 Slide the nut and then the ferrule onto the end of the new sample tubing.

Leave approximately 0.1 inch (0.25 cm) of tubing extending out of the 
ferrule. This length is referred to as the pilot, as shown in Figure 6-16 on 
page 198.

Nut

Secondary sample line
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6 Insert the pilot tubing into its fitting at the top of the flow cell, ensuring 
that the tubing reaches the intended pilot depth.

7 Finger-tighten the nut at the top of the flow cell to secure the sample line. 

8 Check the fitting connections at both ends to make sure they are not 
leaking.

Turn on the stream, load a tube of DI water, and make sure none of the 
fittings are leaking. If needed, unload the tube, turn off the stream, and 
tighten the fittings. After tightening, if leaking still occurs, replace the 
ferrule. 

Within the cuvette flow cell fitting, make sure the pilot is seated flush 
against the pilot depth. Dead volume between the pilot and the pilot depth 
can lead to sample carryover or leaking.

Do not overtighten the nut and do not use tools. Over-tightening the nut 
can kink or damage the tubing.

Make sure all fittings are securely tightened. If any fitting is loose, the 
tubing could detach during high-pressure operation, exposing the 
operator to potentially biohazardous sample spray.



202 BD FACSAria II User’s Guide   

Changing the Air Filters

The BD FACSAria II cytometer has two air filters: one in the sort collection 
chamber door and one in the side door. 

• To change the filter in the sort collection chamber door, slide out the old 
filter and slide in the new filter. See Replacing the Air Filter on page 288 for 
more information.

• To change the air filter in the side door (Figure 6-18), loosen the screws at 
the top corners of the filter and remove the old filter. Install a new filter and 
tighten the screws to hold the filter in place. Replace the filter once or twice 
a year, depending on the quality of the air in the laboratory.

Figure 6-18  Changing the air filter
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Changing the Sheath Tank Air Filter 

Check the inline air filter on the sheath tank air line periodically for any signs of 
debris or discoloration. Replace with a new air filter from the accessory kit every 
six months, or sooner if needed. 

Figure 6-19  Inline air filter for sheath tank

1 Turn off the cytometer.

2 Pull the tubing off each end of the air filter.

3 Install a new filter with the directional arrow pointing toward the sheath 
tank.

Checking the Fluidics Cart Drip Tray 

Check the drip tray on the fluidics cart weekly for signs of excess liquid and 
empty the tray if needed. 

Sheath tank inline 
air filter

Drip tray
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Unscheduled Maintenance

There are several cytometer components that should be cleaned periodically or 
checked for wear and replaced if necessary. See the indicated sections for the 
following maintenance procedures.

Table 6-3  Unscheduled maintenance

Procedure Recommended Frequency

Changing the Integrated Nozzle on page 205 As needed for different sized particles

Cleaning the Integrated Nozzle on page 206 When stream irregularities indicate that 
the nozzle is clogged

Using the Standard Nozzle on page 208 Use this for changing or cleaning the 
standard nozzle as needed

Temporary Replacement of a Seal on page 208 As needed when seal is lost or damaged 
in an integrated nozzle

Installing an O-ring in a Standard Nozzle on 
page 209

As needed when O-ring is lost or 
damaged

Closed-Loop Nozzle Maintenance on page 210 As needed

Installing or Removing a Sample Line Filter on 
page 212

When the sample line filter needs to be 
installed or changed

Changing the Pinch Valve Tubing on page 214 As needed

Cleaning the Camera Windows on page 217 When smudges appear in the Breakoff or 
Side Stream windows

Removing the Deflection Plates on page 219 As needed to clean the deflection plates

Lubricating the Sample Injection Chamber O-Ring 
on page 220

As needed when the O-ring is dry

Using Custom Optical Filters on page 222 As needed

Cleaning the Optical Filters on page 223 As needed when changing a filter

Removing or Installing the FSC ND Filter on 
page 223

As needed
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Changing the Integrated Nozzle 

Three sizes of nozzles are provided with your cytometer: 70, 85, and 100 μm. A 
130-μm nozzle can be ordered as an option. The size is marked on the nozzle. 
The closed-loop nozzle used for cleaning and shutdown procedures is also 
changed with this procedure. 

1 Turn off the stream and open the flow cell access door.

2 Turn the nozzle-locking lever counter-clockwise to the 6:00 position, and 
pull the nozzle out of the cuvette flow cell (Figure 6-20).

Figure 6-20  Nozzle-locking lever

3 Insert the new nozzle into the flow cell (with top side facing up) and push it 
gently all the way forward until it stops.

4 Turn the nozzle-locking lever clockwise to the 12:00 position.

Any cytometer surface that comes in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when handling 
sorting hardware. Wear suitable protective clothing and gloves. 

Caution: Do not open the sort block door while the nozzle locking lever is 
in the 6:00 position. The flow cell can be damaged by the top of the door 
during opening. Always turn the lever clockwise back to the 12:00 position 
before opening the sort block door.

Nozzle-locking 
lever in 12:00 position
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5 Turn on the stream and make sure it flows smoothly from the nozzle into 
the center of the waste aspirator. 

If the stream is flowing but the breakoff is too long or the gap is unsteady, 
this could indicate that there are bubbles in the flow cell. If these conditions 
occur, turn off the stream, wait for 10 seconds, and turn on the stream 
again.

If you see any dripping or spraying, or the stream image appears abnormal, 
turn off the stream and see Troubleshooting the Stream on page 226.

NOTE After changing the nozzle, you might need to adjust the angle of the sort 
block to re-center the stream in the aspirator. To do so, loosen the adjustment 
screws on both sides of the deflection plates and rotate the sort block (see 
Figure 1-12 on page 14). Tighten the screws when the stream is centered in the 
aspirator. For further assistance, see Troubleshooting the Stream on page 226.

Cleaning the Integrated Nozzle 

Use the following procedure to clean the nozzle when the stream appears blocked 
or distorted. To verify that the nozzle is clogged, examine the opening at the 
center of the seal area under a microscope. Figure 6-21 shows an example of an 
unclogged nozzle tip.

Figure 6-21  Magnified view of an integrated nozzle tip

All biological specimens and materials coming into contact with them can 
transmit potentially fatal disease. Handle nozzles as if capable of 
transmitting infection. Wear suitable protective clothing and gloves.

Seal in 
integrated nozzle
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To clean the integrated nozzle:

1 Turn off the stream and open the flow cell access door.

2 Remove the nozzle from the cuvette flow cell.

Turn the nozzle-locking lever counter-clockwise to the 6:00 position. See 
Figure 6-20 on page 205. Remove the nozzle by pulling it straight out.

3 Sonicate the nozzle for approximately 1 minute.

Sonicate the nozzle in a test tube containing DI water. Repeat the 
sonication in one-minute intervals until the nozzle is clean. Do not sonicate 
for more than a total of 5 minutes. 

4 Carefully reinsert the nozzle into the flow cell and push it gently all the way 
forward until it stops.

5 Turn the nozzle-locking lever clockwise to the 12:00 position.

6 Turn on the stream and make sure it flows through the nozzle properly.

7 Close the flow cell access door.

Note that after re-installing the nozzle, you might need to change the angle of the 
sort block to re-center the stream in the aspirator. To do so, loosen the 
adjustment screws on both sides of the deflection plates and rotate the sort block 
(see Figure 1-12 on page 14). Tighten the screws when the stream is centered in 
the aspirator. For further assistance, see Troubleshooting the Stream on page 226.

Caution: Do not open the sort block door while the nozzle locking lever is 
in the 6:00 position. The flow cell can be damaged by the top of the door 
during opening. Always turn the lever clockwise back to the 12:00 position 
before opening the sort block door.

Do not use bleach or any strong detergents to clean the nozzle. These agents 
can damage the seal in the integrated nozzle.
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Using the Standard Nozzle 

The standard nozzle has a replaceable O-ring, in contrast to the integrated nozzle 
which has a seal fixed in place. This section contains information on handling the 
standard nozzles, particularly in dealing with the standard O-ring.

Changing the Standard Nozzle

The procedure to change the standard nozzle is the same as that for the 
integrated nozzle, except to verify that the O-ring stays in place. See Changing 
the Integrated Nozzle on page 205. While removing the nozzle in step 2, observe 
the following process.

To avoid losing the O-ring, hold the nozzle steady and pull it straight out without 
tilting it from side to side. If you do not see the O-ring on the nozzle, it could be 
stuck to the cuvette. To locate and remove the O-ring, wet the wooden end of a 
cotton swab and use it to wipe the inside of the nozzle well. Use the magnifying 
glass in the accessory kit if necessary.

Cleaning the Standard Nozzle

The procedure to clean the standard nozzle is the same as that for the integrated 
nozzle, except that you remove the O-ring before sonicating and replace the 
O-ring afterwards. See Cleaning the Integrated Nozzle on page 206. The same 
practice applies for the closed loop nozzle. See Cleaning the Integrated Closed-
Loop Nozzle on page 210.

Temporary Replacement of a Seal 

The standard O-ring can be used as a short-term replacement in the integrated 
nozzle, if the original seal has been lost or damaged, but a new integrated nozzle 
will provide better long-term usability. See Accessory Kit on page 258 for part 
numbers for ordering integrated nozzles. 
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Standard O-rings (part number 333084) are supplied in the accessory kit. The 
following procedure describes how to install a standard O-ring in an integrated 
nozzle.

1 Make sure the groove in the nozzle is clean. 

If the any part of the seal is still in the nozzle groove, sonicate the nozzle in 
a 10% bleach solution until the seal comes out. Rinse the nozzle in DI 
water after sonicating.

2 Use the wooden end of a cotton swab, or similar tool, to install the O-ring 
in the nozzle groove, then allow the nozzle to air dry for a few minutes. 

Do not wipe the nozzle with anything, because it could leave fibers or other 
contamination, or dislodge the O-ring.

3 Use the magnifier in the accessory kit, or a microscope, to inspect the 
nozzle to verify the O-ring is installed all the way into in the groove.

Installing an O-ring in a Standard Nozzle

The standard O-ring can be replaced in the standard nozzle if the original O-ring 
has been lost or damaged. Standard O-rings are supplied in the accessory kit.

NOTE We recommend performing this operation under a magnifier due to the 
small size of the O-ring and nozzle groove.

1 Use the wooden end of a cotton swab, or similar tool, to install the O-ring 
in the nozzle groove, then allow the nozzle to air dry for a few minutes. 

Do not wipe the nozzle with anything, because it could leave fibers or other 
contamination, or dislodge the O-ring.

2 Use the magnifying glass in the accessory kit, or a microscope, to inspect 
the nozzle to verify the O-ring is installed all the way into in the groove.
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Closed-Loop Nozzle Maintenance 

The closed-loop nozzle and related tubing should be cleaned if there are any 
indications of clogging or kinked tubing.

Cleaning the Integrated Closed-Loop Nozzle 

1 Turn off the stream and open the flow cell access door.

2 Remove the closed-loop nozzle from the cuvette flow cell. 

Turn the nozzle-locking lever counter-clockwise to the 6:00 position. 
Remove the nozzle by pulling it straight out. See Figure 6-22.

Figure 6-22  Closed-loop nozzle

3 Unscrew the nut on the side of the nozzle to remove the tubing.

Make sure the ferrule stays on the tubing as you remove it.

4 Sonicate the nozzle for approximately 1 minute.

Sonicate the nozzle in a test tube containing DI water or a mild detergent. 
Repeat the sonication as needed until the nozzle is clean.

5 Make sure the ferrule is on the tubing, then screw the nut back into the 
hole in the side of the closed-loop nozzle. See Figure 6-23.
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Replacing the Tubing on the Closed-Loop Nozzle 

To replace the tubing on the closed-loop nozzle, use this procedure. See 
Figure 6-23. Use a 7-inch length of sample tubing from the accessory kit as the 
replacement.

Figure 6-23  Replacing tubing from closed-loop nozzle

To replace the tubing:

1 Unscrew the nut from the closed-loop nozzle and from the union fitting and 
pull out the tubing from both places.

Make sure the ferrule comes out on the tubing on both ends. If not, use the 
ferrule tool to remove it. See Figure 6-15 on page 198. 

2 Slide the nut and ferrule off each end of the tubing.

3 Slide the nut and ferrule onto the new tubing as shown in Figure 6-23.

Insert the tubing into the closed-loop nozzle and slowly tighten the nut 
until secure. Do not over-tighten. Make sure the tubing is pushed all the 
way in while tightening the nut.

4 Insert the tubing into the union fitting and slowly tighten the nut until 
secure. Do not over-tighten. Pull gently on the tubing to ensure it is secure.

Closed-loop 
nozzle

Ferrule Nut Tubing (7-inch length) 

Union fitting
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Installing or Removing a Sample Line Filter 

Sample filters can be installed on the end of the sample line to filter out large 
particles from a sample. Pre-filtering the sample before beginning any sorting is 
recommended.

Two sizes of sample line filters are included in the accessories kit: 35 micron (red) 
and 50 micron (purple). The filters can be changed as often as required. The 
sample filters are not intended for use with the 1-mL microtubes.

NOTE When a sample filter is installed, the sample flow rate can be slowed 
down due to the effect of particles in the sample fluid clogging the filter.

1 Select Change Sample Filter from the Cytometer menu.

Make sure the stream is turned on before starting the process.

2 A wizard appears with the instructions. See Figure 6-24.

Figure 6-24  Sample line filter wizard

3 Loosen the sample line fitting nut at the top of the injection chamber to 
allow the sample line to slide freely through the fitting. See Figure 6-25 on 
page 213.
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Figure 6-25  Loosen nut to move sample line 

4 Push the sample line down so the end is below the bottom of the sample 
injection chamber.

Figure 6-26  Sample line filter installed 

5 Install the sample line filter by sliding it onto the end of the line, then click 
Done. See Figure 6-26.

Do not bend the sample line while installing the filter.

6 Pull the sample line up to operation height, slightly above the chamber 
viewing window.

7 Place a tube onto the loading port. 

Sample injection 
chamber

Nut

Sample line

Sample line 
filter
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8 Click Done, and the sample injection chamber raises. 

The sample line should not bow or bend when a tube is loaded.

9 Adjust the sample line height if needed.

10 Tighten the sample line fitting and click Done. 

The bulk injection chamber is lowered and the sample purge mode is 
turned on for about 5 seconds until several drips exit the filter. A message is 
displayed at the bottom of the wizard. See Figure 6-27 on page 214.

Figure 6-27  Sample line wizard message

11 Click Done and the process is complete.

Changing the Pinch Valve Tubing 

The tubing that runs through the pinch valve should be changed as needed. The 
system ships with replacement tubing cut into 3-inch lengths, found in the 
accessory kit.

Be careful of a pinching hazard as the sample injection chamber is raised.
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Figure 6-28  Pinch valve tubing

To replace the tubing: 

1 Turn off the stream (if needed). Make sure the loading port is in the unload 
position.

2 Pull the existing pinch valve tubing out of the slot in the pinch valve.

Grasp the tubing with two fingers on each side of the pinch valve and pull 
it straight out from the slot. The tubing pops out of the slot with a small 
amount of pulling action. See Figure 6-29 on page 215.

Figure 6-29  Tubing removed from pinch valve

3 Unscrew the nut on the black collet fitting at each end of the tubing, and 
pull the pinch valve tubing out of both fittings.

Pinch valve tubing

Pinch valve 
collet fittings

Pinch valve

Pinch valve 
tubing

Sample line 
tubing

Pinch valve 
collet fittings
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Leave both pieces of the fitting on the sample line tubing.

4 Install a new 3-inch piece of pinch valve tubing. See Figure 6-30 on 
page 216.

a Slip the collet over one end of the new pinch valve tubing.

b Slide the pinch valve tubing over the sample line tubing until 
approximately 6 mm of the sample line is inside the pinch valve tubing.

c Slide the pinch valve tubing on the inside of the teeth of the nut until it 
stops.

d Couple both pieces of the fitting together and then tighten until finger-
tight.

e Repeat steps a through d at the other end of the tubing.

f Check to see that both ends of the new pinch valve tubing are held 
securely in the compression fittings.

Figure 6-30  Collet nut fitting on pinch valve tubing 

5 Install the new pinch valve tubing into the slot in the pinch valve.

Make sure the tubing goes all the way into the back of the slot. The sample 
line can drip if the pinch tubing is not all the way into the slot in the pinch 
valve.

Collet Nut

Sample line 
tubing

6 mm

Pinch valve 
tubing
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Cleaning the Camera Windows

Lower Camera Window

Clean the lower camera window and the diode laser window when you have 
trouble viewing the side streams or you cannot set the drop delay using 
Accudrop. Wipe the windows with a soft, lint-free cloth soaked with DI water, 
and then dry the windows.

Figure 6-31  Lower camera and diode laser windows

Upper Camera Window 

Clean the strobe lens and upper camera window when smudges appear in the 
processed (digitized) image in the Breakoff window, or when dark spots appear 
to interfere with Sweet Spot monitoring. You might need to clean these 

Diode laser window

Lower camera window
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components after a clog, or after sheath fluid has leaked or sprayed. Follow the 
steps in this section to clean the strobe lens and upper camera window. 

To clean the strobe lens and upper camera window:

1 Ensure that the deflection plates are turned off (warning light is not 
illuminated).

2 Turn off the stream.

3 Open the sort block door. 

4 Place 1–2 drops of DI water or ethanol on a cotton swab.

5 Click the Breakoff window and select Raw Image.

Visible smudges are more apparent in the raw image view.

6 While viewing the image on the Breakoff window, insert the swab just 
below the bottom of the flow cell.

The strobe lens and upper camera windows are located behind two circular 
openings on either side of the top of the sort chamber. You will see the end 
of the swab in the Breakoff window when you intercept either opening. 

A 12,000-volt potential exists between the deflection plates when they are 
on. Contact with the charged plates results in serious electrical shock. Do 
not touch the deflection plates when the plate voltage is on. The plates 
remain energized even when the sort block door is open.
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7 Gently wipe the upper camera window, and then the strobe lens (opposite 
the window) to remove any saline.

8 Repeat with isopropyl alcohol or 70% ethanol until clean.

Removing the Deflection Plates 

You can remove the deflection plates for cleaning by pulling the plates out using 
the deflection plate removal tool, supplied in the accessory kit. See Figure 6-32.

Figure 6-32  Deflection plate removal tool 

Upper
camera
window

Strobe lens 
window
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1 Make sure the deflection plates are turned off.

2 Open the sort block door.

3 Slide the deflection plate removal tool behind one of the plates and pull 
straight out from the sort block.

Hold your thumb on the plate (or use your other hand) as you pull it out so 
it does not fall as you remove it.

Figure 6-33  Using the deflection plate removal tool

Lubricating the Sample Injection Chamber O-Ring 

The O-ring at the bottom of the sample injection chamber should be lubricated as 
needed to maintain proper operation. 

1 Verify that the loading port is in the down position, and open the hinged 
cover.

2 Check the O-ring (located at the opening in the bottom of the chamber) to 
see if it is dry.
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3 If the O-ring is dry, it must be lubricated with O-ring lubricant from the 
accessory kit.

a Remove the clear plastic tube holder from the tube holder base.

b Apply a small amount of O-ring lubricant to the O-ring inside the 
chamber and to the top, outside beveled edge of the tube holder base. 
This is where the base contacts the O-ring inside the sample injection 
chamber.

c Wipe off any excess lubricant.

d Replace the tube holder on the base.

Figure 6-34  Loading port with tube holder removed

Apply lubricant to outside 
beveled edge of tube holder 
base.
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Using Custom Optical Filters 

If you want to install a custom filter or dichroic, the filter should comply with the 
following specifications. 

For the longpass filters, the surface that faces the center of the octagon or trigon 
should be coated directly on its surface, not between two or more pieces of glass. 
The coating should transmit >70% of the wavelength range you want the filter to 
transmit, with a minimum transmission of >50%, and it should reflect >90% of 
the wavelength range you want the filter to reflect.

The opposite surface (facing away from the center) should be coated with an 
anti-reflective coating with a minimum reflection of ≤1% of the wavelength 
range you want the filter to reflect.

Note that filters must be installed in front of each PMT to block unwanted laser 
light. For the dichroic, carefully assemble the glass filter in the holder using the 
retaining spring. Assemble the filter with the arrow pointing toward the center of 
the octagon or trigon. The angle of the dichroic is critical to achieving optimal 
results.

Note that any time you modify a detector array, you will need to create a new 
cytometer configuration to identify which PMT (identified by laser color and 
letter) will detect the emitted light. See Custom Configurations on page 74 for 
instructions.

Table 6-4  BD FACSAria II filter specifications

Filter Characteristic Dichroic LP Filters BP Filters

Diameter 0.622 ±0.003 in. 1.00 ±0.010 in.

Thickness 0.125 ±0.005 in. 0.12–0.35 in.

Minimum clear aperture 0.562 in. 0.85 in.

Incident angle 11 ±1° 0°
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Cleaning the Optical Filters

Optical filters should be inspected occasionally and cleaned as necessary. The 
frequency will depend on how often the filters are handled. 

1 Wrap a triangular section of the lens paper around the cotton end of a 
cotton swab. Moisten and seal the end with a few drops of alcohol.

2 Holding the cotton swab in a horizontal position, gently rub any spots on 
the filter surface and wipe clean.

3 Allow the solvent to evaporate and check the filter surface for streaks.

4 Inspect a ¼-inch–diameter section in the center of the filter for scratches.

Filters are coated with different dielectrics that can get scratched. If you see 
scratches, replace the filter.

5 Insert the cleaned filter into the octagon or trigon.

Make sure the filters are pushed all the way in. 

Removing or Installing the FSC ND Filter

For applications involving large particles where events appear off scale on the 
FSC axis with a voltage of zero, keep the FSC ND filter in place to decrease the 
FSC signal and keep the events on scale. For applications involving small 
particles (for example, bacteria or platelets), you might need to remove the FSC 
ND filter as follows.

1 Open the flow cell access door.

2 Locate and pull out the FSC ND filter (Figure 6-35 on page 224).

When cleaning or replacing a filter, handle with care to avoid scratching the 
surface and to prevent the filter from falling out of the holder. Use cotton 
swabs, optical lens paper, and spectral-grade methanol or absolute ethanol 
in a dropper bottle (do not use acetone) to clean the optical filters.
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The filter is installed at the left end of the FSC detector block, just to the 
right of the flow cell. To remove the filter, loosen the set screw and pull the 
filter out of the slot. 

Figure 6-35  Removing the FSC ND filter

3 To reinstall the filter, slide it into the slot with the filter side down and the 
label facing the flow cell. 

NOTE You can remove the nozzle holder to get better access to the ND 
filter slot.

Nozzle holder

FSC ND filter

Set screw
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7

Troubleshooting

The tips in this section are designed to help you troubleshoot your experiments. 
Additional troubleshooting information can be found in the BD FACSDiva 
Software Reference Manual.

If additional assistance is required, contact your local BD Biosciences technical 
support representative. See Technical Assistance on page xv.

Troubleshooting suggestions in this chapter are grouped under the following 
headings: 

• Troubleshooting the Stream on page 226

• Troubleshooting the Breakoff on page 231

• Sorting Troubleshooting on page 232

• Acquisition Troubleshooting on page 237

• Fluidics Troubleshooting on page 244

• Electronics Troubleshooting on page 245
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Troubleshooting the Stream
Observation Possible Causes Recommended Solutions

Stream not in center 
of aspirator

Difference in keyed stream 
position between nozzles

If you have just changed the 
nozzle, use an Allen wrench to 
loosen the screws on either side of 
the sort block. Adjust the angle of 
the sort block until the stream 
flows into the center of the waste 
aspirator, and then tighten the 
screws. See Figure 1-12 on 
page 14.

Nozzle inserted improperly Turn off the stream. Remove the 
nozzle and ensure that the seal or 
O-ring is in place. Re-insert the 
nozzle and slide the nozzle in until 
it stops, then close the locking 
lever.

Clogged or damaged nozzle Turn off the stream, remove the 
nozzle, and examine the nozzle tip 
under a microscope.

• If debris is visible, clean the 
nozzle. See Cleaning the 
Integrated Nozzle on page 206.

• If the nozzle appears damaged, 
replace it. See Changing the 
Integrated Nozzle on page 205.
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No stream or dripping 
stream

Nozzle inserted improperly Turn off the stream. Remove the 
nozzle. See Changing the 
Integrated Nozzle on page 205 for 
instructions. 

Clogged or damaged nozzle Turn off the stream, remove the 
nozzle, and examine the nozzle tip 
under a microscope.

• If debris is visible, clean the 
nozzle. See Cleaning the 
Integrated Nozzle on page 206.

• If the nozzle appears damaged, 
replace it. See Changing the 
Integrated Nozzle on page 205.

Stream control disabled 
or no stream when 
Stream control clicked

Air lock in fluidics filter Prime the system with the 
corresponding fluid. 

If the control is still disabled, 
remove the filter, install bypass 
tubing, and repeat the priming 
procedure until you see fluid in 
the line.

When fluid is running through the 
line, remove the bypass tubing, 
install the filter, and repeat the 
priming procedure one last time.

Communication failure 
between workstation and 
cytometer

Exit the software and restart it.

Troubleshooting the Stream (continued)
Observation Possible Causes Recommended Solutions
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No stream when Stream 
control clicked

Sheath tank low or empty Refill the sheath tank. See 
Refilling the Sheath Tank on 
page 109. 

Note that when the empty tank 
warning message is not dismissed 
after 15 minutes, the stream shuts 
off automatically. 

Air in sheath line Prime the sheath tank. See Prime 
After Tank Refill on page 184.

Air in sheath filter Purge the sheath filter. See Purging 
the Sheath Filter on page 191.

Dry filter Open the bleeder valve to purge 
the filter. See Purging the Fluid 
Filters on page 190.

Fanning around center 
stream

Nozzle inserted improperly Re-insert the nozzle. Push it gently 
all the way forward without 
rocking it from side to side.

Unstable stream Debris in flow cell or nozzle Remove the nozzle and run the 
stream with no nozzle in place for 
approximately 10 seconds. (Click 
the Stream control on, then off.) 
Sonicate the nozzle and re-install 
it.

Fluid line connected to 
ethanol shutdown tank

Move fluid and air lines to sheath 
tank, then perform Fluidics 
Startup. See Performing Fluidics 
Startup on page 101.

Troubleshooting the Stream (continued)
Observation Possible Causes Recommended Solutions
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Leaking or spraying 
around nozzle

Defective or damaged 
integrated nozzle seal

Replace the defective seal with a 
standard O-ring. Temporary 
Replacement of a Seal on 
page 208.

Defective or damaged O-ring 
in standard nozzle

Replace the O-ring. See Installing 
an O-ring in a Standard Nozzle on 
page 209.

Nozzle inserted improperly Turn off the stream. Remove the 
nozzle. See Changing the 
Integrated Nozzle on page 205 for 
instructions. 

Extra O-ring is blocking the 
nozzle

Remove the nozzle and use a 
cotton swab to clear out the 
cuvette.

Drop breakoff is too 
long

Bubbles in flow cell Open the flow cell access door 
and check for bubbles in the flow 
cell. If they are visible, turn off the 
stream, wait a few seconds, and 
turn on the stream again. 

Attenuation is on Turn off attenuation.

Amplitude is too low Increase the amplitude until you 
can see drops. If you need a very 
high amplitude (>70 volts) to see 
drops, you might have air bubbles 
in the flow cell.

Nozzle inserted improperly Turn off the stream. Remove the 
nozzle and ensure that the seal or 
O-ring is in place. Re-insert the 
nozzle and slide the nozzle in until 
it stops, then close the locking 
lever.

Troubleshooting the Stream (continued)
Observation Possible Causes Recommended Solutions
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Problems using Auto 
Delay feature

Stream is not stable Make sure stream is stable before 
starting to run auto delay.

Diode laser does not fully 
intercept the sorting streams

Adjust the diode laser to intercept 
streams in the middle, producing 
biggest and brightest spots in the 
left and center images.

Event rate is too low or too 
high

Adjust flow rate to increase or 
decrease event rate. 

Troubleshooting the Stream (continued)
Observation Possible Causes Recommended Solutions
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Troubleshooting the Breakoff

Use the following examples to help troubleshoot problems with the breakoff image. 

A
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m
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tr
ea

m
 Im
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e

Normal stream 
image

Po
ss
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le

Ca
us

es

Nozzle 
inserted 
improperly

Nozzle inserted 
improperly or 
orifice is off 
center

Partial clog Wet or dirty 
strobe lens

Attenuation is 
on at wrong 
pressure

Re
co

m
m

en
de

d
So

lu
ti

on
s

Remove the 
nozzle and 
re-insert it.

Remove the 
nozzle and 
re-insert it.

Remove the 
nozzle, clean 
it, and then 
re-insert it.

Clean the lens 
as described in 
Cleaning the 
Camera 
Windows on 
page 217.

Turn off 
attenuation in 
the Side 
Stream 
window.
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Sorting Troubleshooting
Observation Possible Causes Recommended Solutions

Unstable breakoff while 
Sweet Spot is engaged

Residual ethanol in system Allow the system to run until the 
breakoff stabilizes.

Target Drop 1 value is out of 
range for drop spacing

Use an actual Drop 1 value for the 
target. Remember to repeat the 
drop delay setup each time the 
target value is changed.

Nozzle is clogged or inserted 
improperly

Turn off the stream. Remove the 
nozzle and clean it. Re-insert the 
nozzle and slide the nozzle in until 
it stops, then close the locking 
lever.

Dirty strobe lens or upper 
camera window

Clean the lens and the window as 
described in Cleaning the Camera 
Windows on page 217.

Air in sheath filter Purge the sheath filter. See Purging 
the Sheath Filter on page 191.

Debris in flow cell or nozzle Remove the nozzle and run the 
stream with no nozzle in place for 
approximately 10 seconds. (Click 
the Stream control on, and then 
off.) Sonicate the nozzle and 
re-install it.

Center stream image is 
dim or not visible in the 
Side Stream window

Camera window is dirty Clean the lower camera window. 
See Cleaning the Camera 
Windows on page 217.

Stream is not intercepting the 
diode laser 

Adjust the micrometer dial on the 
laser to make the stream intercept 
as bright as possible. See 
Figure 1-21 on page 23.
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Center stream is off 
center when the plate 
voltage is turned on

Voltage center too low or too 
high

Adjust the Voltage Center slider to 
put the center stream back to 
center.

Saline spray on deflection 
plates or in sort block

Clean the deflection plates and the 
area around them. 

Arcing between 
deflection plates

Salt bridge Clean and dry the deflection plates 
and the area around and behind 
the plates. 

ACDU sorting failure Insufficient stream voltage Increase the voltage for the far left 
stream.

Splash shield not installed Install the splash shield. See 
Installing the Sorting Hardware 
on page 168.

Side stream position 
reversal, where the 
streams appear to be 
associated with the 
wrong voltage slider.

Voltage sliders are set too far 
in or too far out.

Move sliders in or out so they 
control the correct side streams.

Sorting Troubleshooting (continued)
Observation Possible Causes Recommended Solutions
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No deflection or 
insufficient deflection

Insufficient voltage • Increase the side-stream voltages 
using the slider controls.

• Increase the plate voltage.

Stream-charging wire is loose 
or missing

Verify the stream-charging wire is 
inserted all the way into the barb.

Salt bridge Turn off the stream. Remove the 
nozzle. See Changing the 
Integrated Nozzle on page 205 for 
instructions. 

Sorting paused because actual 
Drop 1 value is out of range

Wait until the Sweet Spot adjusts 
the amplitude to achieve the 
Drop 1 target. 

If this happens repeatedly during 
sorting, there might be debris in 
the nozzle or flow cell. See 
Troubleshooting the Stream on 
page 226 for suggestions.

Sorting Troubleshooting (continued)
Observation Possible Causes Recommended Solutions
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Fanning around center 
or side streams

Nozzle inserted improperly Turn off the stream. Remove the 
nozzle and ensure that the seal or 
O-ring is in place. Re-insert the 
nozzle and slide the nozzle in until 
it stops, then close the locking 
lever.

Sweet Spot is off Turn on the Sweet Spot.

Incorrect sort precision mode Verify that the sort precision mode 
is appropriate for your sorting 
requirements. See Sort Precision 
Modes on page 57.

2nd, 3rd, or 4th Drop values 
not optimized

Adjust the 2nd, 3rd, and 4th Drop 
settings to tighten the center 
stream and fine-tune the side 
streams.

Particles too big for nozzle Change the nozzle. See Changing 
the Integrated Nozzle on 
page 205.

Sort button disabled Current tube pointer not set 
to current tube

Click to move the current tube 
pointer to the appropriate tube.

Population not listed in 
Add menu on sort layout

Population defined using 
snap-to gate

Redefine the population using 
another gate type.

Viewing sort layout for 
another tube

Open or create a sort layout for 
the current acquisition tube.

Sort layout counters not 
updating

Viewing sort layout for 
another tube

Open or create a sort layout for 
the current acquisition tube.

High sort conflict rate Event rate is too high for 
drop drive frequency

Decrease the event rate.

Gating conflict Verify the gating hierarchy.

Purity mask is too high Decrease the purity mask.

Sorting Troubleshooting (continued)
Observation Possible Causes Recommended Solutions
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Erratic sort rate Flow rate is too high Decrease the flow rate.

Unexpected sort results Incorrect drop delay Reset the drop delay. See 
Determining the Drop Delay – 
Manual Method on page 154.

Incorrect sort precision mode Verify that the sort precision mode 
is appropriate for your sorting 
requirements. See Sort Precision 
Modes on page 57.

Sweet Spot is off Keep the Sweet Spot on during 
sorting.

Drop 1 changed after setting 
drop delay

Reset the drop delay each time 
you change the Drop 1 value. See 
Determining the Drop Delay – 
Manual Method on page 154.

Laser delay changed after 
setting drop delay

Reset the drop delay each time 
you change the laser delay. See 
Determining the Drop Delay – 
Manual Method on page 154.

Incorrect logic in population 
hierarchy

Verify the gating strategy.

Sorting parent and child 
populations into two 
different tubes

If you try to sort a parent and its 
child population into two tubes, 
BD FACSDiva software ignores 
the child events in both tubes.

Create a new subset under the 
parent population consisting of 
NOT (child). Sort the child 
population into one tube and the 
NOT (child) population into 
another tube.

Sorting Troubleshooting (continued)
Observation Possible Causes Recommended Solutions
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Acquisition Troubleshooting
Observation Possible Causes Recommended Solutions

No events in plots after 
clicking Load or Acquire 
Data

Current tube pointer is not 
set to current tube

Click to move the current tube 
pointer to the appropriate tube.

Laser shutter is engaged Make sure the flow cell access 
door is completely closed.

Laser power is off Turn on the laser power.

Laser delay set incorrectly Adjust the laser delay settings. See 
Cytometer Quality Control Using 
BD FACSDiva Software on 
page 308.

Viewing plots for a different 
tube

Double-click the current tube in 
the Browser to display the plots 
for that tube.

Incorrect population(s) in 
plot

Right-click the plot and select 
Show Populations. Verify that the 
appropriate populations are 
displayed.

Uncolored events in plot • Format the plot to display all 
events.

• Assign a color to the population 
displayed in the plot.

• Verify the population drawing 
order.

Current cytometer 
configuration different from 
optical setup

Verify that the cytometer optics 
match the current cytometer 
configuration. 

No sample in the tube Add sample to the tube or install a 
new sample tube.
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No events in plots after 
clicking Acquire Data 
(continued)

Sample is not mixed properly Increase the sample agitation rate. 
See Sample Agitation on page 65.

Sample line is clogged Perform a sample line backflush. 
See Sample Line Backflush on 
page 184. If necessary, change the 
sample line. 

Sample filter is clogged Replace sample filter.

Threshold not set to the 
correct parameter (usually 
FSC)

Set the threshold to the correct 
parameter for your application. 

Multiple threshold 
parameters not set correctly

Verify that the correct Boolean 
logic (And/Or) was used for the 
threshold parameters.

Threshold channel too low or 
too high

Adjust the threshold channel. See 
Calculating Compensation on 
page 135.

Optical filter(s) not 
completely seated

Make sure the filters are pushed all 
the way in. 

FSC area scaling is incorrect Ensure that the FSC-H matches 
the FSC-A value.

No fluorescence signal Current cytometer 
configuration different from 
optical setup

Verify that the cytometer optics 
match the current cytometer 
configuration. 

Wrong filter installed or filter 
not completely seated

Make sure the appropriate filter is 
installed for each fluorochrome. 
Make sure the filters are pushed all 
the way in. 

Laser delay is set incorrectly Adjust the laser delay settings. See 
Cytometer Quality Control Using 
BD FACSDiva Software on 
page 308.

Acquisition Troubleshooting (continued)
Observation Possible Causes Recommended Solutions
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Low area signal Area scaling is too low Adjust area scaling for the 
corresponding laser. See 
Cytometer Quality Control Using 
BD FACSDiva Software on 
page 308.

Unexpected events in 
plot

Incorrect logic in population 
hierarchy

Verify the gating strategy.

Incorrect population(s) in 
plot 

Right-click the plot and select 
Show Populations. Verify that the 
appropriate populations are 
displayed.

Incorrect drawing order Verify that the required population 
is not hidden by another 
population. Right-click the plot 
and select Order Populations by 
Count.

Acquisition Troubleshooting (continued)
Observation Possible Causes Recommended Solutions
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Erratic event rate Sample aggregates Filter the sample.

Bulk injection O-ring is worn Contact your BD Biosciences 
service engineer.

Sample is contaminated Re-stain the sample, making sure 
the tube is clean.

Sheath tank low Fill the sheath container.

Unexpectedly high event 
rate

Threshold channel is too low Adjust the threshold channel. See 
Calculating Compensation on 
page 135.

Sample is too concentrated Dilute the sample. 

Flow rate is too high Decrease the flow rate in the 
Acquisition Dashboard. 

Bubbles in flow cell Turn off the stream, wait a few 
seconds, and turn on the stream 
again. 

Unexpectedly low event 
rate

Sample not adequately mixed Increase the sample agitation rate. 
See Sample Agitation on page 65.

Threshold channel is too high Adjust the threshold channel. See 
Calculating Compensation on 
page 135.

Sample is too dilute Concentrate the sample.

Sample line is clogged or 
kinked

Backflush the sample line. See 
Sample Line Backflush on 
page 184. If necessary, change the 
sample line.

Look for visible kinks in the line. 
If kinks are found, change the 
sample line. See Changing the 
Sample Lines on page 194.

Acquisition Troubleshooting (continued)
Observation Possible Causes Recommended Solutions
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Unexpectedly low event 
rate (continued)

Sample line installed 
incorrectly

Verify the sample line installation. 
See Changing the Sample Lines on 
page 194.

Sample aggregates Filter the sample.

Memory is full Compare the processed event rate 
in BD FACSDiva software with the 
threshold counter. If the event rate 
is much lower, exit and then 
restart the application.

Distorted populations or 
high CVs

Cytometer settings adjusted 
incorrectly

Optimize the scatter parameters. 
See Calculating Compensation on 
page 135.

Flow rate is too high Decrease the flow rate in the 
Acquisition Dashboard. 

Window extension is too low Increase the window extension.

Bubbles in flow cell Turn off the stream, wait a few 
seconds, and turn on the stream 
again. 

Nozzle is clogged or dirty Clean the nozzle as described in 
Changing the Integrated Nozzle on 
page 205.

Flow cell is dirty Clean the flow cell. See Cleaning 
the Flow Cell on page 176. Let DI 
water sit for 15 minutes before 
turning on the stream. Repeat as 
needed.

Poor sample preparation Repeat sample preparation.

Area scaling is too low Verify area scaling. See Adjusting 
Area Scaling and Laser Delay on 
page 310.

Acquisition Troubleshooting (continued)
Observation Possible Causes Recommended Solutions
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Excessive amount of 
debris in plots

Threshold channel is too low Increase the threshold channel. See 
Calculating Compensation on 
page 135.

Dead cells or debris in sample Examine the sample under a 
microscope.

Sample is contaminated Re-stain the sample, making sure 
the tube is clean.

High electronic abort 
rate (>10% of system 
event rate)

Window extension is too high Decrease the window extension.

Threshold channel is too low Increase the threshold channel.

Event rate is too high Decrease the flow rate in the 
Acquisition Dashboard. 

Sample is aggregated Filter the sample.

Sample is too concentrated Dilute the sample.

Fewer events than 
expected in gated 
population

Window extension set 
incorrectly

Adjust the window extension, if 
needed. See the BD FACSDiva 
Software Reference Manual for 
information.

Laser delay set incorrectly Adjust the laser delay settings. See 
Cytometer Quality Control Using 
BD FACSDiva Software on 
page 308.

Plot is zoomed Unzoom the plot or make the gate 
bigger.

Events left out of the gate When drawing a gate, make sure 
events on the axis are included.

Acquisition Troubleshooting (continued)
Observation Possible Causes Recommended Solutions
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Increasing threshold 
results in decreased area 
signal

Window extension is too low Slightly increase the window 
extension to maximize the area 
signal.

Increasing the window extension 
too much results in more 
electronic aborts or high CVs.

Area measurement off-
scale while the height 
measurement is on scale

Area scaling is too high Decrease area scaling to move the 
area measurement back on scale. If 
necessary, adjust area scaling to 
make the area measurement match 
the height measurement.

Cannot delete from 
Parameters, Threshold, 
Compensation, or Ratio 
tab views

Row not selected Select the row using the selection 
button.

Data already recorded Create a new tube.

Acquisition Troubleshooting (continued)
Observation Possible Causes Recommended Solutions
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Fluidics Troubleshooting
Observation Possible Causes Recommended Solutions

No fluid in line during 
system prime

Air lock in sheath or fluidics 
filter

Remove the filter for the 
corresponding fluid, install bypass 
tubing, and run Prime After Tank 
Refill. Repeat the priming 
procedure until you see fluid in 
the line.

When fluid is running through the 
line, remove the bypass tubing, 
install the filter, and repeat the 
priming procedure one last time.

Prepare for aseptic sort 
fails

Air lock in filter See previous recommendations.

Fluid line is detached Verify the fluid line connections 
on the fluidics cart and on the 
cytometer. Push firmly on each 
line to ensure it is connected.

Fluidics cart air flow 
<80 psi

Air leak Contact your BD Biosciences 
service engineer.

Fluidics cart air flow 
>100 psi

Regulator not adjusted 
properly

Contact your BD Biosciences 
service engineer.

Fluid leak under fluidics 
cart or below side door

Condensation from pressure 
relief valve

This is a normal phenomenon that 
occurs when water is condensed 
from room air. Condensation is 
greater in humid environments. To 
avoid slipping, wipe up any water 
daily.

Bleeder valve is open Check and close all bleeder valves 
for fluid and sheath filters. 

Broken fluid line Contact BD Biosciences.

Sample injection 
chamber does not close 
and causes a BISH or 
BISO error message

O-ring at bottom of sample 
injection chamber is dry and 
causing chamber to stick

Lubricate the O-ring and tube 
holder. See Lubricating the Sample 
Injection Chamber O-Ring on 
page 220.
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Electronics Troubleshooting
Observation Possible Causes Recommended Solutions

“Cytometer 
Disconnected” in 
Cytometer window

Cytometer power is off Turn on the cytometer main 
power.

Communication failure 
between workstation and 
cytometer

• Exit the software and then 
restart it. 

• If restarting does not work, 
reset the cytometer electronics: 
switch off the main power, wait 
10 seconds until the system is 
fully depressurized, and then 
switch the power back on. 

• Restart the computer and the 
cytometer. 

Ethernet cable between 
workstation and cytometer is 
disconnected

Unplug and then plug in the cable 
connectors and make sure they are 
secure. 

IP address changed Enter the correct IP address. Call 
BD Biosciences for assistance.

“Master DAQ 
Overflow” in 
Cytometer window

Event rate is too high Decrease the event rate or verify 
the threshold.

Dirty flow cell Clean the flow cell. See Cleaning 
the Flow Cell on page 176.

“Cytometer not 
responding” in Status 
tab

Unknown Perform the suggestions for a 
communication failure, above.
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8

Technical Specifications

• Cytometer Specifications on page 248

• Fluidics Cart Specifications on page 254
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Cytometer Specifications 

Table 8-1  Cytometer specifications

Cytometer dimensions Height: 71 cm (28 in.)

Width: 122 cm (48 in.)

Depth: 71 cm (28 in.)

Table (optional) Height: 85.1 cm (33.5 in.)

Width: 266.7 cm (105 in.)

Depth: 134.6 cm (53 in.)

Weight Approximately 181.4 kg (400 lb.)

Power requirements 100/115/230 VAC and 50 or 60 Hz

Power consumption (maximum) 1,500 watts
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Environment

Performance 

Table 8-2  Required operating conditions

Storage temperature 1–40°C (34–104°F)

Operating temperature 15–30°C (59–86°F)

Operating relative humidity 5–80% (noncondensing)

Noise level Less than or equal to 62 dBA

Facilities No special room requirements

Table 8-3  Performance specifications

Fluorescence resolution Coefficient of variation PI–Area of <3.0%, 
full G0/G1 peak for propidium iodide (PI)-
stained chicken erythrocyte nuclei (CEN)

Coefficient of variation Hoechst–Area of 
<3.5%, full G0/G1 peak for Hoechst-stained 
CEN

Fluorescence linearity Doublet/singlets ratio for CEN stained with 
PI = 1.95–2.05 detected off the 488-nm laser 
or Hoechst = 1.95–2.05 detected off the 405-
nm laser or 375-nm laser

Forward and side scatter sensitivity Sensitivity enables separation of fixed 
platelets from noise, identification of 
bacteria, and 0.5-micron beads.

Sample acquisition rate Maximum acquisition rate: 70,000 events 
per second with 8 parameters, 12 
compensation pairs. Maximum rate <70,000 
events per second with more parameters, 
>100,000 events per second with fewer 
parameters.
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Sort Performance

Table 8-4  Sort performance specifications

Drop drive frequency Range from 1 to 100,000 Hz

Purity and yield At 70 psi and 90 kHz with an average 
threshold rate of 25,000 events per second 
for a four-way sort results in a purity of 
>98% and a yield >80% of Poisson’s 
expected yield.

Viability Sorts were performed at a variety of sheath 
pressures using cell lines and human 
peripheral blood mononuclear cells. All sorts 
resulted in cells that proved viable and 
proliferated for several days post-sort.

Sort collection devices Two-way sorting into the following sample 
tube collection devices: 12 × 75-mm tubes 
and 15-mL tubes

Four-way sorting into the following sample 
tube collection devices: microtubes, 12 × 75-
mm tubes, and 1.5-mL Eppendorf tubes

Automatic Cell Deposition Unit (ACDU) 
option allows for slide and plate sorting into 
6, 24, 48, 96, and 384-well plates

Sample collection cooling Water recirculator for refrigeration/heating 
(optional)

BD FACS Accudrop 633-nm red-diode laser provided for quick 
drop-delay

Automatic drop determination in software
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Excitation Optics 

Laser Specifications

The following class 3B lasers are mounted on the cytometer.

NOTE For specifications on the Near UV laser (375 nm), see Specifications on 
page 267.

Table 8-5  Laser specifications

 Manufacturer Model
Wavelength 

(nm)
Power 
(mW)a

a. Measured out of fiber optic cable

Ex
ci

ta
ti

on
La

se
rs

Coherent® Sapphire™ 488-20 488 13

JDS Uniphase™ 1144-P 633 11

Point Source™ iFlex 2000™-P-1-405-
0.65-10

405 30

Ill
um

in
at

io
n

La
se

r

StokerYale/Lasiris SNF-701L-660-35-1 deg 
single-line laser

660 35
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Emission Optics 

Table 8-6  Emission optics specifications

Optical coupling Quartz cuvette flow cell is gel-coupled by refractive 
index-matching optical gel to the fluorescence 
objective lens for optimal collection efficiency.

Numerical aperture is equal to 1.2.

Forward scatter detector and 
filters

Photodiode detector with a 488/10 bandpass filter

Side scatter detector Photomultiplier with 488/10 bandpass

Fluorescence detectors and filters Three fixed fiber apertures (200-micron separation)

Detector Arrays 

Table 8-7  Default setup for detector arrays  

Detector Array 
(Laser)

PMT LP Mirror BP Filter Intended Fluorochrome or Dye

Octagon 
(488-nm blue 
laser)

A 735 780/60 PE-Cy™7

B 655 695/40
675/20

PerCP-Cy5.5™ or PI
PerCP, PE-Cy5

C 610 616/23 PE-Texas Red®

D 556 585/42 PE or PI

E 502 530/30 FITC, GFP, Alexa 488

F — 488/10a Side scatter (SSC)

Trigon 
(633-nm red 
laser)

A 735 780/60 APC-Cy7, APC-H7

B — 660/20 APC
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Trigon 
(405-nm violet 
laser)

A 502 530/30 Alexa Fluor® 430/Am Cyan

B — 450/40 Cascade Blue®, Pacific Blue™, 
DAPI, Hoechst, 
Alexa Fluor® 405

a. The optical holder for the 488/10 BP filter also includes a 1.0 ND filter.

Detector Arrays 

Table 8-7  Default setup for detector arrays (continued) 

Detector Array 
(Laser)

PMT LP Mirror BP Filter Intended Fluorochrome or Dye
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Fluidics Cart Specifications 

Table 8-8  Fluidics cart specifications

Dimensions Height: 66 cm (26 in.)

Width: 81cm (32 in.)

Depth: 66 cm (26 in.)

Weight 81.7 kg (180 lb.) fluidics cart only, excluding tanks

Facilities No air supply or vacuum required.

(Optional) Can be connected to facility air supply

Containers • One 10-L stainless steel sheath tank

• One 5-L stainless steel ethanol shutdown tank

• One 10-L plastic waste container

• Three 5-L plastic fluid containers, for bleach, DI 
water, and ethanol
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Appendix A

Supplies and Consumables

This appendix provides a list of supplies and options that are available for the 
BD FACSAria II cytometer. 

• To order spare parts and consumables from BD Biosciences from within the 
US, call (877) 232-8995 or go to bdbiosciences.com.

Outside the US, contact your local BD Biosciences representative.

• To order cytometer options, contact your sales representative.

This information is correct at the time of publication. For up-to-date 
information, see our website (bdbiosciences.com).

• Cytometer Supplies on page 256

• Consumables on page 261

http://www.bdbiosciences.com/home/
http://www.bdbiosciences.com
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Cytometer Supplies

Optical Components

The following filters and mirrors are mounted on the BD FACSAria II cytometer. 
Use these part numbers if you need to order any replacement components. See 
Using Custom Optical Filters on page 222 for instructions.

Detector Array 
(Laser)

PMT
LP Mirror
BP Filter

Replacement 
Part No.

Intended Dye

Octagon 
(488-nm blue laser)

A 735 343787

780/60 343788 PE-Cy7

B 655 343789

695/40 343790 PerCP-Cy5.5 or PI

675/20 343791 PerCP

C 610 640879

616/23 640880 PE-Texas Red®

D 556 343794

585/42 343796 PE or PI

E 502 343797

530/30 343798 FITC

F 488/10 343799 SSC

 1.0 ND 
filter

53-10057-01

Trigon 
(633-nm red laser)

A 735 343787

780/60 343788 APC-Cy7 

B 660/20 343800 APC
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The following filters and mirrors are provided with the violet-laser option.

The FSC photodiode is provided with a 1.0 ND filter. Other filters are available 
as options. Use the following part numbers to replace the filter.

To order a filter holder, use the following part numbers. 

Detector Array
(Laser)

PMT
LP Mirror
BP Filter

Replacement 
Part No.

Intended Dye

Trigon
(405-nm violet laser)

A 502 343797

530/30 343798 Alexa Fluor® 430

B 450/40 343801 Cascade Blue®, 
Pacific Blue™, 
Hoechst, DAPI, 

Alexa Fluor® 405

Detector ND Filter
Replacement 

Part No.

FSC photodiode 0.5 33710407

1.0 33710807

1.5 338651

2.0 338652

Holder Part No.

Mirror holder 336103

Mirror retainer 345662

Mirror backup spring 344979

Filter holder 336102

Filter retainer 333830
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Accessory Kit

The cytometer is shipped with an accessory kit containing the following items. 
Use these part numbers if you need to order any replacements.

Item Part No.

1-mL microtube holder 333457

12 x 75-mm test tube holder 333456

15-mL centrifuge tube holder 333430

Four-way 1.5-mL Eppendorf collection tube holder 644349

Four-way 12 x 75-mm collection tube holder 641454

Two-way 12 x 75-mm collection tube holder 641613

Two-way 15-mL collection tube holder 641612

Universal top section for collection tube holders 644353

O-ring for collection-tube holder (3) 337897

Integrated nozzles:

• 70 micron

• 85 micron

• 100 micron

• 130 micron (not included - can be ordered as an 
option)

• Closed-loop

643940

643941

643942

643943

644395

Nozzle locking lever (spring and plunger included) 643686

Standard nozzle O-rings 333084

Magnifying glass 337599

Sample injection tubing (12-inch lengths) 641059

Sample injection tubing (7-inch lengths) 641475

Ferrule 335108
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Ferrule-removal tool 335690

Collet 19-66455-00

Collet nut 19-66456-00

Pinch valve tubing 641900

Sample line filters (35 micron) 643152

Sample line filters (50 micron) 643153

Sheath fluid filter (also used for ethanol shutdown tank 
filter)

331394

Fluid filter (for DI water, bleach, and ethanol tanks) 643687

Air filter, inline, 3 micron 641913

Disposable waste tank caps (pack of 12) 338854

Cap for 5-L container (5) 335916

Lubricant for O-rings 347306

O-ring pick tool 331430

Deflection plate removal tool 643197

Allen wrench set 98-10004-00

Wrench, 11/16-inch, for sheath probe 646889

Adapter tray for microscope slides 335630

Power cords:

• Main power cord

• Cordset for continental Europe

• Cordset for UK

• Cordset for Australia/Asia

• 333694

• 334140

• 334141

• 334175

Item Part No.



260 BD FACSAria II User’s Guide   

Other Replacement Parts 

The following items are not included in the accessory kit, but you can use the 
indicated part numbers to order spare or replacement parts.

Item Part No.

Autoclavable 10-L container 340261

Auxiliary 5-L container 333504

Sheath sensor probe 642012

Waste sensor probe (6-level) 334915

Auxiliary sensor probe (non-ethanol) 343835

Auxiliary sensor probe (ethanol) 642874

Air filter for cabinet (side door) 334351

Air filter for ACDU cabinet (set of 3) 334821

ULPA filter and tubing replacement kit 
(set of 3, for use with the AMO)

334822

Four-way 1-mL collection tube holder 641614
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Consumables

Cytometer Setup Particles

Particle Supplier Catalog No.

BD Calibrite™ beads BD Biosciences

• Two-color kit
(unlabeled, FITC, PE)

• 349502

• Three-color kit
(unlabeled, FITC, PE, PerCP)

• 340486

• PerCP beads • 340497

• PerCP-Cy5.5 beads • 345036

• APC beads • 340487

Fluoresbrite® Yellow-Green 2-µm beads 
(for the 405-nm laser)

Polysciences Inc.
(800) 523-2575

18604

SPHERO Rainbow Calibration 
Particles, 3.0–3.4 μm

BD Biosciences • 559123 
(8 peaks)

• 556286

• 556291
(brightest 
peak in 
556286)

BD FACS Accudrop beads BD Biosciences 345249

BD Cytometer Setup and Tracking 
(CS&T) beads

BD Biosciences 641319 
(1 vial)
642412
(3 vials)
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Reagents 

Reagent Supplier Catalog No.

BD FACSFlow sheath fluid BD Biosciences 340398
(US and Latin 

America)

342003
(other countries)

BD™ FACSRinse detergent BD Biosciences 340346

BD FACSClean solution BD Biosciences 340345

Ethanol Various –

Chlorine bleach (5% sodium 
hypochlorite)

Clorox® or other major supplier 
(to ensure that the bleach is at the 
correct concentration and free of 
particulate matter)

–

Monoclonal antibodies BD Biosciences –a

a. See the BD Biosciences Immunocytometry Products Catalog or the BD Biosciences website 
(bdbiosciences.com).

Dyes and fluorochromes Molecular Probes
(800) 438-2209

Sigma
(800) 325-3010

–

BD FACS™ lysing solutionb

b. US Patent Nos. 4,654,312; 4,902,613; 5,098,849

BD Biosciences 349202
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Labware 

Item Supplier Catalog No.

1-mL microtubes Bio-Rad Laboratories
(800) 424-6723

223-9391 
(1,000 per box)

1.5-mL Eppendorf tubes Various –

5-mL polystyrene test tubes, 
12 x 75-mm (BD Falcon™)

• Uncapped, 125 per bag

• Capped, 125 per bag

• Capped, 25 per bag

• With cell-strainer cap, 
25 per bag

BD Biosciences

• 352052 

• 352054

• 352058

• 352235

15-mL conical centrifuge tubes 
(BD Falcon)

• Polypropylene, 50/bag

• Polypropylene, 125/bag

• Polypropylene, 50/rack

• Polystyrene, 125/bag

• Polystyrene, 50/rack

BD Biosciences

• 352196

• 352096

• 352097

• 352095

• 352099
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Appendix B

Near UV Laser Option

The Near UV laser option for the BD FACSAria II system features a 375 nm, 
solid state laser that enables sorting and analysis of side populations. This Near 
UV laser uses the same emission pathways as the violet laser option, and the laser 
alignment is fixed and requires no adjustments once it is installed. 

The Near UV laser can be added at the factory as an option on a new instrument, 
or it can be installed by a BD Field Service Engineer into an existing system in the 
field.

Figure B-1  BD FACSAria II system with Near UV laser installed

375 nm Near UV laser
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System Laser Configurations 

The BD FACSAria II systems can be configured as two-laser, three-laser, or four-
laser systems. See Table B-1 for the system configurations. See Figure B-2 for an 
illustration of the laser power toggle switch on a four-laser system.

NOTE In a four-laser system, you can use either the violet or the Near UV laser, 
but you cannot use them at the same time.

Figure B-2  Violet/Near UV laser toggle switch

Table B-1  BD FACSAria II laser configurations 

System Configuration
Blue Laser 
(488 nm)

Red Laser 
(633 nm)

Violet Laser 
(405 nm)

Near UV 
Laser (375 
nm)

Two-laser Yes Yes No No

Three-laser (with Violet) Yes Yes Yes No

Three-laser (with Near UV) Yes Yes No Yes

Four-laser Yes Yes Yes Yes
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Specifications 

Safety

Make sure that everyone working with the system with the Near UV laser 
installed is familiar with safety details in the BD FACSAria II Safety and 
Limitations Manual.

Laser
Nominal 
Wavelength (nm)

Power (mW)

Near UV laser 375 7



268 BD FACSAria II User’s Guide   

Operation

Selecting Optical Filters 

When using the Near UV laser for side population studies, you can install a 
different set of filters in the far-left trigon. The filter set is supplied with the 
system when the Near UV option is installed. This set is optimized for side 
population stem cell applications. See Table B-2 for the part numbers and 
intended dyes and Figure B-3 for the locations in the trigon. 

Figure B-3  Trigon with Near UV filters installed for side population studies

Table B-2  Part numbers for filters for Near UV trigon 

Detector Array
(Laser)

PMT
LP Mirror
BP Filter

Replacement 
Part No.

Intended Dye

Trigon (375 nm 
Near UV laser)

A 610 LP 640879 Hoechst-Red, PI

670 LP 642328

B 450/20 642329 Hoechst-Blue, DAPI, 
Pacific Blue™, 
Cascade Blue®

A
C

B

450/20

670

610



 Appendix B: Near UV Laser Option 269

Creating a Custom Configuration 

The Near UV laser uses the same PMT detectors as the violet laser, but typically 
with different filters installed for optimizing side population studies. We 
recommend that you set up a custom configuration for the Near UV laser in BD 
FACSDiva software using the CS&T application. See Figure B-4.

Figure B-4  Three-laser system configuration with Near UV laser
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Switching From the Violet to the Near UV Laser

The system should be turned on and all cytometer startup procedures performed 
before using the Near UV laser. See Cytometer Startup on page 100 for 
information on these procedures. This section provides an overview of the steps 
involved in switching to the Near UV laser in a four-laser system.

1 Place the Near UV/OFF/Violet laser switch in the Near UV position.

This turns on the Near UV laser and turns off the violet laser. Allow the 
Near UV laser to warm up for 30 minutes before recording data.

2 Set the cytometer configuration to a custom configuration that includes 
parameters for the Near UV laser.

It is a good practice to include Near UV in the configuration name, for 
example, 70-70 Near UV. This is especially helpful in a four-laser system. 

3 Ensure that the appropriate optical filters for Near UV operation are 
installed into the far-left trigon. See Figure B-3 on page 268. 

4 Make sure the cytometer has a valid performance check or perform QC. 

You are now ready to set up and perform your experiment using the Near UV 
laser.

Verify that the custom configuration contains the correct parameters for use 
with the Near UV laser. The system will not perform correctly if this is not 
done.
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Switching Back to the Violet Laser

NOTE Depending on the application, the filters for the standard violet laser can 
also be used with the Near UV laser.

This section provides an overview of the main steps.

1 Place the UV/Off/Violet laser switch in the Violet position. 

This turns off the Near UV laser and turns on the violet laser. Allow the 
violet laser to warm up for 30 minutes before recording data.

2 Set the cytometer configuration to a configuration with violet laser 
parameters.

3 Install the correct optical filters the violet laser in the far-left trigon. 

4 Make sure the cytometer has a valid performance check or perform QC. 

Verify the configuration contains the correct parameters for use with the 
violet laser. The system will not perform correctly if this is not done.

Detector Array
(Laser)

PMT
LP Mirror
BP Filter

Replacement 
Part No.

Intended Dye

Trigon
(405-nm violet 
laser)

A 502 343797 Alexa Fluor® 430

530/30 343798

B 450/40 343801 Cascade Blue®, 
Pacific Blue™, 
Hoechst, DAPI, 

Alexa Fluor® 405
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Side Population Application Guidelines 

The Near UV laser on the BD FACSAria II cytometer is very effective for use in 
applications involving side population (SP) studies. See Figure B-5 on page 273 
for a typical plot from a side population experiment.

Instrument Setup

1 Turn on Near UV laser and allow it to warm up for 30 minutes.

2 Make sure the cytometer configuration is set to a configuration with Near 
UV parameters. 

3 Ensure that the side population filter set is in the Near UV (far-left) trigon. 

Place the 670 LP filter (Hoechst Red) in detector A with 610 LP mirror in 
front. Place the 450/20 filter (Hoechst Blue) in detector B. See Figure B-3 
on page 268.

4 Make sure the cytometer has a valid performance check or perform QC.

Experiment Setup Tips

1 Set the parameters to linear in the experiment.

2 Create a Hoechst Red vs Hoechst Blue dot plot. 

3 Add a FSC vs PI dot plot if you want to discriminate dead cells from viable 
ones.

4 Set the sample temperature to 4°C by selecting Cytometer > Sample 
Temperature.

5 Set the sample flow rate to as low as possible to achieve the best CVs.

Sample concentration should be between 1 and 2 million cells per mL of 
buffer.
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6 Adjust the voltages so that the red blood cells are seen in the lower left 
corner and the dead cells line up on the vertical line to the far right. 

7 The bulk of the rest of the cells can be centered. It should be possible to 
identify a major G0/G1 population with S/G2.

8 Collect a file of 50,000 to 100,000 of live gated events. 

SP prevalence is ~0.02 to 0.05% of total.

9 If sorting, sort into tubes/plate containing small volume of DMEM 
containing 10% FBS and 10 mmol HEPES. Keep sample chilled at 4°C. 

; Tip     Sort rare event samples into polypropylene tubes. Avoid polystyrene 
tubes.

Figure B-5  Typical plot from side population experiment
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Troubleshooting 

Observation Possible Causes Recommended Solutions

Signals dim or noisy Wrong laser turned on 
(Near UV instead of violet, 
or vice-versa).

Turn laser power switch to 
correct position.

Laser delay set incorrectly 
(possible holdover from 
setting on other laser).

Recalibrate laser delay.

No signal Laser shutter closed 
(presumably because flow 
cell access door is open). 

Close flow cell access door.

Laser power switch set to 
OFF. 

Turn switch to Near UV.

Laser power switch set to 
violet laser instead of Near 
UV.

Turn switch to Near UV.

No signals for side 
population 
application

Wrong filters installed. Install filters for side 
population application.



275

Appendix C

BD Aerosol Management Option

The BD aerosol management option (AMO) is a device that uses an attached 
vacuum source to rapidly evacuate aerosolized particles through an ultra-low 
penetrating air filter during routine sorting or analysis. 

The following topics are described in this guide:

• Option Components on page 276

• Operating the BD Aerosol Management Option on page 278

• Maintenance on page 283

• Troubleshooting on page 290

• Specifications on page 293
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Option Components

The BD Aerosol Management Option (AMO) includes the following:

• An evacuator to generate negative pressure

• An ultra-low penetrating air (ULPA) filter to trap particles, with attached 
tubing that connects the evacuator to the instrument

• An air filter for the sort collection chamber door

• A hinged cover on the sample injection chamber

The AMO also requires the splash shield in the BD FACSAria II accessory kit.

The BD Aerosol Management Option is For Research Use Only. It is not for use 
in diagnostic or therapeutic procedures.

Evacuator

The evacuator holds the ULPA filter and attached tubing. Air flow is controlled 
using pushbuttons within a membrane panel on the front of the unit. The 
evacuator sits on castor wheels for easy maneuverability. It can be moved using 
the handle attached to the unit. See Figure C-1 on page 277.

The BD Aerosol Management Option does not eliminate the health risks of 
working with biohazardous material and must be used in conjunction with 
good laboratory practice.
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Figure C-1  AMO evacuator

ULPA Filter

The ULPA filter used in the BD AMO captures and retains 99.9995% of all 
particles down to and including particles 0.12 microns in size, according to the 
manufacturer’s specifications. 

Figure C-2  ULPA filter

Membrane

Tubing

Handle

Flow gauge

ULPA filter

Filter hold-down

panel
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Operating the BD Aerosol Management Option

Starting Up the Evacuator

Before starting up the evacuator, make sure that the ULPA filter is completely 
seated against the bottom of the evacuator filter well, and that the tubing is 
securely attached to the filter and instrument manifold. 

To start up the evacuator:

1 Install the splash shield or the tube holder below the aspirator drawer 
(Figure C-3 on page 279).

The splash shield is required for sorting into a multiwell plate or onto a 
slide. 

To install the splash shield:

a Close the sort block door and open the sort collection chamber door, if 
needed. (The sort block door must be closed in order to open the 
collection chamber door.)

b Remove the tube holder, if one is installed.

c Insert the splash shield into the slotted fittings below the sort aspirator 
drawer. (See Figure C-3 on page 279.) Push the splash shield all the 
way in.

Any instrument surface that comes in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when handling 
instrument hardware. Wear suitable protective clothing and gloves.
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Figure C-3  Installing the splash shield

2 Ensure that an air filter is installed in the sort collection chamber door.

The filter traps airborne dust that could clog the ULPA filter. Note that the 
filter should be changed on a monthly basis. See Replacing the Air Filter on 
page 288.

3 Close the sort collection chamber door.

NOTE The sort collection chamber door must be closed for the evacuator 
to generate negative pressure in the chamber.

Air filter
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4 Switch on the main power on the back of the evacuator (Figure C-4 on 
page 280).

Figure C-4  Turning on main power

5 Press the power button on the membrane panel of the evacuator. 

6 Press the up or down arrow button to set the suction control rate to 20%. 

Each time either arrow button is pressed, the suction will increase or 
decrease by 10%. When two lights are lit on the suction control indicator, 
the actual air flow is the value between the two illuminated percentages. 

7 Verify that the filter flow gauge reads less than 2.4 inches of H2O 
(Figure C-5 on page 281).

For a new filter, the gauge should read 1.1–1.4 inches of H2O. As the filter 
is used, the reading will increase. If the gauge reads 2.4 inches of H2O or 
greater, replace the filter. See Replacing the ULPA Filter on page 284.

Do not set the suction control rate above 20%. Higher rates could affect 
the stability of the side streams.

Main power

Power button
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Figure C-5  Reading the filter flow gauge

Setting Up for Sorting

To get set up for sorting:

1 Start up the flow cytometer system. See Cytometer Startup on page 100.

2 Start up the evacuator as described in Starting Up the Evacuator on 
page 278. 

3 Follow the standard sort setup procedure. See Setting Up for Sorting on 
page 150.

NOTE Always start up the evacuator before setting up for sorting. If you 
start up the evacuator after sort setup is complete, you will need to repeat 
the setup procedure.

New filter Used filter
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Opening the Sort Collection Chamber Door 

1 Use one of the following options to stop sample flow into the sort 
collection chamber:

• Click the Move Drawer button to close the aspirator drawer and sort 
sample into waste.

• Click the Acquire button to stop sample acquisition without unloading 
the sample tube.

• Click Unload to stop acquisition and unload the sample tube.

2 Press the up arrow button repeatedly to increase the suction to 100%.

3 Wait at least 30 seconds before opening the sort chamber doors to allow 
potentially hazardous aerosols to evacuate.

4 Place the system in standby by pressing the power button on the membrane 
panel of the evacuator.

5 Open the sort collection chamber door.

; Tip     Remember to decrease the suction control rate to 20% when you return to 
sorting samples.

Cell sorters that use droplet generation methods, like the BD FACSAria II, 
can produce aerosols around the sample stream. When acquiring 
biohazardous samples, follow universal precautions at all times. Keep the 
sort block door and the sort collection chamber door closed during sorting. 
Follow these steps to stop sample flow and evacuate potential aerosols 
before opening the sort collection chamber door.
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Turning Off the Evacuator

Turn off the evacuator after you have finished running biohazardous samples.

1 Place the system in standby by pressing the power button on the membrane 
panel of the evacuator.

2 Switch off the main power on the back of the evacuator (Figure C-4 on 
page 280).

Maintenance 

Use the following guidelines to ensure optimal performance of the BD Aerosol 
Management Option.

• Change the ULPA filter and attached tubing when the flow gauge indicator 
is >2.4 at a 20% flow setting or when the red filter-life indicator LED is 
blinking. See Replacing the ULPA Filter on page 284.

Two spare filters and replacement tubing are included with the AMO. To 
order additional replacement kits, contact your local BD Biosciences 
representative. 

• Change the air filter in the sort collection chamber door on a monthly 
basis. The filter traps airborne dust that could clog the ULPA filter. Regular 
replacement of the air filter will extend the life of your ULPA filter. See 
Replacing the Air Filter on page 288.

• Do not touch the Filter Life Reset button during normal operation. Doing 
so could shut down the evacuator and prevent the collection of aerosols.

All biological specimens and materials coming into contact with them can 
transmit potentially fatal disease. Handle the ULPA filter and attached 
tubing as if capable of transmitting infection. Dispose of waste using proper 
precautions and in accordance with local regulations. Wear suitable 
protective clothing, eyewear, and gloves.
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• Do not disconnect the tubing from the instrument manifold outlet or the 
ULPA filter unless you are changing the filter. Repeated removal and 
reattachment of the tubing could loosen the connection and disrupt airflow. 

• To ensure optimal airflow, keep the tubing free of kinks and away from 
sharp or heavy objects. Do not crush or puncture the tubing. Ensure that 
the tubing is securely attached at both ends before turning on the evacuator 
power.

• Keep the sort collection chamber free of potentially obstructive debris, such 
as Kimwipes® or disposable pipettes.

Replacing the ULPA Filter

Replace the filter when either of the following conditions occur:

• The filter-flow gauge reads 2.4 inches of H2O or greater at 20% suction.

• The red filter-life indicator LED is blinking. 

NOTE When the red light turns on and is not blinking, you have approximately 
1 hour of filter life remaining. If the red light comes on during sorting, the filter 
will not stop working. Replace the filter as soon as possible when the red light 
starts blinking.

To replace the ULPA filter:

1 Turn off the evacuator main power and disconnect the electrical plug. 

2 Disconnect the tubing from the manifold (Figure C-6 on page 285).

The manifold is located in the connection panel on the left side of the 
instrument.

To prevent potential shock, always turn off the evacuator main power and 
disconnect the electrical plug from the power source before installing or 
removing any filter.
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Figure C-6  Disconnecting tubing (side of instrument)

3 Remove the spring-loaded filter hold-down.

While pushing down on the filter, pull up on the spring-loaded handle 
(Figure C-7A), and guide the handle over the top of the filter and behind 
the metal plate in the back of the evacuator (Figure C-7B). 

Figure C-7  Removing the filter hold-down

A B

Metal 
plate
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4 Lift off the ULPA filter and attached tubing from the evacuator and dispose 
of both the filter and the tubing. 

5 Insert the new ULPA filter into the evacuator filter well (Figure C-8). 

Figure C-8  Inserting the new filter

All biological specimens and materials coming into contact with them can 
transmit potentially fatal disease. Handle the ULPA filter, attached tubing, 
and all instrument hardware as if capable of transmitting infection. Dispose 
of waste using proper precautions and in accordance with local regulations. 
Wear suitable protective clothing, eyewear, and gloves.
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6 Push down on the filter to ensure that it is seated against the bottom of the 
filter chamber (Figure C-9 on page 287). 

Figure C-9  Seating the new filter

NOTE For optimal evacuation of aerosols, the filter must be completely 
seated in the evacuator filter well.

7 Lift the spring-loaded filter hold-down and place it on top of the filter.

8 Press and hold the Filter Life Reset button on the membrane panel for 
5–10 seconds. 

The green and amber LED lights will turn off, and then on. Hold down the 
button until the 100% indicator light is lit. This resets the 180-hour filter-
life clock.

Reset button
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9 Connect one end of the replacement tubing to the ULPA filter, and the 
other end to the tubing manifold (Figure C-10 on page 288).

Figure C-10  Connecting new tubing

NOTE For optimal evacuation of aerosols, ensure that the tubing is 
securely connected at both ends.

10 Connect the evacuator power plug to the power source.

Replacing the Air Filter

To extend the life of your ULPA filter, we recommend that you replace the air 
filter on a monthly basis. The filter traps airborne dust that could clog the ULPA 
filter. Regular replacement of the air filter will extend the life of your ULPA filter.

1 Open the sort collection chamber door and remove the air filter.
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Push the filter toward the left side of the door until you can grasp it, and 
then slide the filter out of the door.

Figure C-11  Removing the air filter

2 Install a new air filter in the door.

Slide the new filter in from the left. 

NOTE Make sure to install the filter with the grid side facing up when the 
door is open.

Grid side (faces up when door open) Non-grid side (faces out when door closed)
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Troubleshooting 

The tips in this section are provided to help you troubleshoot issues that arise 
when using the BD Aerosol Management Option. For cytometer-specific 
troubleshooting, see Troubleshooting on page 225.

If additional assistance is required, contact your local BD Biosciences technical 
support representative or supplier. 

If any of the following are observed, assume the AMO is not evacuating 
properly, and do not open the doors to the sort chamber.

Control Panel Troubleshooting

Observation Possible Cause Recommended Solution

Evacuator indicator 
lights off

Evacuator power cord 
unplugged

Connect the evacuator power 
cord to the power source.

Evacuator power 
switched off 

Switch on the evacuator main 
power. See Figure C-4 on 
page 280.

Evacuator motor failure Contact your local BD technical 
support representative.

Circuit breaker tripped Depress the circuit breaker on the 
rear of the evacuator into its 
original position.

Site power failure Turn off the evacuator power 
switch and wait for site power to 
be restored.

Evacuator indicator 
lights pulsing

Erratic power source Plug the power cord into a 
different outlet.
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Arrow keys not 
responding

Improper operation Push each button firmly before 
removing your finger from the 
control.

Defective membrane panel Contact your local BD technical 
support representative.

Red filter-life 
indicator light on

Approaching 180 hours of 
filter use

Monitor the light. When it 
blinks, change the filter.

Filter life not reset after 
filter change

After changing the filter, press 
and hold the Filter Life Reset 
button until the 100% indicator 
light is lit.

Red filter-life 
indicator blinking

Filter used over 180 hours Replace the filter.

Control Panel Troubleshooting (continued)

Observation Possible Cause Recommended Solution
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Filter Flow Gauge Troubleshooting

Observation Possible Cause Recommended Solution

Zero reading on 
filter flow gauge

Power off Press the power button on the 
membrane panel of the evacuator. 

Filter defective Replace the filter.

Filter improperly seated in 
evacuator

Reseat the filter with the 
evacuator power off.

Tubing loose or 
not connected

Ensure that the tubing is securely 
connected below the sort 
chamber and to the filter module.

Tubing kinked or damaged Inspect the tubing for kinks or 
punctures. Replace the tubing, if 
needed.

Wrong tubing type or part Ensure that the correct type of 
tubing is in use.

Erratic reading on 
filter flow gauge

Defective filter Replace the filter.

Filter improperly seated in 
evacuator

Reseat the filter with the 
evacuator power off.

Off-scale reading on 
filter flow gauge

Tubing or sort collection 
chamber obstructed

• Inspect the tubing for kinks or 
punctures. Replace the tubing, 
if needed.

• Check for obstructions in the 
sort collection chamber. 
Remove any obstruction.

Filter clogged or saturated Replace the filter as described on 
page 284.
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Specifications 

Specifications for the BD Aerosol Management Option are as follows.

Evacuator

• Greater than or equal to 7 CFM (ft3/min) normal operation rate (20% 
suction control)

• Greater than or equal to 30 CFM boost evacuation (100% suction control)

• <35 lb unpacked weight 

ULPA Filter Module

• VLSI grade

• Traps particles greater than or equal to 0.12 µm

• Three-stage filtration (pre-filter, ULPA, post filter)

• Particulate removal efficiency >99.9995%

Air Filter

• Filter media is an open-cell polyurethane foam

• Media specially coated for improved fire-retardation and fungi resistance

• High dust-trapping capacity, low air resistance

• Can be used in a wide variety of climatic conditions

• Rated UL 94 HF-1
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Appendix D

Temperature Control Option

The BD™ temperature control option can be used to control the temperature of 
sorted samples in the BD FACSAria II flow cytometer. 

The following topics are described in this guide:

• Option Components on page 296

• Using the BD Temperature Control Option on page 297

• Maintenance on page 304

• Specifications on page 305
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Option Components 

The BD temperature control option includes the following:

• A recirculating water bath

• Specially designed collection tube holders with ports for recirculating water

Tube holders are available in these styles: two-way 15-mL, four-way 12 x 
75-mm, and four-way 1.5 mL Eppendorf tubes. See Figure D-1.

Figure D-1  Temperature control option components

Two-way 15-mL

Four-way 12 x 
75-mm

Four-way 1.5-mL 
Eppendorf

Water bath
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The BD temperature control option is For Research Use Only. It is not for use in 
diagnostic or therapeutic procedures.

Using the BD Temperature Control Option

Note that before you start the recirculating water bath, you must attach the 
tubing to the appropriate collection device.

Setting Up the Water Bath

1 Remove the threaded plug from the output port on the water bath.

2 Ensure that the drain cock on the back of the water bath is closed by 
turning it fully clockwise.

3 Set the pump outflow to maximum by turning the knob fully counter-
clockwise.

Remove the top cover to access the knob, which is located inside the water 
bath towards the back. See the operating instructions supplied with water 
bath for additional details on this process. This is referred to as position 1.

4 Connect the clear tubing end of the insulated hoses to the input and output 
ports on the water bath. (See Figure D-2 on page 298.)

Slide the tubing over the hose barbs and twist gently while installing to get 
the tubing completely over the barbs. 

When acquiring biohazardous samples, follow universal precautions at all 
times. Keep the sort block door and the sort collection chamber door closed 
during sorting. We recommend that you use the BD Aerosol Management 
Option when sorting biohazardous samples into the temperature control 
tube holders.
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Figure D-2  Input and output ports on water bath

5 Connect the insulated hoses from the recirculating water bath to the 
cytometer control panel.

NOTE Make sure you match the flow direction from the water bath port 
to the flow direction on the instrument manifold. The instrument ports are 
labeled cooling in and cooling out.

Figure D-3  Connections for temperature control option

6 Fill the water bath with distilled water containing 0.1 g/L sodium 
carbonate.

Sodium carbonate helps reduce corrosion. See the water bath 
manufacturer’s documentation for fill levels and other setup information.

NOTE BD Biosciences does not recommend using ethylene glycol 
(antifreeze) in the water bath.

Cooling outCooling in
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7 Plug in the water bath power cord.

NOTE Do not start up the water bath until after you have connected the 
recirculating water tubing, as described in the following sections.

Setting Up the Tube Holder

This section describes how to install the temperature control tube holder on the 
instrument and how to attach the recirculating water tubing to the tube holder. 

1 Place collection tubes in the temperature control tube holder.

Tube holders are available for 15-mL two-way sorting, 12 x 75-mm four-
way sorting, and 1.5-mL Eppendorf tube four-way sorting. For compatible 
tubes, see Supplies and Consumables on page 255.

2 Attach the recirculating water tubing to the tube holder.

a Close the sort block door and open the sort collection chamber door, if 
needed. (The sort block door must be closed in order to open the 
collection chamber door.)

Note that the tubing ports are labeled In and Out. Attach the input 
tubing to the port on the left side of the collection tube holder, and the 
output tubing to the port on the right side, as shown in Figure D-4 on 
page 300.

b To attach the tubing, push it into the port until the tubing snaps into 
place.

Any instrument surface that comes in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when handling 
sorting hardware. Wear suitable protective clothing and gloves. 
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Figure D-4  Setting up the temperature control tube holder

If you need to remove the tubing, push in the orange collar as you pull the 
tubing out of the port.

3 Install the tube holder on the instrument.

Remove the current tube holder (if one is installed), and slide the 
temperature control tube holder into the slotted fittings below the sort 
aspirator drawer. Push the tube holder all the way in.

4 Close the sort collection chamber door and start up the water bath.

Input tubing Output tubing

Tubing ports
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Setting Up the ACDU Stage

This section describes how to attach the recirculating water tubing to the stage 
used with the automated cell deposition unit (ACDU). 

1 Install the splash shield below the aspirator drawer.

a Close the sort block door and open the sort collection chamber door, if 
needed. (The sort block door must be closed in order to open the 
collection chamber door.)

b Remove the tube holder, if one is installed. 

c Insert the splash shield into the slotted fittings below the sort aspirator 
drawer. Push the splash shield all the way in.

2 Click the Access Stage button to bring the ACDU stage to the front.

a Open an experiment, if one is not already open, and create a sort 
layout for any of the tubes.

b In the Sort Layout view, click the Access Stage button to move the stage 
to the front of the sort collection chamber.

3 Attach the recirculating water tubing to the ACDU stage.

Note that the tubing ports are labeled In and Out. Attach the input tubing 
to the port on the left side of the stage, and the output tubing to the port on 
the right side, as shown in Figure D-5 on page 302.

To attach the tubing, push it into the port until the tubing snaps into place.

Any instrument surface that comes in contact with biological specimens can 
transmit potentially fatal disease. Use universal precautions when handling 
sorting hardware. Wear suitable protective clothing and gloves. 
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Figure D-5  Setting up the temperature control on ACDU stage

If you need to remove the tubing, push in the orange collar as you pull the 
tubing out of the port.

4 Install the required collection device on the stage.

5 Close the sort collection chamber door and start up the water bath.

Tubing
ports

Input tubing Output tubing
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Starting Up the Water Bath

NOTE To ensure that the sample collection device is at the correct temperature, 
start up the water bath at least 30 minutes (115 V model) or 60 minutes (110 V 
model) before you start sorting.

1 Switch on the main power on the water bath control panel.

2 Use the up or down arrow keys to set the required temperature.

NOTE To achieve the required sample temperature, you will need to set the 
water bath temperature slightly higher or lower (see Table D-1). These 
settings might need adjustment depending on the ambient temperature in 
your laboratory. We recommend that you calibrate the water bath for your 
operating environment.

Table D-1  Water bath settings for corresponding sample temperature

Required Sample 
Temp (°C)

Water Bath Setting (°C)

4 2

37 37.5

42 43.2

Main power 
switch
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3 Wait at least 30 minutes (115 V model) or 60 minutes (110 V model) to 
allow the recirculating water reach the required temperature.

Maintenance 

To maintain the recirculating water bath, see the documentation provided by the 
manufacturer. 

Tube Holders

Remove the tube holders when you are finished using them, and clean them 
periodically before storage. 

To detach the recirculating water tubing, push in the orange collar as you pull the 
tubing out of the port. 

Clean the temperature control tube holders by wiping them down with an 
appropriate cleaning fluid (for example, 70% ethanol, 5% bleach, or deionized 
water). Dry them with a lint-free cloth before storage.

Recirculating the Water Tubing

Inspect the tubing periodically for leaks, plugs, or contaminants. If needed, 
remove the tubing and clean it with an appropriate cleaning solution, or replace 
the tubing. Contact your BD Biosciences service representative for replacement 
tubing.

When you detach the recirculating water tubing from the tube holder, any 
fluid remaining in the tubing can leak into the sort collection chamber. To 
ensure that fluid is aspirated from the sort collection chamber, make sure 
the sort chamber aspirator pump is on (do not turn off the instrument main 
power) before you detach the tubing. Use caution when handling tubing 
containing hot water.
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Specifications 

Specifications for the recirculating water bath are as follows.

NOTE The following specifications are for the US version only.

The temperature control option includes the Lauda® Ecoline cooling/heating 
bath, model RE 106.

• Operating temperature range: –20 to 120°C

• Ambient temperature range: 5 to 40°C

• Heater power for 115 V/60 Hz: 1.3 kW

• Maximum flow rate at pump output of 5: 17 L/min

• Maximum bath volume: 4–6 L

• Power consumption for 115 V/60 Hz: 1.4 kW

For more information, see the manufacturer’s documentation.
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Appendix E

QC Using BD FACSDiva Software

This appendix contains information on performing the quality control procedure 
using BD FACSDiva software.
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Cytometer Quality Control Using BD FACSDiva 
Software

Perform cytometer quality control (QC) to ensure consistent performance over 
time. During cytometer QC, you want to keep as many variables as constant as 
possible. For example, always use the same QC particle type and lot number, 
sheath pressure, and PMT settings. If you work with different sheath pressures, 
you might consider having a separate QC experiment for each pressure.

When the experiment, cytometer settings, and QC sample are constant, changes 
in the recorded means and coefficients of variation (CVs) indicate changes in 
cytometer performance over time. QC data should be analyzed for trends over 
30–60 runs.

This section describes how to use a QC experiment template to verify laser delay 
and area scaling values, and how to record parameter means and CVs for a 
fluorescent bead. For examples of fluorescent particles that can be used for 
cytometer QC, see Cytometer Setup Particles on page 261.

NOTE QC results are affected by laser and fluidics performance. We strongly 
recommend following the laser and fluidics maintenance procedures in Shutdown 
and Maintenance on page 175.

Setting Up the Cytometer Configuration

The cytometer configuration includes these settings:

• Fluorochromes

• Filters and mirrors

• Sheath pressure (must match sheath pressure in sort setup)

• Nozzle size

• Window extension
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The steps in this section show you how to set up the cytometer configuration in 
preparation for performing QC. 

1 Select Cytometer > View Configurations, which opens the Cytometer 
Configuration window in the CS&T module. See Figure 3-5 on page 70.

NOTE When you select Cytometer > View Configurations, the cytometer 
disconnects from the BD FACSDiva interface and connects to the CS&T 
interface. While the CS&T module is running, BD FACSDiva is in a 
holding mode and does not accept any user input. When CS&T is closed, 
BD FACSDiva becomes active again.

2 Select a cytometer configuration that contains appropriate settings for the 
samples you are running. 

3 Once the appropriate configuration is selected, click OK in the Cytometer 
Configuration window to close it.

4 Close the CS&T application by selecting File > Exit. The BD FACSDiva 
interface is now active and accepting user input. 

See Figure E-1 and Figure E-2 for error messages that can occur if the sort 
setup or sheath pressure are different between the cytometer configuration 
in CS&T and the values in BD FACSDiva.

Figure E-1  Possible error message when closing CS&T

For accurate data results, the cytometer optics must match the current 
cytometer configuration. Also, the sheath pressure and sort setup must 
match the settings in BD FACSDiva.
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Figure E-2  Error message showing details

Preparing QC Particles

Prepare QC particles, also known as beads, in a 12 x 75-mm tube according to 
the manufacturer’s instructions. See Table E-1 for one brand of beads that can be 
ordered from BD.

Table E-1  Bead information

Adjusting Area Scaling and Laser Delay

The required area scaling factor changes based on sheath pressure and particle 
size. The area scaling factors should be verified for each experiment performed 
on the cytometer. 

BD FACSFlow 
Solution

SPHERO Rainbow Particles
(3.0–3.4 microns)

Ordering Info

1 mL 2 to 3 drops BD Biosciences Cat. No. 556291
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This section describes how to optimize area scaling and laser delay using the QC 
template that is included with BD FACSDiva software.

Setting Up the QC Experiment

Follow the steps in this section to set up an experiment for instrument QC. 

1 Click the corresponding buttons on the Workspace toolbar to display the 
Browser ( ), Cytometer ( ), Inspector ( ), Worksheet ( ), and 
Acquisition Dashboard ( ) windows, as needed. 

; Tip     As you work in the software, windows can become hidden. You can 
easily bring a window to the forefront by double-clicking the corresponding 
button on the Workspace toolbar.

2 Create a folder for the QC experiment.

In the Browser, select the icon for your database and click the New Folder 
button on the Browser toolbar.

Rename the folder Cytometer QC or create a Cytometer QC folder inside 
another folder. See the BD FACSDiva Software Reference Manual for ideas 
on how to organize experiments.

3 Create an experiment from the QC Experiment template.

Select Experiment > New Experiment, click the General tab, and select the 
QC Experiment template (Figure E-3). Click OK to add a copy of the 
template to the Browser.

New folder 
button

Database 
icon
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Figure E-3  Creating an experiment from the QC template

4 Add the current month and year to the experiment name, rename the 
specimen with the type of bead you are running (such as Rainbow beads), 
and rename the tube with today’s date.

Adjusting Area Scaling for the Blue Laser

1 Open the QC experiment by double-clicking the experiment icon.

Verify that the Area Scaling worksheet is displayed in the Worksheet 
window.

2 Click to set the current tube pointer next to the tube with today’s date in 
the Browser. 

3 Install the tube of beads onto the loading port.

4 Click Load in the Acquisition Dashboard.

Current tube
pointer
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The loading port rises to enclose the tube within the chamber. Once the 
tube is loaded, acquisition starts automatically.

5 Set the Events to Display to 500 events.

-

6 Adjust the FSC and SSC voltages to place the particles within the P1 gate at 
approximately 100 x 103 on scale in the FSC-H vs SSC-H dot plot. 

a Click the Parameters tab in the Cytometer window.

b Select the voltage field for the parameter you need to adjust.

c To adjust the values you can:

• Click the up and down arrows to adjust the voltages in increments 
of 1. 

• Drag the sliders to adjust the voltages.

• Press the Ctrl key while clicking the on-screen arrows to increase 
or decrease in increments of 10.

• Press the Ctrl key while pressing the keyboard arrows to increase 
or decrease in increments of 10.
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7 Adjust the FSC area scaling until the FSC-A signal matches the FSC-H 
signal, if needed.

a Click the Laser tab in the Cytometer window and check the FSC area 
scaling value.

• If the FSC-A signal is lower than FSC-H, increase FSC area scaling.

• If the FSC-A signal is higher than FSC-H, decrease FSC area 
scaling.
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Figure E-4  FSC area scaling factor set incorrectly (left) and correctly (right)
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8 Adjust the FITC voltage to place the FITC-H signal at approximately 100 x 
103.

a Click the Parameters tab in the Cytometer window.

b Select the FITC voltage field and adjust the voltage.

9 Adjust the blue laser area scaling until the FITC-A signal matches the 
FITC-H signal, if needed.

The blue laser area scaling can be adjusted using any parameter excited by 
the blue laser.

a Click the Laser tab in the Cytometer window. 

b Adjust the area scaling factor for the blue laser.

• If the FITC-A signal is lower than FITC-H, increase area scaling.

• If the FITC-A signal is higher than FITC-H, decrease area scaling.
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Figure E-5  Blue laser area scaling before adjustment (left) and after (right) 

Adjusting Area Scaling and Laser Delay for the Red and Violet 
Lasers

The laser delay factor in BD FACSDiva software is used to realign the signals so 
they can be measured and displayed on the same time scale. Signals are aligned 
with respect to the blue laser, so the blue laser will have a 0 delay value, the red 
laser will have a negative delay value, and the violet (or Near UV) laser will have 
a positive delay value.

1 Adjust the APC voltage to place the APC-H signal at approximately 100 x 
103.

The red laser area scaling and laser delay can be adjusted using any 
parameter excited by the red laser.

2 Adjust the delay setting for the red laser, if needed.
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The sort setup enters area scaling and laser delay values from the last time 
the sort setup was used. For this reason, the settings should be close to the 
appropriate values. You are simply confirming that the values are correct as 
part of your QC. If adjustments are needed, they should be slight. The 
delay is properly adjusted when the fluorescence signal intensity is at its 
highest.

a Click the Laser tab in the Cytometer window.

b Change the window extension to 0.

• If the APC-A signal stayed the same, then go to step e.

• If the APC-A signal decreased, then follow step c through step e.

c Click in the Delay field for the red laser.
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d Adjust the laser delay value until the maximum APC-A signal is 
achieved.

e Reset the window extension to the appropriate setting (typically 2). 

3 Adjust the red laser area scaling until the APC-A signal matches the APC-H 
signal, if needed.

Click the Laser tab in the Cytometer window.

• Increase the area scaling factor if the APC-A signal is lower than 
APC-H. 

• Decrease the area scaling factor if the APC-A signal is higher than 
APC-H.

4 Repeat step 1 through step 3 to adjust area scaling and laser delay for the 
violet (or Near UV) laser, using the appropriate parameter instead of APC.

Recording QC Data 

The QC experiment template includes Browser elements, as well as plots and 
instrument settings. The first time you use the QC experiment template, adjust 
the settings by placing the signals for each parameter to channel 100,000. The 
instrument settings you establish will be used for subsequent QC runs. 

Before adjustment After adjustment
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1 Display the QC worksheet by clicking the QC tab in the Worksheet 
window. 

2 Adjust the PMT voltage for each parameter to set the signal to 
approximately 100 x 103. 

3 Set the flow rate to 1.0 in the Dashboard.

4 Ensure that the current tube pointer is still set to the first tube, and then 
click Record Data.

Once the tube has finished recording, the tube icon changes to a tube with a 
disk. Also, the tube will now have cytometer settings associated with it.

5 After data has been recorded, click Unload in the Dashboard and remove 
the tube.

6 (Optional) Select File > Print.

Keep a record of the daily QC results for future reference. By comparing 
results from day to day, you will be able to monitor instrument 
performance.

Tube with data

Tube without data
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An example of recorded data is shown in Figure E-6. 

Figure E-6  Recorded QC data 
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Reusing the QC Experiment

The QC experiment was designed so you can reuse it for subsequent QC runs by 
duplicating the tube without data. Collecting all QC data in the same experiment 
makes it easy to export the statistics to a QC log.

1 Verify that the cytometer configuration is set to the appropriate 
configuration for QC.

2 Open the QC experiment.

3 Right-click the most recent tube and select Duplicate without Data. 

4 Rename the tube with the current date.

5 Verify that area scaling and laser delay are correct.

a Verify that the Area Scaling worksheet is displayed.

b Prepare and load a tube with QC particles.

c Verify that the FSC and blue laser area scaling factors are set correctly.

; Tip     You can use the same area scaling values that were determined the last 
time you ran the QC particles. Select the last recorded data file in your QC 
experiment and find the area scaling values in the Tube tab. Type these 
numbers into the Cytometer window, Laser tab.
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d Ensure that the red and violet (or Near UV) laser delays are set 
appropriately by setting the window extension to 0 and verifying that 
the area signal is not lost. Adjust the laser delay, if necessary.

e Reset the window extension to the appropriate value before verifying 
the remaining area scaling factors. 

f Verify the red and violet laser area scaling factors.

6 Set the flow rate to 1.0.

7 Record 10,000 events.

Do not adjust any voltages. You may need to adjust the singlet gate to 
capture the population in the FSC-A vs SSC-A dot plot.

Area scaling values

Tube tab
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Tracking QC Results

Monitoring cytometer QC results can provide you with information regarding 
your instrument’s performance. Changes in mean fluorescence intensity or CV 
can alert you to possible instrument issues or service procedures that may need to 
be addressed. To track cytometer performance over time, copy means and CVs 
for each parameter onto a QC log.

You can also perform batch analysis, which allows you to automatically export a 
statistics file in comma separated value (CSV) format for a group of tubes. The 
CSV file can be opened in a spreadsheet application. See Performing a Batch 
Analysis on page 146 for instructions on this process.
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Index

Numerics

4-Way Purity mode 57

A

aborts
See also conflicts, sort.
electronic 242

Access Stage button 92
accessory kit, contents 258
Accudrop

about 51
beads, sorting in Initial mode 158
experiment 97, 155
optimizing drop delay 156

ACDU See automated cell deposition unit
acquisition

controls 81
events to record 139
troubleshooting 237

Acquisition Dashboard 81
adding

cytometer configurations 74
experiments 311
folders 132, 311
sort layouts 89, 162
sort populations 90, 162

adjusting
amplitude 48, 105
area scaling 124, 126, 127, 312
Drop 1 48, 106

drop delay 156
flow rate 30, 82
Home location 170
laser delay 317
micrometer dial 157, 160
PMT voltages 42
side streams 170
sort block angle 14, 206
voltages 125
Window Extension 318

aerosol management option (AMO)
about 16
changing filters 202
components 276
connecting 3
maintenance 283
specifications 293
starting up 278
troubleshooting 290
using 275–293

agitating samples 65
air

external 4
filters, changing 202
line 102, 180
pressure 5
supply, external 4

AMO See aerosol management option
amplitude

about 47
adjusting 48, 105
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analysis
batch 146
data 138
printing 144
sorting 143, 151, 161

application settings
about 123
adjusting area scaling 124
creating 123
optimizing PMT voltages 128
saving 130
window 133

applications
custom 74
recommended flow rates 31
recommended sort setup 85

area parameters 42
area scaling

adjusting 310
primary laser 312

arrays, detector 22, 34, 252
aseptic sorting 187
aspirator drawer

about 15
opening 50, 92, 164

assistance, technical xv
attenuation control 50
auto drop delay

about 52
graph 160
overview 159
using 159

autoclaving sheath tank 187
automated cell deposition unit (ACDU)

about 17
accessing stage 92
chamber 17
collection devices 171
custom devices 172
installing splash shield 168

sorting 168
troubleshooting 233

B

backflush, sample line 184
bandpass filters 37
base configurations 76
batch analysis, performing 146
BD FACSAria II

about 1
cytometer 6
fluidics cart
workstation 26

BD FACSDiva software See software
beads

Accudrop 156
calibration 261
CS&T 120
setup 118

beam splitters 36
biexponential

display 141
sort gates 161

bleach fluid line 189
bleeding filters 190
breaker, circuit 24
breakoff

drop 45
setting up 105–107
troubleshooting 105, 231
window 46, 84

bulk sorting 152
buttons

See also controls
Access Stage 92
chamber light 9
emergency stop 25
Load 82
power 24
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Sort 92
Unload 82
waste drawer 50

C

calculating compensation 135
cameras

about 23, 51
cleaning windows 217

cap, waste 115
cart, fluidics See fluidics cart
chambers

ACDU 17
sample injection 9
sort block 13
sort collection 17

changing
air filters 202, 203
ethanol shutdown filter 193
fluid filters 191
nozzles 205
optical filters 222
pinch valve tubing 214
sample lines 194
sheath filters 192
waste cap 115

charging drops 52
circuit breaker 24
cleaning

camera windows 217
cytometer 181, 183
flow cell 176
fluidics 187
mode failure 244
modes 183
nozzles 206
optical filters 223
strobe lens 217

clogged nozzle 206

closed-loop nozzle
cleaning 210
for shutdown 176
installing 178, 179
maintenance 210
replacing tubing 211

coefficient of variation (CV), high 241
collection

devices 17, 87
optics 20
tubes, replacing 166

collet fitting 198
compensation

calculating 135
controls, creating 134
gating data 137
setup 137

components
BD FACSDiva workspace 62, 83
cytometer 6
electronics 24
fluidics 7
optics 18
workstation 26

computer
about 26
shutting down 177, 181

configuration, cytometer
about 40, 68, 69
adding 74
and sort setup 79
copying 76
custom 74
editing 77
laser 266
mismatch dialog 80
selecting 118

conflicts, sort
about 53
counting 93
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printing 94
saving 91, 162
troubleshooting 235

connecting
external air 4
fluidics cart 3
power cords 3, 24

containers
about 2
autoclaving 187
emptying waste 114
refilling 112

containment device, sheath probe 186
controls

See also buttons
ACDU stage 92
acquisition 81
aspirator drawer 50, 92
attenuation 50
compensation 134
cytometer (software) 63
flow rate 82
fluidics 63
optical filter 50, 51
sorting 83, 92
stream 47
Sweet Spot 47
test sort 50
tube loading 82
voltage 50
waste drawer 50

conventions, user’s guide xiv
cooling samples 66, 100
cord, fluidics cart 3, 5
counters, sorting 93
creating

analysis objects 143
application settings 123
compensation controls 134
custom devices 84, 172

experiments 311
folders 132, 311
sort layouts 89, 162
sort precision modes 59
statistics view 144

CS&T See Cytometer Setup and Tracking
custom devices 84, 172
custom optical filters 222
customer support xv
cuvette flow cell

about 11
cleaning 176

cytometer
about 6
adding configurations 74
cleaning 181, 183
configuration 40, 68, 69, 118
controls, software 63
disconnect error 245
doors 7
electronics 24
fluidics 7, 28
not responding 245
optics 18
performance 116, 249
power 24, 100
QC particles 261
quality control 308
shutting down 176, 178
specifications 248, 254
starting 100
status report 72
supplies 256
workstation 26

Cytometer Setup and Tracking (CS&T)
beads 120
menu selections 68
overview 116
window 117
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D

daily shutdown procedure 176
Dashboard, Acquisition 81
data

analyzing 138, 143
gating 137, 143
recording 138, 142
recording QC 319

data collection, overview 131
default setup, detector arrays 252
deflection

drop 53
plates 15, 152, 153

removing 219
troubleshooting 234

deflection plate removal tool 219
delay

drop 50, 51, 154
See also Accudrop

laser 43, 317
deleting

custom devices 174
sort populations 91
sort precision modes 59

detectors 22, 34, 40
devices, sorting 87, 172, 174
diode laser 23, 51
discriminating filters 37
doors, sort collection chamber 17
doublets

discrimination experiment 97
discrimination gating 132
eliminating 142

drain plug 115
drawer See aspirator drawer
drip tray 203
drop

auto delay 159
breakoff 45
charging 52

conflicts 53
correction factors 51, 154
deflection 53
delay 50, 51, 154, 156

See also Accudrop
drive frequency 47
formation 45
satellites 106

Drop 1
about 46, 48
adjusting 48, 106

E

editing
cytometer configurations 77
sort layouts 91
statistics view 144

electronics
aborts 242
about 24
signal processing 41
troubleshooting 245

emergency stop button 25
emission

optics 252
spectra 33

emptying waste 114
error messages

cleaning mode failure 244
cytometer disconnected 245
cytometer not responding 245
Master DAQ overflow 245

ethanol shutdown
filter, changing 193
tank

capacity 108
refilling 111
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events
not showing in plots 237, 239
rate, troubleshooting 240, 241
target 90, 162
troubleshooting 242

excitation optics 18, 251
Experiment Layout 139
experiments

Accudrop 97, 155
creating 311
cytometer QC 97
doublet discrimination 97
QC, setting up 311
reusing 322
setting up 139
sorting 162
templates 97

exporting sort reports 96, 165

F

FACSAria II See BD FACSAria II
FACSDiva software See software
ferrules, removing 198, 200
fiber optics 19
filling containers 112
filters

about 35
air, changing 202
bandpass 37
changing 191, 222
default setup 252
discriminating 37
fluid, changing 191
holders 257
longpass 36
neutral density (ND) 39, 223, 257
optical 35, 223, 268
purging 190
removing 191, 223

sample line 212, 213
sheath 192

Fine Tune mode 58
flow cell

about 11
access door 7
cleaning 176

flow rate
about 31
adjusting 30, 82
recommendations 31

fluid
bleach line 189
containers 2
filters 191
level indicators 67
line 102, 180
movement 28
out port 189
priming 113, 184
recommended 108
refilling 112

fluidics
about 28
cleaning 187
components 7
connections 3
containers 2
controls 63
daily shutdown 176
level indicators 67
power 5
shutdown 64, 178
startup 29, 63, 102
system 28
troubleshooting 244

fluidics cart
about
cord 3, 5
dimensions 254
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drip tray 203
power 3, 5
setting up 108
specifications 254

fluorescence
about 33
emission spectra 33
signal, troubleshooting 238

folders, adding 132, 311
forward scatter (FSC)

about 32
detector 40
ND filter 223, 257

removing 223
frequency, drop drive 47
FSC See forward scatter

G

Gap 46, 48
gating

compensation controls 137
data 143
during sorting 161

global worksheets
adding sort layouts 89, 162
previewing data 138
setting up 140

H

hardware, ACDU 168
hazard symbols xiv
hazards, mechanical 25
heating samples 66, 100
height parameters 42
holders

collection tube 17, 152, 300
optical filter 257
sample tube 10

Home Device 84, 170, 171

hydrodynamic focusing 31

I

Initial mode 58
installing

collection tube holders 152, 300
nozzle 205
plates 169, 302
sample line filter 212
sample tubes 10
slides 169, 302
splash shield 168

instrument See cytometer
integrated nozzle

about 12
changing 205
cleaning 206
replacing seal 208

interrogation point 11

L

labels, parameter 139
label-specific tubes 134
labware, parts list 263
laser delay, adjusting 310
lasers

about 18
configurations 19, 266
delay 43, 317
diode 23, 51
power 24
shutting down 177, 181
specifications 251
starting 100
warmup time 100

layout See sort layouts
leaks, troubleshooting 244
lens, strobe 217
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levels
fluid 67
sample 9

lever, nozzle 103, 205
light

detection 34
injection chamber 9
scatter signals 32
voltage warning 15

limitations xvi
Link & Save 137
Load button 82
loader, plate 18
loading tubes 10, 30
long clean 244
longpass filters 36

M

maintenance
AMO 283
scheduled 182
temperature control option 304
unscheduled 204

managing aerosols 16
Masks

about 53
default precision modes 57
Phase 56
Purity 55
Yield 54

Master DAQ overflow error 245
micrometer dial 23, 157, 160
mirrors, dichroic 36
mismatch dialog

configuration 80
cytometer settings 134

modes
defining 59
deleting 59

sort precision 53, 57
monitoring sorts 94, 165

N

ND filters 39, 223, 257
Near UV laser

about 265
configurations 266, 269
optical filters 268
side population guidelines 272
specifications 267
troubleshooting 274

neutral density filters 39, 223, 257
nozzles

See also closed-loop nozzle
about 12
breakoff patterns 107
changing 205
cleaning 206
integrated 12
lever 103, 205
O-ring 208, 258
sizes 85, 205
spare 258
standard 13, 208

O

octagon
about 21, 22, 34
default filters 252

opening
aspirator drawer 50, 92, 164
sample injection chamber 10

Optical Filter control 50, 51
optical filters

about 35
changing 222
cleaning 223
custom 222
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default setup 252
Near UV laser 268

optics
about 18
collection 20
default setup 252
emission 252
excitation 18, 20, 251
fiber 19
filter holders 257
reordering 256
stream-viewing 23

optimizing
cytometer performance 308
cytometer settings 131
drop delay 156
PMT voltages 128
streams 170

ordering supplies 255
O-ring

nozzle 208, 258
sample injection chamber 220

P

parameters
about 42
adding 40, 69, 74
labels 139
measuring 42
scatter, distorted 241

parts, replacement 260
pausing sorting 46, 92, 167
performance

check, running 120
tracking 68

phase
field 51
masks 54, 56

photodiodes 40

photomultiplier tubes (PMTs)
about 22, 40
applying voltages 42
assigning 40, 69, 74
optimizing for application 

settings 128
pinch valve

changing tubing 214
collet fitting 216

plate loader 18
plate voltage 51
plates

deflection 15, 152, 153
removing 219

installing 169, 302
sorting into 168

plots
excessive debris 242
no events in 237
unexpected events in 239

PMTs See photomultiplier tubes
populations

sorting 52, 90, 161, 162
troubleshooting 235, 242

power
buttons 24
cytometer 24, 100
fluidics cart 3, 5
laser 24

precision modes 53, 57
See also sort precision modes

preferences, user 143
pressure

air 5
sample 30
sheath 29, 64
sort, default values 85
troubleshooting 244

primary laser, verifying area scaling 312
priming fluids 113, 184



334 BD FACSAria II User’s Guide  

printing
sort reports 96, 165
worksheets 144

pulse, electronic 41
purging filters 190
Purity

Masks 55
mode 57, 162

Q

quality control (QC)
about 308
beads 310
experiment 97
particles 261
tracking results 324

R

reagents, parts list 262
recording

data 138, 142
during sorting 165
QC data 319

refilling
ethanol shutdown

tank 111
plastic containers 112
sheath tank 109

removal tool, deflection plate 219
removing

deflection plates 219
ferrules 198, 200
filters 191, 222, 223
sample line filter 212

replacement parts 260
replacing

closed-loop nozzle tubing 211
tubes 166

reports
cytometer status 72
printing 96, 165
sort 94, 96

results, troubleshooting 236
rotating sort block 14, 206
running performance check 120

S

safety, general 25
sample

agitation 65
core diameter 31
flow 28, 30
injection chamber

about 9
lubricating O-ring 220
sample line 213

interrogation 11
line

backflush 184
changing 194
filter 212, 213

pressure 30
temperature 66, 100
tubes, replacing 166

samples
heating 66, 100
running 142

satellites, drop 106
Save Conflicts 91, 162
saving

application settings 130
sort conflicts 91, 162

scaling, area
adjusting 310
primary laser 312
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scatter
light 32
parameters, distorted 241

second laser, adjusting delay 317
sensitivity, cytometer performance 249
settings

See also application settings
optimizing 131

setup
beads 118
compensation 137
values, sort 85, 86

sheath
flow 29
fluid 108
line 189
pressure 29, 64
reservoir, autoclaving 187

sheath filter
changing 192
purging 191

sheath probe
containment device 186
removing 185

sheath tank
capacity 108
changing air filter 203
changing filter 192
connectors 109
refilling 109
required location 111

shutdown tank, ethanol
capacity 108
refilling 111

shutting down
computer 177, 181
daily procedure 176
fluidics 64, 176, 178
lasers 177, 181

side populations 272

side scatter (SSC) 32
side streams

optimizing 170
window 49, 84

signals
about 32
detection 34
fluorescent 33
generating 41
low Area 239
no fluorescent 238
scattered light 32
troubleshooting 243

Single Cell mode 58
slides

installing 169, 302
sorting into 168

software
about 26
cleaning modes 183
components 62, 83
cytometer controls 63
QC 308
templates 97

sort
block 13, 16
collection

chamber 17
devices 17

Sort button 92
sort layouts

about 52, 87
creating 89, 162
custom 84, 172
editing 91
entering populations 90, 162

sort menu 84
sort precision modes

4-Way Purity 57, 162
about 53
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creating 59, 84
defaults 57
deleting 59
Fine Tune 58
Initial 58
Purity 57
Single Cell 58
Yield 58

sort reports
about 94
exporting 96, 165
printing 96, 165

sort setup values 85, 86
sort, test 50, 153
sorting

about 44, 149
Accudrop beads 158
analysis 143, 151, 161
aseptic 187
aspirator drawer control 50, 92
bulk 152
collection devices 87
conflicts 53, 91, 93, 162, 235
controls 83, 92
counters 93
experiment 162
gates 161
into plates 168
into slides 168
into tubes 152
monitoring 94, 165
pausing 46, 92, 167
populations 52, 90, 161, 162
recording data 165
resuming 166, 167
setup 150
starting 92, 164
stopping 92
troubleshooting 232

specifications
cytometer 248
fluidics cart 254
laser 251
temperature control option 305

splash shield, installing 168
stage, accessing 92
standard nozzle 208
starting

cytometer 100
fluidics 29, 63, 102
lasers 100
sorting 92, 164
stream 104

statistics view, creating 144
status, cytometer report 72
Stokes shift 33
stop button 25
stopping sorting 92
stream

See also side streams
centering 50, 154
control 47
deflecting 51
flow rate 29
setting up 170
starting 104
troubleshooting 104, 226
viewing 23

stream-charging wire 53
strobe lens, cleaning 217, 218
supplies, cytometer 256
Sweet Spot

about 45, 46
control 47

symbols, hazard xiv
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T

tanks See containers
target events 90, 162
technical assistance xv
temperature control option

about 17
maintenance 304
setting up ACDU 301
specifications 305
using 296–305
water bath 297

temperature, sample 66
templates, experiment 97
test sort 50, 153, 171
threshold, troubleshooting 243
trap, waste 115
trigons

about 21, 22, 34
default filters 252

troubleshooting
ACDU 233
acquisition 237
AMO 290
breakoff 105, 231
CVs 241
deflection 234
electronic aborts 242
electronics 245
event rate 240, 241
fluidics cart 244
leaks 244
low Area signal 239
Near UV laser 274
populations 235, 242
pressure 244
scatter parameters 241
signals 238, 243
sorting 232, 235, 236
stream 104, 226
threshold 243

tubes
adding sort layouts 89, 162
agitating 65
compensation 134
heating/cooling 66, 100
holders 10, 17
label-specific 134
loading 10, 30
replacing 166
sorting into 17, 152
unloading 10, 30

typographical conventions xiv

U

Unload button 82
unloading tubes 10, 30
user preferences 143

V

View Configurations selection 68
viewing global worksheets 140
views

See also windows
sort layout 87
statistics 144

violet laser
configuration 19
detector 22, 34, 257, 271
laser delay 43
switching from near UV laser 270

voltage
adjusting PMT 42
controls 50
optimizing PMT 128
warning light 15
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W

waste
aspirator 15
cap, changing 115
container parts 114
emptying 114

water bath 297, 303
width parameters 42
Window Extension, adjusting 318
windows

See also views
about 62, 83
Acquisition Dashboard 81
Breakoff 46
camera, cleaning 217
CS&T 117
cytometer configuration 69
device setup 171
showing 311
Side Stream 49
strobe lens 218

worksheets
See also global worksheets
printing 144
viewing 140

workspace
components 62, 83
setting up 131
setting up CS&T 117

workstation
about 26
shutting down 177, 181

Y

Yield
mask 54, 56
mode 58
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